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Welcome

IMPAX Orthopaedic Tools is a high-performance tool for the precise planning of hip implants. IMPAX Orthopaedic 
Tools allows working without film at traumatological, orthopedic and pediatric workstations.

Modules

IMPAX Orthopaedic Tools supports you with the following modules (depending on the selected package):

•	 Hip - Manual Planning for specific, manual prosthesis selection and precisely fitting planning of 
hip implants

•	 Hip - Automatic Planning for automatic suggestions of hip endoprostheses
•	 Hip - Biometry for biometrically optimal prepared implantation
•	 Hip - Coxometry for precise measurement of clinically relevant hip data for children and adults
•	 Hip - Wear Measurement for measuring the wear of hip endoprostheses, including wear level 

and wear direction (Not available in IOT 3.0!)
•	 Hip - FAI (femoral acetabular impingement) for precise assessment of hip joint morphology
•	 Hip - Intertrochanteric Osteotomy with a specifically designed workflow
•	 Knee for optimal surgery planning using partial images as well as long leg images in a standing 

position
•	 Osteotomy for optimal determination of the pre-operative axis situation as well as simulation of 

single and multiple osteotomies for corrective osteotomies near the tibial head
•	 Osteotomy by Dror Paley for calculation and correction of complex deformities on the lower 

limb according to Dror Paley
•	 Spine for common measurements on vertebrae in frontal as well as lateral view
•	 Foot for implant planning on foot and ankle joint as well as determinating/correcting a hallux 

valgus deformity
•	 Upper Extremities for implant planning on shoulder, elbow, hand and finger
•	 Trauma for adjustments of bone segments and implant planning

IMPAX Orthopaedic Tools offers the following advantages over other methods of prosthesis planning:

•	 Digital planning images and scanning data are transferred from and sent back to the DICOM 
image database, optimizing your workflow.

•	 Preoperative biometric measurements can be taken with the greatest precision by just a few 
clicks of the mouse.

•	 A high quality standard is ensured in preoperative diagnostics and treatment planning.
•	 All of the manufacturers' templates you need can be chosen selectively from a prosthesis data-

base.
•	 Prostheses can be adapted to the anatomical situation with the greatest precision. This helps 

to reduce the risk of malpositioning, which can lead to premature loosening of the prosthesis.
•	 The new, modern user interface of IMPAX Orthopaedic Tools is significantly user friendlier than 

the previous versions. Getting a planning result can be achieved with very little effort. Many 
functions are now combined into single steps.

•	 Operating of the software is supported by a function tool.
•	 The controls are similar to usual  MS/WINDOWS software.

You can save the planning data as digital DICOM images in the database of your workstation and transfer them to 
a central DICOM archive. As a result, you are able to retrieve the planning data very quickly whenever this may be 
necessary, for example for a follow-up or a demonstration during a patient consultation. Of course you can also 
print out your planning on a printer.

IMPAX Orthopaedic Tools can help you to comply with legal requirements to document the pre-surgical planning 
of your procedures.

Advantages

Documentation
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System Description

The IMPAX Orthopaedic Tools planning software is a plug-in for your IMPAX workstation. Please consult the data 
sheet for hardware and software requirements or consult your Agfa sales representative. The most recent version of 
the data sheet can be found on http://www.agfahealthcare.com/global/en/he/library/libraryopen?ID=38338278.

Additional information about Agfa’s solutions for Orthopaedics is available on Agfa HealthCare’s web site:
http://www.agfahealthcare.com/global/en/main/products_services/orthopaedics/index.jsp 

Installation

The installation procedure is described in a separate document. This product is normally installed for you by your 
local system administrator or by a trained Agfa service engineer. Please do not make any changes to the instal-
lation without consulting your local system administrator or Agfa’s service, as any modification may impact the 
performance or stability of your IMPAX workstation.

Agfa Healthcare Community

Become a member of the Agfa Healthcare Community and register for an account on:

https://www.regonline.com/ahcommunity 

Members of the Agfa Healthcare Community have access to the latest release of the IMPAX Orthopaedic Tools 
template library.

Intended Use

IMPAX Orthopaedic Tools is a suite of software applications intended to be used by trained medical professionals 
to facilitate the assessment of bone and joint deformities and the planning of arthroplasties and osteotomies 
based on 2D medical images.

It is designed to work within a filmless, digital environment with calibrated length measurements, angle measure-
ments, planning of the placement of orthopaedic implants using digital templates and interactive simulation of the
effect of treatments such as osteotomies. The results of measurements, planning and simulations can be saved in 
a PACS system.

WARNING
All dimensions and measurements given by the IMPAX Orthopaedic Tools prosthesis database 
derive from original manufacturer data or templates. If you suspect that the data is not cor-
rect, please report it to Agfa‘s service representative or contact Agfa using the contact infor-
mation provided in the beginning of this manual.

Intended User

This manual is written for professional healthcare workers and for users of Agfa products who have received pro-
per training. Users are considered as the persons who actually handle the system as well as the persons having
authority over the system.

http://www.agfahealthcare.com/global/en/he/library/libraryopen%3FID%3D38338278
http://www.agfahealthcare.com/global/en/main/products_services/orthopaedics/index.jsp
https://www.regonline.com/ahcommunity
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Warnings and Safety Advice

In order to use IMPAX Orthopaedic Tools safely, it is essential to read this User Manual carefully.

This manual is written for professional healthcare workers and for users of Agfa products who have received pro-
per training. Detailed safety instructions for the safe and effective use of this software are documented in a sepa-
rate Safety User Manual which is delivered with this software and installed on your computer. Use the “?” button 
on the toolbar to find the menu item for the Safety User Manual.

WARNINGS and NOTES are highlighted in the following way:

NOTE
provides important advice for working with

the software, as well as other useful information

CAUTION
Highlights circumstances or consequences to which you

should pay particular attention when working with IMPAX Orthopaedic Tools.

WARNING
Warnings are directions regarding specific circumstances which, if not followed, could cause

fatal or serious injury to a user, engineer, patient or any other person or lead to mistreatment.

Left and Right Mouse Buttons

All workflows and functions (mouse click, selecting, moving, marking areas, etc.) are conducted by using the left 
mouse button.

In case certain steps require the use of the right mouse button, the right mouse click is specifically mentioned.
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Starting the Software

When starting IMPAX Orthopaedic Tools, a splash screen appears 
showing the loading status.

After successful initialization, the IMPAX Orthopaedic Tools work-
space opens and you can start with your work.

User Interface

The IMPAX Orthopaedic Tools screen is divided into the following areas/elements (standard workspace):

1.	 Menu bar
2.	 Toolbar
3.	 Module and function tool
4.	 Information window
5.	 Work area
6.	 Coordinates
7.	 Zoom & window tool
8.	 Overview window

1
2

3

4

5

6+7

8
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Menu Bar

The menu bar offers access to general functions, such as various file operations (open/save/close), printer and 
software settings, various image functions as well as settings for workspace and planning window. Menu items 
marked with a symbol can also be found in the toolbar.

By clicking on the question mark, you can find help and scaling instructions as well as detailed info about the pro-
gram and the software licences in use. Also, you get direct access to TeamViewer remote support. You can create/
send a report and create an audit log.

Toolbar

The toolbar contains frequently used functions. You can find a detailed description for each function in »Functions 
& Symbols«. Under menu item View you can use the function Large icons to enlarge or reduce the symbols shown 
in the toolbar.

Module & Function Tool

The module and function tool guides you through a planning step by 
step (Example shown: Hip module).

•	 Steps that have yet to be performed are displayed 
with a yellow arrow.

•	 Finished steps are displayed with a green and white 
check mark.

•	 Steps with multiple options are displayed with a blue 
arrow and can be shown or hidden with a mouse 
click.

•	 Inactive steps are displayed in grey with a padlock 
symbol. Functions/steps required for activation are 
shown via MouseOver.

Using the buttons at the top, you can switch into another module or 
enter/edit the planning information. Additionally, you can insert a 
demo image in each module.

The drawing/capture mode is preset in each function. It can be changed using the keyboard:

Key E	 End point - mouse cursor captures end point of a line
Key F	 Free - mouse cursor can be placed anywhere in the image
Key L	 Line/Element - mouse cursor captures line or element
Key M	 Center - mouse cursor captures center point of a line/circle/etc.
Key P	 Point - mouse cursor captures a defined point
Key S	 Intersection point - mouse cursor captures intersection point of two lines

Information Window

The information window guides you through every function step by step. The next step to be performed is always 
shown, usually for the left mouse button ("Left").

 Frequent commands for the right mouse button ("Right") are Back, Cancel Function/End Function, End Selection 
and Reject Implant/Template.



25

IMPAX Orthopaedic Tools» Table of Contents «

» Table of Contents «

Basics

Overview Window

The overview window shows a full view of the current planning. The grey, dotted rectangle marks the section 
currently displayed in the work area.

A click on any desired point of the overview centers the planning accordingly in the work area. Selecting a required 
area in the overview zooms to the respective area in the work area.

Work Area

Images (as well as the corresponding patient info) are displayed and edited and the planning is performed in the 
work area.

The work area can be divided into multiple windows. You can then, for example, 
use one window to work with a magnified view of the image, and use another 
window to view the whole planning. Changes performed in one window are au-
tomatically applied to all other windows as well.

The active window (in which you can work) can be identified by its active title 
bar. If you want to switch to another window, just click on the according title bar.

The layout settings can be found under menu item Window.

When starting IMPAX Orthopaedic Tools, opening/setting up 
a planning, or changing into a different module, you can see 
the module overview in the work area.

All modules purchased with your license package are shown, 
all other modules are shown faded out.

Coordinates + Zoom & Window Tool

The coordinate tool shows the x and y coordinates of the mouse cursor.

Using the slide control and the "+" and "-" buttons of the zoom & window tool, the current zoom factor in the 
current window can be adjusted as needed. The current zoom factor is displayed.

Furthermore, by using the window buttons of the zoom & window tool, you can maximize the workspace (hide all 
tools and windows) or restore the default workspace. 



26

IMPAX Orthopaedic Tools » Table of Contents «

» Table of Contents «

Basics

Keyboard Shortcuts

Some functions can be performed by using a specific key or shortcut.

Key F1	 Loads the user manual

Key H	 Reduce zoom factor (half)

Key T	 Increase zoom factor (double)

Key A	 Zoom all

Key W	 Zoom to an area specified by mouse ("Zoom rect.")

Key X	 Move image area ("Zoom Pan")

Key C	 Activate delete mode

Key U	 Undo

Shift + U	 Redo 

Ctrl + N	 New planning

Ctrl + O	 Open planning

Ctrl + S	 Save planning

Ctrl + P	 Print planning

Ctrl + Z	 Undo

Ctrl + Y	 Redo

Ctrl + X	 Cut

Ctrl + C	 Copy

Ctrl + V	 Paste

→	 Rotate element counterclockwise

←	 Rotate element clockwise

In the implant menu:

↑ or  –	 one implant size smaller

↓ or  +	 one implant size larger

Changing drawing/capture mode of the mouse cursor:�
�

Key E	 End point - mouse cursor captures end point of a line
Key F	 Free - mouse cursor can be placed anywhere in the image
Key L	 Line/Element - mouse cursor captures line or element
Key M	 Center - mouse cursor captures center point of a line/circle/etc.
Key P	 Point - mouse cursor captures a defined point
Key S	 Intersection point - mouse cursor captures intersection point of two lines
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Floating Windows

You can modify the workspace according to your requirements (floating windows). Individual elements can be 
moved, their size and behavior changed, or hidden altogether.

Changes made to the workspace are automatically saved and will be at your disposal when using the software the 
next time.

Hide & Show Elements

Under menu item View, most elements of the workspace can be 
shown and hidden with a single mouse click.

Shown elements are displayed with a check mark and highlighted 
in yellow.

You can also use the respective function to restore the standard 
workspace.

Most elements can also be close by using the "X" icon in the 
upper right corner of the particular window.

Auto Background

When clicking on the symbol shown on the right, you can put the respective element into background 
mode. Only the element's name highlighted in yellow is shown as a tab. When moving the mouse 
over the tab, the whole element is displayed. When moving the mouse away from the element, it 
returns to the background.

Another click on the symbol returns the element back to normal. You can also put multiple elements 
into background simultaneously.

This function is only available for docked elements.

Detach & Fixate Elements

You can detach an element by double clicking on its title bar and put it in floating mode. This way, you can move 
it free across the workspace, including other monitors. Another double click returns the Element into its previous, 
fixed position.

You can also detach an element by clicking on the title bar and pull the element on another position while still 
holding the mouse button.
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Change Element Size

You can change the size of docked/attached as well as detached/floating elements. To do so, 
put the mouse cursor to the edge of an element, an arrow symbol appears.

Now click on that position, hold the mouse button and move the mouse into one of the direc-
tions shown by the arrow symbol. A dotted preview line shows the new size of the element. 
Release the mouse button, the element's size is now adjusted accordingly.

If multiple elements are attached in the same area, this will always change height or width of 
all elements at the same time.

If the window size is too small for the content of the window, scroll bars appear to enable 
scrolling to all parts of the content.

Attach Elements

If an element is in detached/floating mode, you can attach it to any position of the 
workspace.

While moving the element with the mouse, various docking icons appear. Arrows 
indicate the workspace side where the element can be attached.

In the outer areas, you will always find separate docking icons for the respective 
outer border. Additionally, you can find all 4 icons together in the area you currently 
are in with the mouse. Use these for the respective borders of the particular area.

When moving the mouse with the floating element on one of these icons, a dark 
blue overlay depicts the area where the attached element would be, as well as a 
preview of the element's size.

Merge Elements

You can merge multiple elements. Move a floating element on top of another element. The 4 docking 
icons appear, as well as a merging icon in the middle.

If you move the mouse with the floating element on this icon, the element will be merged with the 
existing element. All elements merged in this area are shown in tabs in the lower part of the element. 
The currently selected element is highlighted.

The merged elements can now be simultaneously detached, moved, their size changed, reattached or 
merged with further elements. The procedure is the same as for individual elements.

To seperate merged elements, click on the respective tab and pull it out while still holding the mouse 
button. The element is now back to detached/floating mode.
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Maximize & Reset Workspace

You can find two icons in the zoom & window tool, which will help especially after exten-
sive changes and modifications to the workspace.

The right icon maximizes the workspace. All elements except for the menu bar are hidden, 
allowing for a maximum size work area.

The left icon resets to the standard workspace.

Standard Settings

During installation of the software, most of the standard settings are conducted. Still, you can adjust IMPAX Or-
thopaedic Tools to your requirements and change settings at any time. In order to do so, select menu item File > 
Settings.

You can then choose between Application Settings and User Settings with multiple, thematically grouped tabs.

NOTE
All modified settings are saved when ending the current IMPAX Orthopaedic Tools session and will 
be at your disposal again at the next time (saved on workstation level).

Folder Settings

Contains settings for standard folders.

NOTE
All settings should only be modified by a system administrator.
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DICOM Settings

Contains various settings for DICOM output of the planning:

•	 Allow/disallow font size locking, including magnification factor
•	 Grayscale export
•	 Loading of DICOM images with Overlay

PACS Settings

Enables direct saving of the planning into your PACS system. The DICOM planning data is not saved locally and then 
picked up by the PACS as during the regular export, but sent to the PACS directly (“Push to PACS”).

The following parameters for the local machine and the remote server must be entered::

•	 AE Title
•	 Address
•	 Port
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Contains settings for:

•	 Date format & language
•	 Show/hide all outline functions
•	 Show/hide preview x-ray images (modules Knee, Osteotomy and Osteotomy by Dror Paley)
•	 Default font

Scaling Settings

You can select the preferred method for manual scaling:

•	 Line
•	 Circle with 3 points
•	 Circle with 2 points
•	 Magnification factor 

Furthermore, automatic scaling sphere detection after loading an image can be selected and standard measures 
can be set. If the scaling sphere detection is not successful, the selected manual scaling method will be performed.

General Settings
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Contains various settings for screen output of the planning:

•	 Allow/disallow font size locking, including magnification factor
•	 Large icons in toolbar
•	 Grayscale display
•	 Work area background color
•	 Substitution color for work area
•	 Toggle mouse wheel scrolling zoom direction
•	 High Quality rendering

Screen Settings

Patient Info Settings

Allows you to set the color of and the position on which the patient info is displayed while planning.

Mandatory & always displayed:

•	 Patient name
•	 Patient ID
•	 Date of birth
•	 Sex

Optional:

•	 Height
•	 Weight



33

IMPAX Orthopaedic Tools» Table of Contents «

» Table of Contents «

Basics

Contains various advanced settings:

•	 Amount of undo steps
•	 Decimal places for distances in mm
•	 Decimal places for angles in °
•	 Enable/disable demo image selection for Autoplan tool

Advanced Settings

EndoDok Settings

If EndoDok is installed and available on your system, you can make settings to the  EndoDok interface:

•	 Activation of the interface
•	 Input of the EndoDok URL (for direct launch of the EndoDok software)
•	 EndoDok directory (this is where planning data is made available for the EndoDok software)
•	 Optional input of FTP Server information (if direct upload of planning data is required)

For setup and support of the EndoDok interface, contact its manufacturer XAXOA:

		  XAXOA
		  Friedrichstr. 191			   Hotline:	 +49 (0) 30 20659-459
		  10117 Berlin, Germany		  Email:	 support@xaxoa.de
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Starting IMPAX Orthopaedic Tools

Since IMPAX Orthopaedic Tools is an IMPAX tool, you will open it from out of IMPAX. Perform the following proce-
dure to launch the application. To start up IMPAX Orthopaedic Tools

1.	 In IMPAX, open a study for display. Refer to the Knowledge base of IMPAX.

	 The template button, giving access to the IMPAX Orthopaedic Tools application, is located on 
the toolbar or context toolbar of the IMPAX Image area (depending on the user configurati-
on). If the button is not available, refer to the IMPAX user manual for help regarding IMPAX 
configuration.

2.	 Click the template button.
	 A popup dialog window opens.

3.	 Select the image on which you would like to 
perform pre-surgical planning. An image pre-
view including the respective patient informa-
tion is displayed. After selecting the image, the 
application opens with the image displayed in 
the image pane. You have now performed the 
first step of the Basic workflow of the applica-
tion. You must now scale the image.

Planning Workflow

The following steps give you a high-level overview of how you should work with the application. More details can 
be found in the chapters that describe the corresponding topic. Much if not all of the planning depends of course 
of the module you select in step 3.

1.	 Start IMPAX Orthopaedic Tools as described above and load the image which you want to use for 
the planning. Alternatively you can use a previously saved planning for further planning. Refer to 
»Import Image from File« (next page) if you want to load more than one image.
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2.	 A new image must be subsequently scaled, only then IMPAX Orthopaedic Tools will be able to deter-
mine prostheses  and dimensions true to scale. Agfa advises to use its dedicated calibration marker 
(metal sphere). 

3.	 Afterwards, select the required module and perform the steps suggested in the Module Tool consec-
utively. The steps are listed chronologically to the usual work routine and displayed as follows:

•	 Steps that have yet to be performed are displayed with a yellow arrow.
•	 Finished steps are displayed with a green and white check mark.
•	 Steps with multiple options are displayed with a blue arrow and can be shown or hidden 

with a mouse click.
•	 Inactive steps are displayed in grey with a padlock symbol. Functions/steps required for 

activation are shown via MouseOver.

	 For each step/function, a Function Tool is automatically 
displayed, showing all options you currently have. IMPAX 
Orthopaedic Tools offers a function tool for all functions.

	 As an example, the Line Tool is shown on the right, offering 
you a selection of various line types. They are all displayed 
in a convenient selection list.

	 Additionally, you can set or change the relevant attributes 
for the element to be drawn – color, line style, paragraph 
format, font type and size.

	 You can always skip functions or repeat them in case of changes. Steps displayed in grey with a pad-
lock symbol are inactive and can not be performed. Those functions will be activated, once another 
required function is performed. After deleting elements created with a function, the deleted step will 
be displayed with a yellow arrow again.

	 In order to exit the function tool, use the symbol in the upper right corner or (in case you 
haven’t started the function yet) by a right click with the mouse.

	 By using the Toolbar, you can perform functions without using the module tool.

4.	 After that, insert implants and determine the intraoperatively relevant dimensions.

5.	 Prior to saving, check and/or complete the  Planning info.

6.	 In the end, print and/or save the results as an .mpl file or in DICOM format. Once the planning is 
completed, transfer the planning image into the IMPAX database.

Importing Images

This feature is intended to load multiple Images into the viewing panel. First, 
use the Image Selection tool in IMPAX and select the images you want to use 
in IMPAX Orthopaedic Tools. You can select any number of images.

Then, click the IMPAX Orthopaedic Tools button on the IMPAX toolbar. IMPAX orthopaedic Tools will 
open with the currently active image. Apply scaling as usual and terminate with right mouse click.

Import Image from File
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Then, select menu item Images > Insert image (file) or click on the Insert and edit Images icon of the 
toolbar and select Insert image (file) in the image tool.

In the list you will see all images which were selected in IMPAX when you launched IMPAX Orthopa-
edic Tools, inclunding the one which is already loaded. If you are not sure which one is the second 
image, activate the Preview by clicking on the corresponding checkbox. This will allow you to see the 
contents of the files as well as further image information. Click on the Open button. The selected 
image is now shown and you are automatically prompted to scale it as well.

Depending on the screen location of your first image, the second image may be overlapping or even 
be completely on top of the first image. Use the Quick Move tool to select the second image and 
move it to a proper position.

Proceed accordingly for all additional images.

Scaling Images

All images must be scaled, so as to enable measures to be taken true to scale and to ensure that all prostheses 
will be inserted using the correct scale. All prostheses of the IMPAX Orthopaedic Tools database are drawn in a 
1:1 scale.

WARNING
Images can only be properly scaled, if a reference object (sphere or scale bar) with dimensions 
known to the user is placed in the image region, close to and at the level of the joint/bone 
area you are interested in, when recording the image. Please verify the entered scaling size tho-
roughly, wrong input can lead to serious miscalculation. The original IMPAX Orthopaedic Tools 
sphere has a 25 mm diameter with a +/- 0.1 mm tolerance. When using other reference objects, 
measure and tolerance of the respective manufacturer apply. Please pay extreme attention to 
the Image Requirements and Scaling Instructions at the end of this User Manual.

IMPAX Orthopaedic Tools offers the following scaling methods:

•	 Scaling with automatic sphere detection (can only be selected in the standard settings)
•	 Scaling with a circle, e.g. when a scaling sphere is visible in the image
•	 Scaling with a distance line, e.g. when a rectangular scaling bar is visible in the image
•	 Scaling with a magnification factor

You can select your favorite method in the standard settings. This way, you can skip the manual selection of the 
scaling method for each scaling procedure. You can still select a different method on a case-by-case basis.

Automatic Sphere Detection

After loading the image, the automatic sphere detection is per-
formed and the results shown.

Please check the result carefully (you can adjust the sphere size 
or select it from the FlyOut list with previous and standard values; 
previously used values can also be deleted directly in this list).

Especially avoid mixing up the scaling sphere with a possibly used 
round x-ray marker. If there is a match, confirm the scaling, other-
wise proceed to manual scaling.
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Select Manual Scaling Method

To achieve greater accuracy, enlarge the part of the image 
containing the reference object by zoom-ing in with the scroll 
wheel of the mouse or using the zoom icons of the toolbar.

Activate the desired method by clicking on the respective option in the se-
lection list.

Scaling by line
Click on the start and end points of the distance line you want to use, e.g. alond a visible scale bar. Enter the length 
in mm and confirm by clicking on Apply Scale or using the Enter key.

Scaling by circle (3 points)
Select two points on the outer edge of the scaling sphere by clicking on them with the mouse. Drag the circle open 
with the mouse so it matches the outline of the scaling sphere. Fix the circle with another mouse click. Enter the 
diameter of the scaling sphere in mm and confirm by clicking on Apply Scale or using the Enter key

Scaling by circle (2 points)
Select one point on the outer edge of the scaling sphere with 
a mouse click. Move the mouse to the opposite outer edge 
of the scaling sphere and set the second edge point with a 
mouse click once the drawn circle matches the outline of the 
scaling sphere. Enter the diameter of the scaling sphere in mm 
and confirm by clicking on Apply Scale or using the Enter key.

Scaling by magnification factor (Only for DICOM images containing image data)
Enter the magnification factor of the image in % into the input field and confirm by  clicking on Apply Scale or using 
the Enter key. If the original magnification of an x-ray was e.g. 1:115, enter magnification factor 115. This allows 
for a 1:1 scaling of the image.

Adjust Scaling

If you want to adjust the scaling later, select menu item Images 
> Image tool or click on the Insert and edit images icon of the 
toolbar.

Now, click on any point of the inserted image. The current scal-
ing factor is displayed in the image tool. You can now select the 
scaling method and perform the scaling again.

WARNING
If you want to adjust the scaling after having already done some planning on the image, you 
have to delete all graphics and elements first and recreate them after the scaling is adjusted, 
otherwise they won't be in proper scale anymore.

WARNING
Scaling by magnification factor is executed without a known/verifiable scaling object and 
therefore with no warranty. A warning message is displayed when selecting this method. This 
scaling method is not recommended.
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Planning Information

ATTENTION
This procedure is mandatory due to legal reasons.

In order to calculate geometrical parameters 
and for documentation purposes, information 
is required about the patient and the physician 
carrying out the planning.An input form Plan-
ning info is created automatically with every 
image. Information is either filled in using the 
information from the DICOM header, or must 
be completed by the physician. This form ap-
pears automatically whenever you want to 
save the IMPAX Orthopaedic Tools planning. 

Important patient info (depending on the re-
spective settings) is constantly displayed in 
the planning. Additionally, you can use the re-
spective function in each module to insert the 
planning information into the planning.

When saving the planning, you will automat-
ically be required to check and complete the 
Planning Information. 

Check and complete all patient related data. Any missing information (height, weight) will not be saved in IMPAX. 
The next time this study is loaded, that information will be missing again.

The fields Physician Name, Patient Name and Patient Birthday must always be filled out.
For the Biometry module, specification of patient's height and weight are mandatory.
For the Coxometry module, please also specify the recording date.

WARNING
When saving a file in order to set aside a planning and resume work at a later time, choose a file 
name that ensures unambiguous connection between the planning data and the patient, for 
example: patient name and date of birth. Incorrect assignment of plannings can have serious 
consequences for the patient.

CAUTION
The data entered in this window from the DICOM header must never be changed, with the excepti-
on of e.g. saving the planning image in an anonymized knowledge database. 

Correction of Planning Information

In case you want to correct the planning information at a later time, click on the Planning info button in the mod-
ule tool. The input form is shown and you can adjust and modify the data accordingly.

NOTE
After prosthesis templates have been inserted, an Implants list will be generated in which all pros-
thesis data is applied. Only implants saved in the final version are documented. This list also includes 
order  or reference numbers (when available) and other information about the used implants. 
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Inserting Implants

There are two ways to insert a new prosthesis or a new implant:

•	 Templates Module in the module overview – You can 
select and insert all available prostheses and implants 
directly

•	 From any other module – You can select and insert all 
prostheses and implants relevant for this module (e.g. 
cup and stem in the Hip module)

The prosthesis used last is always attached to the mouse cursor. When 
activating the currently required prosthesis, the mouse cursor display 
changes accordingly. 

Using the function Next Prosthesis you can add the next/additional 
prostheses.

The procedure for plates, nails and screws works accordingly.

IMPAX Orthopaedic Tools offers 2 options for prosthesis selection:

•	 selection from a pull down menu
•	 selection from a menu (list)

WARNING
All dimensions and measurements given by the IMPAX Orthopaedic Tools prosthesis databa-
se derived from original manufacturer data or templates. If you suspect that the data is not 
correct, please report it to Agfa‘s service representative or contact Agfa using the contact 
information provided in the beginning of this manual.
Please always make absolutely sure to use the prosthesis corresponding to the correct body 
side of the patient.

Selection from a Pull Down Menu

By touching each button, a pull down menu 
appears, allowing you to make the desired se-
lection.

You can proceed in any desired order, e.g. you 
can select: Manufacturer, Prosthesis series, 
Prosthesis type, Implant size, Neck length.

Successively click on the single buttons. The 
buttons always display the current selection. 
Depending on the selection made, the avail-
able successive options can change.

When the prosthesis selection is finished, the 
prosthesis is attached to the mouse cursor 
and can be inserted.
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Inserting of a prosthesis does not depend on how the prosthesis is selected (menu/list or pull down menu). As 
soon as you have selected the desired prosthesis, place the prosthesis with a left mouse click. To pick the prosthe-
sis up again and move it to another position, use a left mouse click as well.

As long as you are in this function, you can switch to a different prosthesis type of your choice by using the pull 
down menu or the menu/list. With a right click of the mouse, the prosthesis is confirmed as final and you exit the 
function.

Using the function Next (= next prosthesis), the current prosthesis is confirmed and you can select another pros-
thesis, e.g. a cup fitting to a stem, or a femoral component fitting to a tibial component.

Selection from the Menu List

The menu list is activated by clicking on the Menu button. A list appears, containing all prosthesis data you can 
currently use:

Click on the desired attributes to make your selection, e.g.:
Manufacturer – Prosthesis series – Prosthesis type – Implant size – Neck length

The number of columns vary for different types and manufacturers of prostheses. Depending on the selection 
made, the available options in the successive columns can change.

When the prosthesis selection is finished, the prosthesis is attached to the mouse cursor and can be inserted.

Insert Prosthesis

NOTE
EXCEPTION: Screws are always to be positioned using a starting point and an ending point. They 
vary in length according to the mouse position and are confirmed as final by setting the end point. 
They can not be moved anymore. Changes can only be made using the Delete function and inserting 
a new one, or using the Move function.

Edit Prosthesis

As long as the prosthesis is not confirmed as final, you can always pick the prosthesis up again with 
a left mouse click, move it or change it. The prosthesis is only confirmed as final if you click the right 
button of the mouse.

A prosthesis thas has already been confirmed as final can be changed/modified/moved by clicking on 
it and selecting the Edit icon in the pop-up context menu.
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Showing and Hiding of Functions/Icons/Prostheses

You can show or hide any function or element in each module tool, as well as in the toolbar and the prosthesis 
menu list. The shown/hidden elements are saved and are at your disposal the next time you work with IMPAX 
Orthopaedic Tools.

In order to hide an element, select it with a right mouse click. In the pop-up 
context menu, select Hide item.

Hidden elements in the module tool and the prosthesis menu list are iden-
tified by the following mark at the end of the function or prosthesis list:: 
»»»

In order to show a hidden element again, perform a right mouse click on the module tool, toolbar or prosthesis 
menu list. In the pop-up context menu, select the element to be shown again, listed unter menu item Show ele-
ment.

Using the function Display all (this session only) in the context menu, you can show all hidden elements for the 
current session only. When you start the program the next time, they will be hidden again. The same result can 
be achieved by clicking on the symbol »»» – The temporarily shown elements are displayed in parentheses, in 
the prosthesis menu list in grey color. With a right mouse click, you can select specific elements and show them 
permanently.

Using the function Show all items (reset) in the context menu, you can show all hidden elements permanently 
again.

Saving

IMPAX Orthopaedic Tools distinguishes images between the native IMPAX Orthopaedic Tools format .mpl, suitable 
for further planning and editing, and DICOM images, saved into your archive as final, non-changeable documents.

.mpl
IMPAX Orthopaedic Tools native format. Only for setting aside a planning and resume work at a later time or to be 
able to make changes and corrections. Saves the planning as an .mpl file in the file system of your computer on a 
local harddrive. At this time, it is not saved into the IMPAX database.
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NOTE
Requires appropriate user privileges on the computer used as well as compliance with safety and 
privacy regulations. Unauthorized access to privileged patient information must be prevented.

DICOM
Once the planning is complete, the final image is saved into the IMPAX database. By doing so, all graphical ele-
ments, e.g. outlines, prosthesis templates, texts, are permanently merged with the image and can no longer be 
modified.

Save File

In order to save your planning, select menu item File > Save planning, click on the Save planning icon 
of the toolbar or use the keyboard shortcut Ctrl + S.

After entering/completing the planning information in regards to physician and patient, checking its 
accuracy and confirming with OK, the file will be saved.

When saving the document for the first time, the Save planning as dialogue window is shown. You can 
now enter the file name and change file type and target folder if required.

Export as DICOM/Bitmap...

In order to transfer the planning into your database, select menu item File > Export as DICOM/Bitmap... After 
entering/completing the planning information in regards to physician and patient, checking its accuracy and con-
firming with OK, the Export as DICOM/Bitmap dialogue window is shown.

You can now enter the file name and, if required, adjust the DICOM/file type as well as the target folder. We re-
commend to keep the file type DICOM Image - uncompressed (*.dcm) unchanged. Any existing planning files in 
the predefined export folder are usually not yet saved in your local database.

Use the control button Save to save the planning. If a file with the selected name already exists, a security query 
alerts you to make sure not to overwrite other plannings.

The pre-selected file type is IMPAX Ortho-
paedic Tools Planning (*.mpl). This format 
allows you to save the planning together 
with all planning details and is suitable for 
further editing.

In case you choose to save the planning in one of the DICOM or other file types, all graphical elements, 
planning objects and texts are permanently merged with the image and can no longer be modified.

Use the control button Save to save the planning. If a file with the selected name already exists, a 
security query alerts you to make sure not to overwrite other plannings.

If you want to save an existing planning under a different file name or in another format, select menu 
item File > Save Planning As... – the dialogue window described above also appears.

WARNING
Choose a file name that ensures unambiguous connection between the planning data and the 
patient, for example: patient name and date of birth. Incorrect assignment of plannings can 
have serious consequences for the patient.
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Transfer Planning Into IMPAX / Save to PACS

Using the EndoDok Interface

After five years of development, the German Society for Orthopedics and Orthopedic Surgery (Deutsche Ge-
sellschaft für Orthopädie und Chrirurgie – DGOOC) has released a certification procedure for endoprosthetics 
centers, working with 20 pilot clinics. This is the first certification procedure worldwide defining the quality criteria 
of clinics that perform implantations of endoprostheses.

When establishing an endoprosthetics center, an adequate software is the foundation for all requirements for the 
purposes of certification, especially when determining and documenting quality indicators. This creates overlaps 
with preoperative planning, with regard to required data and functionality.

An interface with Xaxoa’s EndoDok software has been implemented in IMPAX Ortho-
paedic Tools, allowing for corresponding documentation within the scope of above 
mentioned certification procedure.

If EndoDok is installed and available on your system and the EndoDok was activated in the correspond-
ing settings, you can not only transfer your planning into your PACS system but also make it available 
for EndoDok. Click on the Export to PACS icon of the toolbar (available for the modules Manual Plan-
ning, Automatic Planning, Biometry and Knee).

As usual, the planning info form is displayed for the purpose of completion/confirmation. After entering/complet-
ing the planning information in regards to the physician and patient as well as checking its accuracy,  confirm by 
clicking on the OK button.

Next, activate/deactivate the Endodok-Export if needed. Select the required case from the drop down menu: 
Primary Reconstruction, Exchange Arthroplasty, Fracture Reconstruction, Tumor Reconstruction. You can also 
specify the pathological body side and define if it’s a pre or post operative measurement.

After selecting the corresponding case, confirm by clicking on the Finish button. The file type is DICOM, a UniqueID 
is added to the image. From the export folder, the image is automatically retrieved and saved into the database of 
your PACS application.

Additionally, the planning image as well as the implant information is made available in the specified EndoDok 
directory, or (if activated in the settings accordingly) uploaded directly to the selected server via FTP.

You can now open the EndoDok software the way you are used to, or do so by clicking on the EndoDok 
icon in the toolbar. 

The planning you have just saved including all corresponding information will be available within no more than one 
minute for further handling and evaluation.

The data is either added to an existing patient/case, or a new patient/case is automatically created.

In order to transfer the planning into IMPAX, click on the Save to PACS icon of the toolbar.

The image(s) will be automatically added as a new series to the current study and will be visible in 
IMPAX after a short delay.

NOTE
When saving in DICOM format, all graphical elements, planning objects and texts are permanently 
merged with the image and can no longer be modified.
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For further support regarding the EndoDok interface or software, contact the manufacturer XAXOA:

		  XAXOA
		  Friedrichstr. 191
		  10117 Berlin
		  Germany

		  Hotline:	 +49 (0) 30 20659-459
		  Email:	 support@xaxoa.de

Working in Offline Mode

Via menu item File > Work offline, you can put IMPAX Orthopaedic Tools into offline mode and release the license 
used. This can be of particular significance when only a restricted number of licenses are available in your network 
and another person needs to perform a planning while you are pausing your work, for example during a break.

When in offline mode, all planning functions are deactivated, except the possibility to save your planning and/or 
export it to your PACS system.

By deselecting the offline mode in the File menu, you can resume your work.

Depending on the settings made during setup, IMPAX Orthopaedic Tools switches into offline mode after a specific 
idle time.

Convert IMPAX Orthopaedic Tools Plannings to DICOM

If you want to convert a larger number of existing IMPAX Orthopaedic Tools plannings (.mpl format) into DICOM 
format (e.g. when transferring previous plannings into a newly installed PACS system), you no longer have to open 
and re-save each planning individually. Instead you can use the integrated converter tool.

Via menu item File > Convert IMPAX Orthopaedic Tools Plannings to DICOM, the converter tool is opened.
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By clicking on the File icon, you can add all plannings to be converted. They are then displayed in the 
planning list.

By selecting individual or multiple plannings and subsequently clicking on the Delete icon, you can re-
move the selected plannings from the list.

Select the desired export directory. Optionally, you can choose to overwrite any existing DICOM files.

By clicking on the Convert button, the conversion procedure is started. The current status is being displayed in the 
progress bar.

After completing the conversion procedure (or if you want to return to IMPAX Orthopaedic Tools without conver-
sion), close the tool by clicking on the Close button.
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New Planning

This feature is intended to load multiple Images into the viewing panel of IMPAX Orthopaedic Tools. 
Before any further editing, the scaling procedure is performed. In order to insert images in IMPAX Or-
thopaedic Tools, select menu item Images > Insert image (file), or click on the Insert and edit images 
icon of the toolbar and select Insert image (file) in the image tool.

You can now insert the image and scale it thereafter. Further information on the exact procedure can 
be found in chapter »Working with IMPAX Orthopaedic Tools« in sections »Importing Images« and 
»Scaling Images«.

WARNING
Images can only be properly scaled, if a reference object (sphere or scale bar) with dimensions 
known to the user is placed in the image region, close to and at the level of the joint/bone 
area you are interested in, when recording the image. Please verify the entered scaling size tho-
roughly, wrong input can lead to serious miscalculation. The original IMPAX Orthopaedic Tools 
sphere has a 25 mm diameter with a +/- 0.1 mm tolerance. When using other reference objects, 
measure and tolerance of the respective manufacturer apply. Please pay extreme attention to 
the Image Requirements and Scaling Instructions at the end of this User Manual.

Insert and Edit Images

Using the controls in the module tool, you can adjust brightness 
and contrast of the image.

For DICOM images, the standard settings are automatically used.

The automatic button allows for an automatic adjustment based 
on the highest and lowest grey-scale value of the image.

If you want to start a new planning, proceed as described in chapter »Working with IMPAX Orthopae-
dic Tools« in sections »Starting IMPAX Orthopaedic Tools« and »Planning Workflow«.

A new document is opened, in which you can perform your planning.

The work area shows the module overview. All modules purchased with you license package are 
shown, all other modules are shown faded out. 
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Under menu item Images you can also activate all func-
tions for image editing.

The following functions are available:
Insert image (file)
Paste clipboard
Copy and move move image area
Cut and move image area
Image tool
Hide all images
Invert images (on screen)

The 10 most recent images are listed.

After scaling an image, you can further edit the image by activating the image tool. Select the image 
with a mouse click. It is now marked by small dots on its corners. Then, select one of the edit func-
tions.

With Copy and move image area, an image area is created and can 
be moved or rotated using the mouse. The original image stays intact.

With Cut and move image area, an image area is created and can 
be moved or rotated using the mouse. The image is cut out of the 
original, a black area appears on the original position of the cut image 
area.

With Rotate image, you can rotate the image by using a line creat-
ed by two mouse clicks. The first click marks the rotation center and 
starting point of the line, the second click sets the end point of the 
line. Now you can rotate the image and place it with another click of 
the mouse.

Open Planning

Opens a planning previously created by you or another person for purposes of viewing or further ed-
iting. In order to open a planning, select menu item File > Open planning, click on the Open planning 
icon of the toolbar or use the keyboard shortcut Ctrl + O.

You can use this function to open files in the .mpl (IMPAX Orthopaedic Tools Classic Planning) and 
.prt (IMPAX Orthopaedic Tools Classic 1.xx Drawing) formats.

Save Planning

Saves a planning in a predefined or any other folder of your workstation, including all planning infor-
mation. Only for setting aside a planning and resume work at a later time.

In order to save a planning, select menu item File > Save planning, click on the Save planning icon of 
the toolbar or use the keyboard shortcut Ctrl + S.
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Check and/or complete the planning information, especially the name of the planning physician, as 
well as the patient's name and date of birth. After that, you can save the planning on your local work-
station in the IMPAX Orthopaedic Tools format .mpl. This way, it is available for further editing and 
planning. You can  also save your planning in DICOM format into the IMPAX database. This way, it is 
saved as a final document and can not be changed or modified anymore. 

Further information about the various saving procedures can be found in chapter »Working with 
IMPAX Orthopaedic Tools«, section »Saving«.

WARNING
Choose a file name that ensures unambiguous connection between the planning data and the 
patient, for example: patient name and date of birth. Incorrect assignment of plannings can 
have serious consequences for the patient.

Print Planning

In order to print the current planning, select menu item File > Print planning or use the keyboard 
shortcut Ctrl + P. When using the Print planning icon of the toolbar, the print section tool is opened 
before the main printing function.

Export to PACS

You can use this function to transfer your plannings directly into your PACS system.

Further information about this function can be found in chapter »Working with IMPAX Orthopaedic 
Tools«, section »Transfer Planning Into IMPAX / Save to PACS«.

The print section tool lists all defined print sections, which 
can be deleted separately or all at once. The respective print 
section is highlighted in the planning for clear reference.

A print section can be defined by a simple mouse click in the 
work area. The Scale defines the size of the section – the 
greater the scale factor, the smaller the printed section of 
the image. Adjust to paper size allows you to draw a freely 
selectable area as a print section.

You can select the desired printer and paper format by using 
the Printer setup button or via menu item File > Printer Set-
up, as usually done on Windows computers. Finally, you can 
execute the printing function.

Furthermore, you can select additional IMPAX Orthopaedic 
Tools specific options for the print job in the print menu win-
dow.
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Select Size (Shaft/Head/...)

Allows you to select the required shaft width or neck length, a specific inlay or a nail length or width 
for a previously inserted implant.

In order to select the required size, click on the Select Size (Shaft/Head/...) icon of the toolbar. By 
a simple mouse click on the required size option, the size can be selected. All other size options are 
hidden. To show all size options again, click again on the selected size.

Once you have selected the proper size, end the function with a right click.

Line or Element is the predefined capture mode.

Move/Copy/Mirror/Rotate

One or more selected elements can be moved, copied, mirrored or rotated, depending on the com-
mand activated in the function tool.

In order to perform one or more of these functions, click on the Move/Copy/Mirror/Rotate icon of 
the toolbar. The copy/move tool opens. The functions can be performed in any (even multiple) com-
bination.

When no function is selected, the default function is Move. 
You can freely move the selected element using the mouse.

Copy: Allows copying of the selected element or implant, 
which then can be freely placed in addition to the original.

Mirror by axis: You can mirror/flip the selected element 
over a freely determinable axis.

Select images: After selecting one or more elements and 
then activating this function, an image or image area can 
be moved/copied/mirrored/rotated together with the ele-
ments.

Mirror/flip horizontal and vertical: You can mirror/flip the 
selected element horizontally and vertically.

Rotate: The selected element can be rotated according to 
the chosen angle.
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Instructions for Moving

In order to move one or multiple elements, proceed as follows:

1.	 Select all elements to be moved separately or define an area containing all elements to be moved 
by two mouse clicks.

2.	 End selection by a right click (always required).
3.	 Select a grab point for the elements to be moved. In capture mode Free, you can place the mouse 

cursor at any position of the image. Using the P key, you can switch to the capture mode Point. This 
allows you to capture a specific grab point (e.g. neck center), as soon as the mouse cursor comes 
near it.

4.	 The selected elements are now attached to the mouse and can be moved across the image by mov-
ing the mouse. For rotation, use the ← → keys, to adjust a prosthesis size, use the ↑↓ keys.

5.	 Select the target point for the moved elements. In capture mode Free, you can place the mouse cur-
sor at any position of the image. Using the P key, you can switch to the capture mode Point. This al-
lows you to capture a specific end point (e.g. cup center), as soon as the mouse cursor comes near it.

6.	 The elements are moved. A right click exits the function.

In order to move elements together with an image/image area, proceed as follows:

1.	 Select all elements to be moved separately or define a specific area.
2.	 Activate the Select images function in the copy/move tool.
3.	 Select the image to be moved together with the elements.
4.	 A right click ends selection.
5.	 Select the grab point for the elements to be moved.
6.	 The selected elements are now attached to the mouse and can be moved across the image by mov-

ing the mouse. For rotation, use the ← → keys, to adjust a prosthesis size, use the ↑↓ keys.
7.	 Select the target point for the moved elements.
8.	 The elements are moved. A right click exits the function.

Instructions for Copying

In order to copy one or multiple elements, proceed as follows:

1.	 Activate the Copy function in the copy/move tool. 
2.	 Select all elements to be copied or define a specific area.
3.	 A right click ends selection.
4.	 Select the grab point for the elements to be copied.
5.	 A copy of the selected elements is now attached to the mouse and can be moved across the image 

by moving the mouse. For rotation, use the ← → keys, to adjust a prosthesis size, use the ↑↓ keys.
6.	 Select the target point for the copied elements.
7.	 The elements are copied. A right click exits the function.

Instructions for Mirroring

In order to mirror one or multiple elements, proceed as follows:

1.	 Activate the Mirror by axis function in the copy/move tool.
2.	 Select all elements to be mirrored or define a specific area.
3.	 A right click ends selection.
4.	 Define the first point of the mirror axis to be used (e.g. body center).
5.	 Define the second point of the mirror axis.
6.	 The elements are mirrored. A right click exits the function.
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Instructions for Mirroring/Flipping horizontally and vertically

In order to mirror/flip one or multiple elements horizontally or vertically, proceed as follows:

1.	 Select the Mirror (horizontal) or Flip (vertical) function in the copy/move tool. 
2.	 Select the elements to be mirrored/flipped, or define a specific area.
3.	 A right click ends selection.
4.	 Select the grab point for the elements to be mirrored/flipped.
5.	 The selected elements are now mirrored/flipped, attached to the mouse and can be moved across 

the image by moving the mouse. For rotation, use the ← → keys, to adjust a prosthesis size, use the 
↑↓ keys.

6.	 Select the target point for the elements.
7.	 The elements are mirrored/flipped and positioned. A right click exits the function.

Instructions for Rotating

In order to rotate one or multiple elements, proceed as follows:

1.	 Select the elements to be rotated, or define a specific area.
2.	 A right click ends selection.
3.	 Select the rotation angle in the copy/move tool, in which the elements are to be rotated. Alterna-

tively, you can also select a default value offered in the fly out window.
4.	 Select the grab point for the elements to be rotated.
5.	 The selected elements are now rotated, attached to the mouse and can be moved across the image 

by moving the mouse. For rotation, use the ← → keys, to adjust a prosthesis size, use the ↑↓ keys.
6.	 Select the target point for the elements.
7.	 The elements are rotated and positioned. A right click exits the function.

Quick Move/Copy/Mirror/Rotate

A selected element can be moved, copied, mirrored or rotated, depending on the command activated 
in the function tool.

In order to perform one or more of these functions, click on the Move/Copy/Mirror/Rotate icon of 
the toolbar. The copy/move tool opens. The functions can be performed in any (even multiple) com-
bination.

This function is identical to the regular version, but only possible with a single element/image. Ending 
the element selection by a right click is not required.

In order to open this function, you can also select the required element and use the Quick Move icon  
in the pop-up context menu.

Quick Copy

Single elements can be quickly copied using this function. In order to copy an element, select the 
respective element with a mouse click and use the copy icon in the pop-up context menu.

A copy of the selected element is now attached to the mouse and can be moved across the image by 
moving the mouse. With a mouse click, the element is placed at the target point. The function ends 
automatically.



57

IMPAX Orthopaedic Tools» Table of Contents «

» Table of Contents «

Functions & Symbols

Delete

Single elements or element groups can be deleted using this function. In order to delete an element, 
select the respective element with a mouse click and use the delete icon in the pop-up context menu. 

Or click on the Delete icon of the 
toolbar. The delete tool opens (see 
image on the next page). You can 
now delete elements with a mouse 
click or by selecting a specific area, 
as well as choose further options.

Using the option Single elements, specific elements in element groups can be deleted, e.g. a label or 
measurement next to inserted implants. You can also select any available group and delete it com-
pletely. Groups are separate elements connected together, like prosthesis implants and their labels.

Undo & Redo

Using these functions, you can undo or redo one or multiple steps previously performed.

In order to undo a step, select menu item Edit > Undo, click on the Undo icon of the toolbar or use 
the keyboard shortcut Ctrl + Z respectively the U key.

In order to redo a step (i.e. cancel a previous undo command), select menu item Edit > Redo, click on 
the Redo icon of the toolbar or use the keyboard shortcut Shift + U.

You can undo or redo as many steps, as specified on the Advanced tab of the system settings.

Zoom All

Adjusts the zoom factor to show the whole planning in the work area.

Click on the Zoom All icon of the toolbar or use the A key.

Zoom Rect

Zooms a rectangular area to fit into the work area.

In order to zoom an area, click on the Zoom Rect icon of the toolbar or use the W key.

Click on any corner point of the area to be selected. Now move the mouse to the second, opposite 
corner point – you can see a selection mark depicting the zoom area. End selection with another 
mouse click, the selected area is zoomed into the work area and displayed. You can use this function 
in the work area as well as in the overview window.
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Zoom Pan

You can grab and move the screen content at any desired point.

Click on the Zoom Pan icon of the toolbar or use the X key.

The screen content is attached to the mouse with a simple mouse click. Move the screen content to 
the desired position. A second mouse click puts the screen content back down.

Alternatively, you can move the screen content directly by pressing the scroll wheel of the mouse.

Zoom In & Zoom Out

This functions zoom in or out of the planning using a fixed zoom factor..

In order to zoom in or out of the planning by the factor 1.25, click on the Zoom In or Zoom Out icons 
of the toolbar.

You can also zoom in or out of the planning by using the scroll wheel of your mouse. The zoom is 
performed in relation to the position of the mouse cursor.

In order to reduce the zoom factor by half, use the H key. In order to increase the zoom factor by 
double, use the T key.

If you are working in another function or module tool, you don't need to exit in order to use this func-
tion. Just activate Zoom Pan additionally and move the image to the desired position. At the same 
time, you can use the scroll wheel of your mouse to zoom in or out.

Afterwards, you can exit the function with a right click of the mouse and return to the previous func-
tion. As the function Zoom Pan interrupts all other functions, you must always exit with a right mouse 
click. Only then can you continue with the previous function.

Arrows

This function draws arrows.

Click on the Arrows icon of the toolbar. The arrow tool opens. You can now select Line color and Line 
width.

In order to draw an arrow:

1.	 Define the starting point of the arrow.
2.	 Define the end point of the arrow. Using the space key or selecting the respective op-

tion in the arrow tool, you can reverse the arrow‘s direction.
3.	 The arrow is drawn. You can now draw another arrow, or exit the function with a right 

click of the mouse.
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Lines

This function draws various lines.

Click on the Lines icon of the toolbar. The line tool opens. You can now select Line color, Line width 
and Line style. Furthermore, you can select from different Line types:

Line by two points:
Draws lines with starting and end points.

Line by angle:
Draws lines in a defined angle to a reference line. The angle 
can be entered manually or selected from a range of stan-
dard values.

Parallel by distance:
Draws a parallel line in a defined distance (mm) to a refer-
ence line.

Trim length:
Adjusts the length of existing lines.

Centerline by 4 points:
Automatically defines a center axis by using 4 boundary points.

Horizontal/vertical:
Draws horizontal and vertical lines.

Instructions for Line by 2 Points

In order to draw a line by 2 points:

1.	 Define the starting point of the line.
2.	 Define the end point of the line.
3.	 The line is drawn. You can now draw another line, or exit the function with a right click 

of the mouse.

In order to draw a line by angle:

1.	 Enter the angle in ° in the line tool or select the angle from the listed standard values.
2.	 Select the reference line. The capture mode is Line or Element.
3.	 Place the line on the required position.
4.	 The line is drawn. You can now draw another line, or exit the function with a right click 

of the mouse.

In order to draw a parallel line:

1.	 Enter the distance in mm in the line tool or select the distance from the list with previ-
ously used values. 

2.	 Select the reference line. The capture mode is Line or Element.
3.	 Place the line on the respective position. If you haven't selected a value in mm, you can 

place the line in any desired distance to the reference line.
4.	 The line is drawn. You can now draw another line, or exit the function with a right click 

of the mouse.

Instructions for Line by Angle

Instructions for Parallel Line
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In order to trim a line's length:

1.	 Select the end point of a previously drawn line with a mouse click.
2.	 Define a new end point of the line.
3.	 The length of the line is successfully changed. You can now edit another line, or exit the 

function with a right click of the mouse.

In order to draw a centerline by 4 points:

1.	 Define the first point of the first aid line.
2.	 Define the second point of the first aid line.
3.	 Define the first point of the second aid line.
4.	 Deinfe the second point of the second aid line.
5.	 The line is drawn through the centers of the two aid lines. You can now draw another 

line, or exit the function with a right click of the mouse.

To draw a horizontal or vertical line:

1.	 Define the start point of the line.
2.	 Define the end point of the line. Only end points in horizontal or vertical position to the 

start point are possible.
3.	 The line is drawn. You can now draw another line, or exit the function with a right click 

of the mouse.

Instructions for Length Trimming

Instructions for Centerline by 4 Points

Instructions for Horizontal/Vertical Lines

Points

This function draws various points.

Click on the Points icon of the toolbar. The point tool opens. 
You can now select point color and point weight as well as 
the point size in mm. Furthermore, you can choose from a 
range of various point styles (which can be combined by 
pressing the Ctrl key during selection).

In order to draw a point, a simple mouse click is all. A right click exits the function.

Outlines

This function draws outlines, e.g. femur or tibial outline.

Click on the Outlines icon of the toolbar. The curve tool opens. You can now select Line color and 
Line width as well as the amount of automatic Intermediate points. Furthermore, you can select the 
Interpolation method:
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Spline (natural):
Draws naturally rounded outline curves. This is the recom-
mended standard setting.

Polyline:
Draws polylines with multiple straight lines.

Polyline closed:
Draws polylines, with their last point automatically connect-
ing to the start point, creating a closed area.

Calculate areas/subareas:
If activated, the size of areas created with an outline are de-
termined. If the outlines overlap and create subareas, their 
size can be calculated as well.

In order to draw an outline, you can either successively define any required number of intermediate 
points or draw the outline while holding down the mouse button. A right click with the mouse com-
pletes the outline. In order to remove or adjust intermediate points, use the  Reject last point button 
or the Backspace key.

Create, Edit and Move Text

Using this function, you can create new text as well as edit, move or rotate existing text.

In order to create new text, click on the Create Text icon 
of the toolbar. The create text tool opens. You can now se-
lect text color, font type and font size as well as the usual 
Windows Paragraph alignment. Additionally, the following 
options are available:

Proportions/Fixed font size:
Defines if text size remains when zooming, or if text size 
changes proportionally to the zoom factor.

Angle:
The text angle in ° can be entered manually or selected from 
the listed standard values.
The text angle can also be manually adjusted at any time by 
using the ← and → keys.

Notepad:
Opens the Windows notepad, which allows for easier cre-
ation and editing of larger text.

In order to create a text:

1.	 Enter the required text in the text input field of the create text tool.
2.	 Place the text on the desired position with a mouse click.
3.	 The text is created. You can now create another text or exit the function with a right 

click of the mouse.
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Circle (3 points):
Draws a circle using 3 edge points.

Circle (2 edges):
Draws a circle using 2 edge points.

Circle (center + edge):
Draws a circle using center point and edge point.

Arc (3 points):
Draws an arc using 3 edge points.

Arc (2 edges):
Draws an arc using 2 edge points.

Arc (center + edge):
Draws an arc using center point and edge point.

Ellipse (3 points):
Draws an ellipse using 3 edge points.

Ellipse arc (3 points):
Draws an ellipse arc using 3 edge points.

In order to edit/modify an existing text:

1.	 Select the text to be edited with a mouse click (if not already selected via the pop-up 
context menu).

2.	 Edit the text and change the text attributes in the edit text tool.
3.	 Pick the text up with a mouse click in order to move it.
4.	 Place the text on the desired position.
5.	 The text is moved/modified. You can now change additional attributes or exit the text 

editing function with a right click of the mouse.

Circles

This function draws circles, ellipses, arcs and ellipse arcs.

In order to draw a new circle, arc or ellipse, click on the Circle icon of the toolbar. The circle/arc tool 
opens. You can now select Line color and Line width.

Furthermore, you can additionally select the automatic drawing and measuring of center point, di-
ameter and radius.

You have multiple options for drawing circles, ellipses and arcs:

In order to edit/modity an existing text, click on the Edit and/or move text icon of the toolbar. Or 
selecte the respective text with a mouse click and use the edit Icon in the pop-up context menu.The 
edit text tool opens.

NOTE:
For safety reasons, Implant texts (e.g. size/description) can not be modified.
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In order to draw a circle using 3 points:

1.	 Define the first edge point of the circle.
2.	 Define the second edge point of the circle.
3.	 A circle preview is displayed. Define the third edge point of the circle.
4.	 The circle is drawn. You can now draw another circle, or exit the function with a right 

click of the mouse.

Instructions for Circle (3 Points)

In order to draw a circle using center point and edge point:

1.	 Define the center point of the circle.
2.	 A circle preview is displayed. Define the edge point of the circle. Using the space key, 

you can switch center and edge point.
3.	 The circle is drawn. You can now draw another circle, or exit the function with a right 

click of the mouse.

Instructions for Circle (Center + Edge)

In order to draw an arc using 3 points:

1.	 Define the first edge point of a circle.
2.	 Define the second edge point of a circle.
3.	 A circle preview is displayed. Define the third edge point of a circle.
4.	 Define the beginning of the arc by using the displayed intersecting line.
5.	 Define the end of the arc by using the displayed intersecting line. Using the space key, 

you can switch the arc alignment between clockwise and counterclockwise.
6.	 The arc is drawn. You can now draw another arc, or exit the function with a right click 

of the mouse.

Instructions for Arc (3 Points) 

In order to draw a circle using 2 edge points:

1.	 Define the first edge point of the circle.
2.	 A circle preview is displayed. Define the second, opposite edge point of the circle.
3.	 The circle is drawn. You can now draw another circle, or exit the function with a right 

click of the mouse.

Instructions for Circle (2 Edges)

To draw an arc using 2 edge points:

1.	 Define the first edge point of a circle.
2.	 A circle preview is displayed. Define the second, opposite edge point of the circle.
3.	 Define the beginning of the arc by using the displayed intersecting line.
4.	 Define the end of the arc by using the displayed intersecting line. Using the space key, 

you can switch the arc alignment between clockwise and counterclockwise.
5.	 The arc is drawn. You can now draw another arc, or exit the function with a right click 

of the mouse.

Instructions for Arc (2 Edges) 
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To draw an arc using center point and edge point:

1.	 Define the center point of a circle.
2.	 A circle preview is displayed. Define the edge point of the circle. Using the space key, 

you can switch center and edge point.
3.	 Define the beginning of the arc by using the displayed intersecting line.
4.	 Define the end of the arc by using the displayed intersecting line. Using the space key, 

you can switch the arc alignment between clockwise and counterclockwise.
5.	 The arc is drawn. You can now draw another arc, or exit the function with a right click 

of the mouse.

Instructions for Arc (Center + Edge) 

To draw an ellipse using 3 points:

1.	 Define the first edge point of the ellipse.
2.	 Define the second, opposite edge point of the ellipse.
3.	 An ellipse preview is displayed. Define the third edge point of the ellipse.
4.	 The ellipse is drawn. You can now draw another ellipse, or exit the function with a right 

click of the mouse.

Instructions for Ellipse (3 Points)

To draw an ellipse arc using 3 points:

1.	 Define the first edge point of an ellipse.
2.	 Define the second, opposite edge point of an ellipse.
3.	 An ellipse preview is displayed. Define the third edge point of the ellipse.
4.	 Define the beginning of the arc by using the displayed intersecting line.
5.	 Define the end of the arc by using the displayed intersecting line. Using the space key, 

you can switch the arc alignment between clockwise and counterclockwise.
6.	 The ellipse arc is drawn. You can now draw another ellipse arc, or exit the function with 

a right click of the mouse.

Instructions for Ellipse Arc (3 Points)

Measure Distance

This function measures distances. In order to create a new measurement, click on the Measure dis-
tance icon of the toolbar. The measurement tool opens. You can now select Line color, Line width and 
Line style as well as Font size and Font type. Furthermore, you can choose from a range of various 
measurement types:

Measurement parallel:
Standard setting, measurement is parallel to measured dis-
tance.

Measurement values nearby:
Direct measuring of a distance with adjacent measurement 
label.

Measurement values separated:
Direct measurement with separate measurement label.

Move measurement value:
Moves an existing measurement label.
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In order to perform a parallel measurement:

1.	 Select the starting point of the measurement.
2.	 Select the end point of the measurement.
3.	 Place the measurement label.
4.	 The measurement is performed and displayed. You can now perform another measure-

ment, or exit the function with a right click of the mouse.

Instructions for Measurement Parallel

In order to perform a measurement with adjacent measurement label:

1.	 Select the starting point of the measurement.
2.	 Select the end point of the measurement.
3.	 The measurement is performed and displayed. You can now perform another measure-

ment, or exit the function with a right click of the mouse.

Instructions for Measurement Values Nearby

In order to perform a measurement with separated measurement label:

1.	 Select the starting point of the measurement.
2.	 Select the end point of the measurement.
3.	 Place the measurement label at any desired position.
4.	 The measurement is performed and displayed. You can now perform another measure-

ment, or exit the function with a right click of the mouse.

Measurement and measurement label are marked with an automatically issued, identical letter, to 
allow for a correct assignment and avoid any confusion.

Instructions for Measurement Values Separated

In order to move the measurement label of an existing measurement (except angles):

1.	 Select the measurement label to be moved.
2.	 Place the measurement label to its position.
3.	 The measurement label is moved. You can now move another measurement label, or 

exit the function with a right click of the mouse.

When moving the measurement label of a measurement with adjacent measurement label, the mea-
surement automatically changes to a measurement with a separated measurement label.

Instructions for Moving Measurement Value

Measure Angle

This function draws and measures angles.

In order to draw and measure an angle, click on the Measure Angle icon of the toolbar. The measure-
ment tool opens. You can now select Line color, Line width and Line type as well as Font size and 
Font type.

Furthermore, you can specify if the angle to be drawn is less than/equal to 180° or greater than 180°, 
respectively if measurement shall be performed clockwise or counterclockwise. Use the space key to 
switch between the two options.

You can choose different angle measurement types:
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Angle between lines:
Draws and measures angles between existing lines and el-
ements.

Angle by 3 points:
Draws and measures angles via 3 points (Apex and 2 lines).

Angle by 4 points:
Draws and measures angles via 4 points (drawing two lines 
with starting and end points)

In order to measure an angle between existing lines:

1.	 Select the first line of the angle to be measured.
2.	 Select the second line of the angle to be measured.
3.	 Place the measurement label. Using the space key, you can switch between the two 

options Angle <= 180° and Angle > 180°. In case the selected lines intersect, you can 
define the quadrant to be measured by moving the mouse accordingly.

4.	 The angle measurement is performed and displayed. You can now perform another 
measurement, or exit the function with a right click of the mouse.

Instructions for Angle Measurement Between Lines

In order to perform an angle measurement by 3 points:

1.	 Define a point on the first leg of the angle to be measured.
2.	 Define the Apex of the angle to be measured.
3.	 Define a point on the second leg of the angle to be measured.
4.	 Place the measurement label. Using the space key, you can switch between the two 

options Angle <= 180° and Angle > 180°.
5.	 The angle measurement is performed and displayed. You can now perform another 

measurement, or exit the function with a right click of the mouse.

Instructions for Angle Measurement by 3 Points

In order to perform an angle measurement by 4 points:

1.	 Define the starting point of the first line of the angle to be measured.
2.	 Define the end point of the first line of the angle to be measured
3.	 Define the starting point of the second line of the angle to be measured.
4.	 Define the end point of the second line of the angle to be measured
5.	 Place the measurement label. Using the space key, you can switch between the two 

options Angle <= 180° and Angle > 180°. In case the selected lines intersect, you can 
define the quadrant to be measured by moving the mouse accordingly.

6.	 The angle measurement is performed and displayed. You can now perform another 
measurement, or exit the function with a right click of the mouse.

Instructions for Angle Measurement by 4 Points
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Format

This function allows changes and modifications to the format of existing lines or elements.
NOTE: Text can also be changed using the text tool.

In order to change the format of an existing element, select the desired element with a mouse click 
and click on the Format icon in the pop-up context menu. Or click on the icon Format of the toolbar. 
The format tool opens. You can now select Color, Line with and Line style, Font size and Font type, 
Proportions/Fixed font size as well as the usual Windows Paragraph alignment.

Layout of the format tool:

•	 Color selection
•	 Selection of line width
•	 Selection of line style
•	 Definition of paragraph alignment
•	 Definition of proportions/fixed font size
•	 Selection of font type and font size
•	 Single elements (e.g. implant or measurement labels) 

can be changed
•	 Unmark all

In order to change the format of an existing element, select 
the element/s or a specific area and perform the required 
changes. Exit the function with a right click of the mouse.

Moving Measurement Value

In order to move the measurement value/angle arc of a previously drawn angle, selecte the respec-
tive angle with a mouse click and use the edit Icon in the pop-up context menu..Place the measure-
ment on the new position. The function exits automatically.

Enable/Disable Fixed Font Sizes

This function allows to set if text sizes remain when zooming, or if text sizes change proportionally to 
the zoom factor.

There is no function tool. If the function is active, all text is shown in the predefined size, disregarding 
the current zoom factor.

Explanation of "fixed font size"

Usually, the size of text changes proportionally to the zoom factor. If a text was created using the Fixed 
Font Size attribute, the text size remains when zooming. In result, texts are always easily readable. 
Fixed font size is predefined for prosthesis and measurement labels. This setting can be modified by 
using the attribute and text tools.

Relevance of the function:

The Fixed Font Size can be activated or deactivated for: 
•	 the screen
•	 the image export/DICOM
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Setting the function:

For the screen, select menu item View > Enable/disable fixed font sizes or select menu item File > 
Settings > Screen > Allow font size locking.

For DICOM image export, select menu item File > Settings > DICOM > Allow font size locking.

Standard settings after installation:

The standard settings are
•	 for the screen, fixed font size is allowed (active)
•	 for DICOM image export, fixed font size is allowed (active)

When working on IMPAX Orthopaedic Tools, you can decide for yourself which setting works best for 
you and allows for optimal readability. Your personal settings are saved and will be used the next time 
you start the program.

Invert Images (on Screen)

All x-ray images visible on the screen can be inverted (black/white) using this function.

In order to invert the images, click on the Invert images (on screen) icon of the toolbar. By deactivat-
ing the function you will return to normal view.

Cut and Move Image Area

With this function, an image area is created and can be moved or rotated using the mouse. The image 
is cut out of the original, a black area appears on the original position of the cut image area. 

In order to cut and move an image area, select menu item Images > 
Cut and move image area or click on the Cut and move image area 
icon of the toolbar.

1.	 Select the first and successively all other required points 
of the image area to be cut out. Alternatively, draw the 
image area while holding down the mouse button. A 
preview of the image area is shown in inverted style.

2.	 A right click with the mouse cuts the image area.
3.	 Pick up the image area to be moved. Optionally, using 

the ← and → keys or the image tool, you can rotate 
the cut image area.

4.	 Place the image area to the desired position.
5.	 Exit the function with a right click of the mouse.

Once you have selected two points, you can open a pop-up context menu with a right mouseclick. 
Based on the line drawn by those two points, you can now either split the image along this line or cut/
copy a rectangular area.
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Window Level/Width

You can adjust brightness and contrast on a scaled image.

In order to adjust brightness and/or contrast of an image, click on the Window level/width icon of 
the toolbar. The image tool opens.

Use the mouse to click on the image you want to adjust. Hold the mouse button down 
and move the mouse vertically up/down to adjust the image contrast, or horizontally 
to the left/right to adjust the brightness. The mouse cursor is replaced by the symbol 
shown at the right during this process.

The image tool shows the current brightness and contrast values:

Remote Support

This function opens a remote support session using TeamViewer.

Only required when R&D needs to access the workstation for 
remote support. Use TeamViewer only when asked by Agfa ser-
vice to do so.

In order to start the remote support session, please select menu 
item ? > Remote support.

After a few seconds, the remote support window opens. Please 
tell our customer support agent the ID number and password 
displayed, thereby allowing access to your system.

Using the tool icon in the upper right corner, you can edit the 
session settings. Our support agent will gladly help you to do so.

Agfa News

Opens the Agfa News & Events website.
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Export to Mobile Device

Enables the export of a planning to an attached Android mobile device (tabled, smartphone, etc.). 
Available for the modules Manual Planning, Automatic Planning, Biometry and Knee.

Click on the toolbar icon Export to Mobile. The export tool is opened. Select the desired mobile de-
vice in the drop down menu. If not all attached devices are being displayed yet, you can refresh the 
list via the button Refresh Devices.

By clicking on the Start button, the current planning is transferred onto your mobile device.

Open EndoDok

Opens the EndoDok address specified in the settings. After installation, the default setting is the En-
doAlliance website.
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Basics

The module Hip - Manual Planning supports you in planning hip implants. It is based on current planning methods 
in hip endoprosthetics – formerly applied manually – using x-rays and prosthesis templates.

You can perform the following tasks quickly and accurately:

•	 Select and fit a suitable prosthesis (cup, stem)
•	 Calculate and display a leg length adjustment
•	 Perform a resection
•	 Repositioning stem

The basic requirements for planning a surgical procedure are x-rays taken according to the following criteria:

•	 Symmetrical positioning of the pelvis
•	 Hip joints in neutral position
•	 Longitudinal femur axis parallel to the image receptor plane
•	 Patella in zero position
•	 Central ray beam on femoral head center symphysis
•	 Scaling sphere with known diameter or scaling bar with known size

NOTE
When recording the x-ray, pay attention to avoid oblique positioning, abduction or external leg ro-
tation. Otherwise you won't be able to determine the optimal rotation center of the endoprothesis 
accurately.

Workflow Step by Step

In order to perform a hip planning:

1.	 Load/import image as described in »Importing Images«.
2.	 Scale image as described in »Scaling Images«.
3.	 In the module overview, select the Hip - Manual Planning module.

Step 1 – Insert & Scale Images

WARNING
Images can only be properly scaled, if a reference object (sphere or scale bar) with dimensions 
known to the user is placed in the image region, close to and at the level of the joint/bone 
area you are interested in, when recording the image. Please verify the entered scaling size tho-
roughly, wrong input can lead to serious miscalculation. The original IMPAX Orthopaedic Tools 
sphere has a 25 mm diameter with a +/- 0.1 mm tolerance. When using other reference objects, 
measure and tolerance of the respective manufacturer apply. Please pay extreme attention to 
the Image Requirements and Scaling Instructions at the end of this User Manual.

Step 2 – Draw Outlines (optional)

If needed for your planning (e.g. for better highlighting), you can draw both femoral and pelvic outlines. Outlines 
are not required for all further steps, the outline functions are hidden in the standard setting on setup. You can 
activate the outline functions by selecting menu item File > Settings > General, they will be available after restart-
ing the program.
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Step 3 – Cut Femur

Requirements:
A scaled image.

Result:
The femoral outline or the pelvis outline is drawn by clicking on intermediate points 
on the bone outline.

You are in the contour tool. After selecting contour type as well as the line color and 
line with, successively click on one point after another along the bone outline. The 
spline function requires less intermediate points for straight lines than for curves.

NOTE
To reject points, use the button Reject last point or use the Backspace key. Each click or keystroke 
rejects one point. Afterwards, continue drawing the outline.
In case you forget a part of the outline, return to the function femoral outline and add the missing 
lines in the same way as described above.

In order to draw the femoral outline:

1.	 Define the first point of the femoral outline..
2.	 Define the next point/s of the outline.
3.	 With a right click of the mouse, end the drawing of the outline.
4.	 Draw all other outlines the same way. End the drawing with a right click of the mouse.
5.	 With another right click of the mouse, exit the contour tool.

If a pelvis outline is required, perform the function Pelvis outline in the same way as described above .

Requirements:
A scaled image.

Result:
An image area is drawn and marked with an outline (symbolically highlight-
ed in white color in the image on the left).

You are in the image tool, the function Cut and move image area is selected. 

In order to cut the femur:

1.	 Select the first and successively all other required points of the image area to be cut out. Alterna-
tively, draw the image area while holding down the mouse button. A preview of the image area is 
shown in inverted style.

2.	 A right click with the mouse cuts the image area and exits the function.

The femur image area is now cut, the image area is marked with an outline.
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Step 4 – Leg Length Correction

Requirements:
A radiologically flawless recorded, scaled image without pelvic inclination or femur rotation.

Result:
This function automatically determines the leg length difference. After all required clicks, the femoral outline/cut 
femur image area is moved distal or proximal to the calculated position and the leg length correction in mm is 
displayed. If no femur cut was made, the leg length difference (actual and desired state) is graphically displayed 

After selecting the line color and line width, start by drawing the reference line (depending on the x-ray, the line 
can be chosen individually, e.g. acetabulum, ischium).

In order to perform the leg length correction:

1.	 Set the first point of the reference line.
2.	 Set the second point of the reference line.
3.	 Define the reference point on the pathological femur.
4.	 Define the reference point on the non pathological femur. When moving the mouse, the leg length 

difference is already displayed.
5.	 The leg length difference is drawn, the femoral outline/cut femur image area is automatically moved 

by the determined leg length difference.

NOTE
When defining the image area, start with the resection line, or insert 
a stem first and define the image area afterwards by starting with 
the resection line.

NOTE
Any previously inserted stem prosthesis 
does not move!!! Use the function Quick 
Move to move it to the new position, or 
delete the prostheses and insert it again 
using the function Insert Stem.
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Step 5 – Define Hip Joint Center (HJC)

Requirements:
A scaled image.

You have the following 3 options to define the HJC: Circle by 3 points, CCD angle, Free. They are described below:

Step 5a – Define HJC with Circle by 3 Points

Result: 
A circle by 3 points is drawn, the circle and the diameter in mm are shown 
for a quick moment, the hip joint center is drawn.

After selecting the line color and line width, start drawing the circle.

In order to define the HJC with a circle by 3 points:

1.	 Define the first point.
2.	 Define the second point.
3.	 A circle with diameter in mm is displayed. Define the third point.
4.	 The hip joint center is drawn.

Step 5b – Define HJC with CCD angle

Result:
Using the function FSA (femoral shaft axis) by 4 points, the CCD angle and 
the hip joint center are drawn.

After selecting the line color and line width, start drawing the anatomical FSA (femoral shaft axis).

Optionally, you can use the function tool to define/select the required angle size: Default (130°/84°), Child 
(140°/90°), Adult (128°/90°), Senior (115°/90°) oder Custom.

NOTE:
Please use this option only in cases where the femoral head 
is not or not clearly visible.
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In order to define the HJC by drawing the CCD angle:

1.	 Define the first point.
2.	 Define the second point, which has to be opposite of the first point.
3.	 Define the third point.
4.	 Define the fourth point, which has to be opposite of the third point.
5.	 Place the angle in a way, that the upper leg of the displayed angle touches the tip of the greater 

trochanter and the other leg of the angle runs through the center of the femoral neck. The mouse 
cursor defines the hip joint center.

6.	 The hip joint center is drawn. Also, femoral shaft axis and femoral neck axis as well as the trochanter 
line are drawn.

Step 5c – Define HJC Freely

Result: 
Using this function, the HJC is defined freely.

After selecting point color/type and line width, define the HJC freely.

In order to define and draw the HJC freely:

1.	 Place the point on the determined position.
2.	 The hip joint center is drawn.

Step 6 – Correct Abduction/Adduction

Requirements: 
A scaled image with a cut femur image area or alternatively with a drawn femoral outline.

Result: 
An existing abduction or adduction is corrected, the femoral outline/cut femur image area is moved.

You are in the copy/move tool.

In order to correct the abduction/adduction:

1.	 Select the grab point of the cut femur image area and pick it up.
2.	 Optionally, by using the ← → keys or according input in the copy/move tool, you can rotate the cut 

image area.
3.	 Place the femur image area on the desired position.
4.	 The abduction/adductiion is corrected.
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Step 8 – Select and Insert Cup

Requirements:
A scaled image, hip joint center (HJC).

Result:
Using the function Insert Cup, you can select the manufacturer, type, size 
and other properties of a cup and place the cup on the required position 
in the required inclination.

After selecting the function, you are in the Implant/template tool, the prosthesis used last is attached to the 
mouse cursor, freely moveable in the work area.

After selecting the line color, line width as well as the body side, consecutively select the desired manufacturer, 
the prosthesis type, prosthesis size and all other properties. The prosthesis attached to the mouse cursor changes 
accordingly. Further info about inserting implants can be found at »Inserting Implants«.

WARNING
All dimensions and measurements given by the IMPAX Orthopaedic Tools prosthesis database 
derived from original manufacturer data or templates. If you suspect that the data is not cor-
rect, please report it to Agfa‘s service representative or contact Agfa using the contact infor-
mation provided in the beginning of this manual.

In order to insert the cup:

1.	 The prosthesis usually appears on the mouse under 45°. By using the cursor keys ← and →, you 
can adjust the inclination of the prosthesis. The angle in ° is displayed in the Angle field of the im-
plate/template tool. If you have previously drawn the reference line, the angle is measured in rela-
tion to it. In capture mode Free you can place the prosthesis anywhere in the image. Using the key 
P, the capture mode for a Point is activated, e.g. the hip joint center. If you approve of size/position/
angle, place the prosthesis.

2.	 As long as the prosthesis is not confirmed as final, you can always pick it up again and move or modi-
fy it. You can change the size by using the cursor keys ↓ and ↑ after selecting the respective column 
of the menu list or the respective fly out menu.

3.	 With a right click of the mouse, confirm the prosthesis as final.
4.	 The prosthesis is inserted.

Step 7 – Draw Reference Line

Requirements:
A scaled image.

Result:
The reference line is drawn.

In order to draw the reference line:

1.	 Define the starting point of the line (1).
2.	 Define the end point of the line (2).
3.	 The reference line is drawn.

After selecting the line color and line width, start by drawing the reference line (depending on the x-ray, the line 
can be chosen individually, e.g. acetabulum, ischium).
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Step 9 – Select and Insert Stem

Requirements:
A scaled image, hip joint center, cup.

Result:
Using the function Insert Stem, you can select the manufacturer, type, 
size and other properties of a stem  At first, insert the stem in a way the 
inner corticalis overlaps with the edge of the stem and the resection line 
is at the desired position.

NOTE
It is rarely possible to immediately place the stem correctly on the hip joint center. At »Reposition-
ing Stem«, Repositioning of the stem is described.

WARNING
All dimensions and measurements given by the IMPAX Orthopaedic Tools prosthesis database 
derived from original manufacturer data or templates. If you suspect that the data is not cor-
rect, please report it to Agfa‘s service representative or contact Agfa using the contact infor-
mation provided in the beginning of this manual.

After selecting the function, you are in the Implant/template tool, the prosthesis used last is attached to the 
mouse cursor, freely moveable in the work area.

After selecting the line color, line width as well as the body side, consecutively select the desired manufacturer, 
the prosthesis type, prosthesis size and all other properties. The prosthesis attached to the mouse cursor changes 
accordingly. Further info about inserting implants can be found at »Inserting Implants«.

In order to insert the stem:

1.	 The prosthesis appears on the mouse. By using the cursor keys ← and →, you can adjust the 
inclination of the prosthesis. The angle in ° is displayed in the Angle field of the implant/template 
tool. In capture mode Free you can place the prosthesis anywhere in the image. Using the key P, 
the capture mode for a Point is activated, e.g. the hip joint center. If you approve of size/position/
angle, place the prosthesis.

2.	 As long as the prosthesis is not confirmed as final, you can always pick it up again and move or modi-
fy it. You can change the size by using the cursor keys ↓ and ↑ after selecting the respective column 
of the menu list or the respective fly out menu.

3.	 With a right click of the mouse, confirm the prosthesis as final.
4.	 The prosthesis is inserted.
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Step 10 – Select Neck Length

Requirements:
The stem is placed correctly in the femur.

Result:
The neck length determines the post operative leg length and a lateral 
changed position of the femur.

You can also open this function at any time by using the Select 
Size (Shaft/Head/..) icon of the toolbar.

WARNING
All dimensions and measurements given by the IMPAX Orthopaedic Tools prosthesis database 
derived from original manufacturer data or templates. If you suspect that the data is not cor-
rect, please report it to Agfa‘s service representative or contact Agfa using the contact infor-
mation provided in the beginning of this manual.

In order to select the neck length:

1.	 Select the required neck length with a click of the mouse. You can click on the displayed size as well 
as the lines to the rotation center or the rotation center itself.

2.	 You can change your choice at any time and as often as needed with another click of the mouse.
3.	 End selection with a right click of the mouse.
4.	 The neck length is selected, the stem updated.

Step 11a – Draw Resection Line (optional)

Requirements:
The prosthesis is placed correctly in the femur.

Result:
The inner and outer corticalis outlines are cut through. You 
can draw the resection line as a straight cut, or as a stepped 
cut. In both cases, you need a line with 3 points.

NOTE
Omit this function if you have drawn a femur cut. That way, the resection line is already defined 
when defining the femur cut image area. Or you have already defined the image area together with 
the prosthesis.

In order to draw the resection line:

1.	 Select the first point, the medial starting point of the resection line.
2.	 Select the second point. For a straight cut, the second point is on the lateral corticalis. For a stepped 

cut, the point indicates the step (see picture above).
3.	 Select the third point. For a straight cut, it is placed outside the femur. For a stepped cut, it is placed 

on the lateral corticalis (see picture above). 
4.	 The resection line is drawn and the length of the cuts in mm are displayed.
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Step 11b – Draw Resection Line in Cut Image Area

Requirements:
A femur cut image area is defined, the prosthe-
sis is placed correctly in the femur.

Result:
The inner and outer corticalis outlines are cut 
through. You can draw the resection line as a 
straight cut, or as a stepped cut. In both cases, 
you need a line with 3 points.

In order to draw the resection line:

1.	 Select the first point, the medial starting point of the resection line.
2.	 Select the second point. For a straight cut, the second point is on the lateral corticalis. For a stepped 

cut, the point indicates the step (see picture above).
3.	 Select the third point. For a straight cut, it is placed outside the femur. For a stepped cut, it is placed 

on the lateral corticalis (see picture above). 
4.	 The resection line is drawn and the image is removed in the respective area.

Step 12 – Reposition Stem

Requirements:
Cup and stem are inserted.

Result:
The rotation center of the prosthesis (head center) is brought to congru-
ency with the rotation center of the cup (center). If necessary, abduction/
adduction of the femur can be corrected at the same time using the cur-
sor keys.

   before

   after

You are in the copy/move tool.

To reposition the stem:

1.	 All elements to be moved (prosthesis, cut femur image 
area, any existing outlines) are automatically selected and 
marked.

2.	 Select the rotation point of the prosthesis (head center) as 
a grab point.

3.	 The prosthesis is now attached to the mouse cursor. Place it 
on the rotation center of the cup, bringing the head center 
to congruency with the cup. Use the cursor keys ← or → 
for rotation.

4.	 The repositioning is completed.
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Step 13 – Measure Distances and Angles

The measuring of distances and angles is described in chapter »Working with IMPAX Orthopaedic Tools«, sections 
»Measure Distance« and »Measure Angle«.

NOTE
To measure the leg length correction, set the first point on the outline, e.g. greater trochanter. Set 
the second point perpendicular to the first one. An inclinated line between the measurement points 
causes incorrect measurements.

Step 14 – Measure CCD Angle

Requirements:
A scaled image.

Result:
The CCD angle is drawn and measured.

You are in the CCD angle tool. You can choose from two drawing modes  
for each of the axes to be drawn (FSA/femoral shaft axis and FNA/femoral 
neck axis): 2 points or 4 points. The sequence in which you draw the two 
axes does not matter. The additional option FNA by M.E. Mueller is ex-
plained on the next page.

To measure the CCD angle using axes with 2 points:

1.	 Define the first point of the first axis (e.g. FSA – femoral shaft axis).
2.	 Define the second point of the first axis.
3.	 Define the first point of the second axis (e.g. FNA – femoral neck axis).
4.	 Define the second point of the second axis.
5.	 The CCD angle is drawn, the angle size in ° is displayed.

To measure the CCD angle using axes with 4 points:

1.	 Define the first point of the first axis.
2.	 Define the second point of the first axis, opposite (medial) of the first point.
3.	 Define the third point of the first axis.
4.	 Define the fourth point of the first axis, opposite (medial) of the third point.
5.	 Define the first point of the second axis.
6.	 Define the second point of the second axis, opposite (medial) of the first point.
7.	 Define the third point of the second axis.
8.	 Define the fourth point of the second axis, opposite (medial) of the third point.
9.	 The CCD angle is drawn, the angle size in ° is displayed.
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If a CCD angle is measured outside of the norm range of 
124°/136°, the comment (>N) or (<N) is added to the mea-
surement label. In case of a substantial deviation, the warning 
shown on the right is displayed.

Step 15 – Measure Leg Length Difference

Requirements:
A radiologically flawless recorded, scaled image without pelvic inclination or femur rotation.

Result:
This function automatically determines the leg length difference and displays it.

As long as you are in the function CCD angle, you can grab the drawn lines at their respective ending points or in 
the middle to e.g. move them parallel or to rotate. Once you have defined 2 or 4 points, the axis is shown. Once the 
second line is finished, the CCD angle appears automatically. Draw the axes on the left and on the right body side.

Step 14a – Femoral Neck Axis by M.E. Mueller

After drawing the femoral shaft axis, instead of drawing the fem-
oral neck axis by 2 or 4 points you can also use the function 
according to M.E. Mueller.

In order to draw the femoral neck axis by M.E. Mueller:

1.	 Select the first point on the edge of the femoral head.
2.	 Move the mouse in order to match the femoral head with the displayed aid circle. By clicking the 

mouse, define the second edge point of the femoral head.
3.	 Place point 3 on the lateral corticalis of the femoral neck (at the most narrow area).
4.	 Place point 4 on the medial corcitalis of the femoral neck. IMPAX Orthopaedic Tools assists with 

correct placing on the opposite side in relation to the femoral head center.
5.	 The CCD angle size ° is displayed. Exit the function with a right click of the mouse.
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After selecting the line color and line width, start by drawing the reference line if it doesn‘t exist yet (depending on 
the x-ray, the line can be chosen individually, e.g. acetabulum, ischium).

In order to determine the leg length difference:

1.	 Set the first point of the reference line.
2.	 Set the second point of the reference line.
3.	 Define the reference point on the pathological femur.
4.	 Define the reference point on the non pathological femur. When moving the mouse, the leg length 

difference is already displayed.
5.	 The leg length difference is drawn.

Step 16 – Measure Femoral Offset

In order to measure and draw the femoral offset:

1.	 Define the first point on the inner corticalis.
2.	 Define the second point on the inner corticalis (opposite of the first point).
3.	 Define the third point on the inner corticalis.
4.	 Define the fourth point on the inner corticalis (opposite of the third point).
5.	 Define the femoral rotation center. Using the key P, the capture mode for a Point is activated, e.g. a 

previously defined hip joint center.
6.	 The femoral offset is measured and drawn.

Requirements:
A scaled x-ray image.

Result:
The femoral offset is measured and drawn.

Step 17 – Measure Acetabular Offset

In order to measure and draw the acetabular offset:

1.	 Define the acetabular rotation center. Using the key P, the capture mode for a Point is activated, e.g. 
a previously defined cup center (NOT the femoral head center).

2.	 Define the second point on the distal end of the pelvic tear drop.
3.	 The acetabular offset is measured and drawn.

Requirements:
A scaled x-ray image with previously drawn reference line.

Result:
The acetabular offset is measured and drawn.
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Step 19 – Insert Osteosynthesis Components

The procedure to insert plates, nails and screws is the same as the procedure to insert implants.

In order to measure inclination/anteversion:

1.	 Set the first point on the lateral edge of the cup.
2.	 Set the second point on the medial edge of the cup. The inclination of the cup is already shown and 

changes when moving the mouse.
3.	 Move the mouse away from the drawn line, towards the edge of the cup. A preview of an ellipse is 

shown. Bring the edge of the ellipse and the edge of the cup to congruency, and set the third point.  
The anteversion of the cup is now shown as well and changes when moving the mouse.

4.	 Inclination and anteversion are calculated. The result in ° is attached to the mouse cursor.
5.	 Place the result to the desired position.
6.	 You can now measure the inclination/anteversion of another cup or end this function with a right 

click of the mouse.

ATTENTION
This measurement is only valid if pelvis is positioned perfectly

perpendicular to and centered on the x-ray beam.

Step 20 – Insert Planning Information

By using this function, you can insert the most important planning infor-
mation (e.g. physician performing the planning, patient, implants used) as 
text into the planning image.

The Create text tool is opened. You can find the corresponding descrip-
tion in chapter »Functions & Symbols«, section »Create, Edit and Move 
Text«.

In the field below, you can select which information shall be inserted. 
Additionally, you can enter/modify the physician‘s name.

The text containing the planning information is already attached to the 
mouse cursor and can be placed at the desired position.

Requirements:
A scaled x-ray image with inserted hip implant and correctly 
drawn reference line.

Result:
The edge of the cup is drawn. Inclination and anteversion of 
the cup are calculated and displayed.

Step 18 – Measure Inclination/Anteversion
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Basics

The Hip - Automatic Planning module provides automatic suggestions for hip implants.

You can perform the following tasks quickly and accurately:

•	 Get and optimize suggestions for a suitable prosthesis (cup, stem)
•	 Perform all other plannings and actions known from the module Hip - Manual Planning

The basic requirements for planning a surgical procedure are x-rays taken according to the following criteria:

•	 Symmetrical positioning of the pelvis
•	 Hip joints in neutral position
•	 Longitudinal femur axis parallel to the image receptor plane
•	 Patella in zero position
•	 Central ray beam on femoral head center symphysis
•	 Scaling sphere with known diameter or scaling bar with known size

NOTE
When recording the x-ray, pay attention to avoid oblique positioning, abduction or external leg ro-
tation. Otherwise you won't be able to determine the optimal rotation center of the endoprothesis 
accurately.

Workflow Step by Step

In order to perform a hip planning:

1.	 Load/import image as described in »Importing Images«.
2.	 Scale image as described in »Scaling Images«.
3.	 In the module overview, select the Hip - Automatic Planning module.

Step 1 – Insert & Scale Images

WARNING
Images can only be properly scaled, if a reference object (sphere or scale bar) with dimensions 
known to the user is placed in the image region, close to and at the level of the joint/bone 
area you are interested in, when recording the image. Please verify the entered scaling size tho-
roughly, wrong input can lead to serious miscalculation. The original IMPAX Orthopaedic Tools 
sphere has a 25 mm diameter with a +/- 0.1 mm tolerance. When using other reference objects, 
measure and tolerance of the respective manufacturer apply. Please pay extreme attention to 
the Image Requirements and Scaling Instructions at the end of this User Manual.

Step 2 – Select Work Mode

In case you haven't already inserted and scaled an image, you can now 
do so, or insert a demo image to make yourself familiar with the function. 
By  checking the Don't ask again checkbox, you can skip this selection. In 
this case, the image tool opens automatically in case no image has been 
inserted. 

Now choose either Hip Autoplan in order to begin the automatic hip plan-
ning directly, or the Expert Mode for various preparative steps.
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Step 3 – Hip Autoplan

Requirements:
A scaled image. If a leg length adjustment and correction of abduction/
adduction are required, please do so before the automatic planning using 
the expert mode.

Result:
Cup and Stem are suggested in 2 separate steps.

NOTE
Please regard the following restrictions:
•	 Only one body side can be planned in each step 

(planning variant/layer)
•	 There is no verification if cup and stem fit together 

as a system.
•	 Changes to neck length and shaft length can be 

only made in expert mode.

After selecting line color and line width, you can make a selection out of 
your personal favorites using the Favorites field of the autoplan tool. (see 
»SStep 3c – Favorites«). Or you can select the desired manufacturer using 
the Manufacturer field (All can be selected as well).

Now, select the body side to be planned in the autoplan tool and afterwards start the automatic planning proce-
dure by a click on the respective symbol button for Cup or Stem.

After opening the function, all available prostheses are loaded in the back-
ground. Depending on the database size and the selected manufacturer, 
this can take a few moments. Meanwhile, you can already draw the desig-
nation points for the cup or the stem (Steps 3a and 3b). But you can only 
insert a prosthesis once the loading of the prosthesis data is completed.

Step 3a – Cup Autoplan



93

IMPAX Orthopaedic Tools» Table of Contents «

» Table of Contents «

Hip - Automatic Planning

In order to perform an automatic planning of the cup:

1.	 Define the hip joint center (1). You can do so freely or by 2 edge points (with aid circle). Make the 
selection in the autoplan tool.

2.	 Define the medial acetabular edge (2).
3.	 Define the lateral acetabular edge (3).
4.	 Define the acetabular bottom/placement depth (4).
5.	 Once loading of prosthesis data is completed, a preview of the cup is displayed. You can now move 

the prosthesis if needed, as well as adjust the inclination by using the cursor keys ← and → or 
the angle field of the autoplan tool. By using the Edit buttons of the au-
toplan tool, you can further modify the prosthesis or select a different 
prosthesis (implant/template tool), a right click of the mouse returns 
you to the autoplan tool (by then, rotating/moving the prosthesis is not 
possible anymore).

6.	 The automatic planning of the cup is now completed. You can now per-
form the automatic planning of the stem, or open a pop-up context 
menu with a right click of the mouse in order to apply the planning or 
reject it if needed.

CAUTION
Please keep in mind, that the cup displayed is merely a suggestion, which must checked and verified 
for correct size and position in each and every case.

Step 3b – Stem Autoplan

In order to perform an automatic planning of the stem:

1.	 Define the hip joint center (5), if it has not yet been defined. You 
can do so freely or by 2 points (edge + center with aid circle). 
Make the selection in the autoplan tool.

2.	 An aid line connected to the hip joint center and attached to the 
mouse cursor appears. Define any desired point on the femoral 
neck axis (6).

3.	 Define a point on the resection line (7).
4.	  IMPAX Orthopaedic Tools will now attempt an automatic detec-

tion of the femoral outline. If the detection is successful, contin-
ue with item No. 8. If the detection is incorrect or not successful, 
define a point on the medial inner corticalis (8).

5.	 An aid line connected to point 8 and attached to the mouse cur-
sor appears. Define the lateral opposite point on the inner cor-
ticalis (9).

6.	 Further down, define the next point on the medial inner corticalis 
(10).

7.	 An aid line connected to point 10 and attached to the mouse cur-
sor appears. Define the lateral opposite point on the inner cor-
ticalis (11).

8.	 Once loading of prosthesis data is completed, a preview of the 
stem is displayed. You can now move the prosthesis if needed, as 
well as adjust the inclination by using the cursor keys ← and → 
or the angle field of the autoplan tool. By using the Edit buttons 
of the autoplan tool, you can further modify the prosthesis or 
select a different prosthesis.

9.	 The automatic planning of the stem is now completed. You can 
now perform the automatic planning of the cup, if not yet com-
pleted, or open a pop-up context menu with a right click of the 
mouse in order to apply the planning or reject it if needed.

CAUTION
Please keep in mind, that you possibly might need to select 1-2 implant sizes smaller for cemented 
stems. Please also keep in mind, that the stem displayed is merely a suggestion, which must checked 
and verified for correct size and position in each and every case.
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Step 3c – Favorites

In order to narrow down the implants used for 
automatic planning, you can create and select 
personal favorites lists. Select Enable Favorites 
in the Favorites field of the autoplan tool, and 
then the desired favorites list.

In case you haven't created any favorites lists yet, click on the Edit button. A new window opens. Click on the New 
list button (the menu and all other buttons are deactivated). After that, you can enter the name of the list and save 
it by clicking on the OK button.

A selection menu list opens, and you can now select the preferred manufacturer/s by placing a check mark. You 
can also select certain implants, implant types and variants by placing check marks in the particular columns (the 
respective manufacturers or implants are displayed with a grey check mark). All subsidiary entries are automati-
cally selected and can be deselected if needed.

Your selection is always saved immediately. Please note, that only implants which can be automatically planned 
are listed in the selection menu.

Use the button Close in the upper right corner in order to close the window once you're done. This way, you can 
create any desired favorites list.

When favorites lists are available, you can use the Show button (once loading of prosthesis data is completed) in 
order to display all available implants of a specific favorites list.

Using the Edit button, you can use the selection window described above (once loading of prosthesis data is 
completed) in order to create additional lists, rename existing lists, add/modify implants or delete lists that are no 
longer required.
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Step 4 – Expert Mode

You can choose expert mode by clicking on the respective button in the work mode selection, or by using the exit 
function icon in the upper right corner of the autoplan tool.

The expert mode allows you to perform a range of preparative and supplementary steps in addition to the auto-
matic planning:

•	 cut femur
•	 leg length correction
•	 define hip joint center
•	 correct abduction/adduction
•	 adjust neck length
•	 resection
•	 repositioning stem
•	 measurements
•	 insert plates/nails/screws
•	 insert planning information

All functions are described in detail in chapter »Hip - Manual Planning«.
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Basics

The positioning of the prosthesis within the muskulosceletal system influences the biomechanical forces acting  
when the joint is under static load as well as when the joint is moving.

If extensive joint deformities are present, for example coxarthrosis as a result of hip dysplasia or posttraumatic ar-
throsis, it is difficult to achieve biomechanical ideal implant geometry and implant stability at the same time when 
fixating the implant. Shortened or stretched muscle fascicles indicate a joint deformity and allow conclusions to be 
drawn as to the pressure present inside a joint.

The module Hip - Biometry enables you to plan hip prosthesis with an optimal joint geometry comparable to that 
of a healthy joint: 

•	 In order to assess the joint situation, geometrical force parameters acting on the hip are com-
pared with the normal values found in healthy subjects.

•	 The postoperative joint situation is evaluated for several potential centers of rotation of the 
prosthesis. This enables you to quickly find the optimal rotation center for the prosthesis and to 
ensure the best surgical outcome for your patient. 

A successful biometric analysis can only be obtained, if x-rays are taken according to the following criteria:

•	 Symmetrical positioning of the pelvis
•	 Hip joints in neutral position
•	 Longitudinal femur axis parallel to the image receptor plane
•	 Patella in zero position
•	 Central ray beam on femoral head center symphysis
•	 Scaling sphere with known diameter or scaling bar with known size

CAUTION
It is essential for the criteria described above to be met to ensure the optimal rotation center for 
the endoprosthesis will be determined accurately. When recording the x-ray, pay attention to avoid 
oblique positioning, abduction or external leg rotation.

Marker Points

IMPAX Orthopaedic Tools uses 10 points defined on the image to determine the direction of the pulling force of 
the individual muscles and to draw conclusions as to its direction.

Biomechanical Parameters

Six biomechanical hip parameters are determined. Each one is compared with normal values found in healthy sub-
jects and assessed by using a scientifically based matrix that has been tried and tested in clinical practice.

Hip Score

The total of all values determined in this way constitutes what is known as the hip score or BLB score (based on 
Babisch-Layher-Blumentritt). The BLB score is therefore a value for the assessment of the overall joint situation.

Optimal Rotation Center

In order to determine the optimal postoperative rotation center, the joint situation is evaluated to locate a number 
of potential rotation centers. Possible rotation centers are displayed as simulation points on the image. 

WARNING
Please be aware that the hip biometry module only provides an approximation of joint reac-
tive forces. Factors other than just bone configuration and geometrical parameters contribute
to joint forces. Always use intraoperative visualization, palpation, tissue tension evaluation, 
and range of motion parameters to better understand joint forces.
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Biometric Marker Points (Overview)

The ten marker points derived from the model by Blumentritt (Blumentritt S.: 
Biomechanische Bauprinzipien des menschlichen Hüftgelenkes in der Frontale-
bene [Biomechanical Structural Principles of the Human Hip Joint in the Frontal 
Plane] Gegenbaurs morphol. annual 134 (1988) 221-240).

Point 1	 Upper mid part of processus spinosus L5 (Base of os sacrum)

Point 2	 Lower mid symphysis

Point 3	 Preoperative rotation center (hip joint center)

Point 4	 approx. 3cm distal of the lesser trochanter (in the imagined 
direction of pull of the rectus femoris muscle towards the 
medial upper edge of the patella)

Point 5	 Lateral, most proximal edge of the greater trochanter

Point 6	 Most cranial edge of the sclerotic area. If coxarthrosis exists 
as a result of dysplasia: point of sclerotic area more or less 
halfway between the outer and inner edge of acetabulum

Point 7	 Spina iliaca anterior inferior 

Point 8	 Most lateral point of the iliac wing

Point 9	 Most cranial point of the iliac wing

Point 10	 Most medial point of the iliac wing

NOTE
In order to calculate the biometric values, it is useful to record an image with the complete iliac wing 
and as much of the femoral shaft as possible.

Images:
Point 7 in various image types and perspectives:
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Biomechanical Parameters (Oveview)

Angles

BETADIFF
Deviation of calculated direction of pull of the abductor muscles from their ideal direction of action.

SZWITH
Theoretical direction of the resulting joint counterforce in relation to the horizontal (position of the sclerotic area).

KLDELTAOPT
Direction of pull of the rectus femoris muscle in relation to the horizontal in an ideal joint situation.

Length Ratios

VRECABD
Ratio of lever lengths (vertical distance of directions of pull from the rotation center) of the rectus femoris and the 
abductor muscles.

VD5ABD
Ratio of lever lengths (vertical distance of directions of pull from the rotation center) of the center of gravity of part 
of the body and the abductor muscles.

Force Parameters

RREL
Resulting joint counterforce relative to body weight.

Assessment Values / Hip Score

The biomechanical parameters are compared to the values found in healthy subjects and assessed as follows:

	 Value	 Assessment

	 2		 Normal range:  MW: - 2 SD  ≤  x  ≤  MW  +  2 SD 
	 1		 Critical range:  MW: - 3 SD  ≤  x  ≤  MW  +  3 SD
	 0		 outside twice the standard deviation:
			  x  < MW  ±  3 SD  <  x
			  MW = mean value; SD = standard deviation

	 Hip Score	 Assessment
	 10 - 12	 ideal, i.e. good or very good hip biomechanics
	 7 - 9		 satisfactory hip biomechanics
	 4 - 6		 moderate, unfavorable hip biomechanics
	 0 - 3		 poor hip biomechanics

The higher the hip score,
•	 the better the biomechanics,
•	 the longer the life span of the prosthesis,
•	 the less post operative pain,
•	 the better the gait pattern,
•	 the better the Harris hip score.
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Workflow Step by Step

In order to perform a hip planning:

1.	 Load/import image as described in »Importing Images«.
2.	 Scale image as described in »Scaling Images«.
3.	 In the module overview, select the Hip - Biometry module.

WARNING
Images can only be properly scaled, if a reference object (sphere or scale bar) with dimensions 
known to the user is placed in the image region, close to and at the level of the joint/bone 
area you are interested in, when recording the image. Please verify the entered scaling size tho-
roughly, wrong input can lead to serious miscalculation. The original IMPAX Orthopaedic Tools 
sphere has a 25 mm diameter with a +/- 0.1 mm tolerance. When using other reference objects, 
measure and tolerance of the respective manufacturer apply. Please pay extreme attention to 
the Image Requirements and Scaling Instructions at the end of this User Manual.

Step 1 – Insert & Scale Images

If needed for your planning (e.g. for better highlighting), you can draw both femoral and pelvic outlines. Outlines 
are not required for all further steps, the outline functions are hidden in the standard setting on setup. You can 
activate the outline functions by selecting menu item File > Settings > General, they will be available after restart-
ing the program.

Step 2 – Draw Outlines (optional)

Requirements:
A scaled image.

Result:
The femoral outline or the pelvis outline is drawn by clicking on intermediate points 
on the bone outline.

You are in the contour tool. After selecting contour type as well as the line color and line with, successively click on 
one point after another along the bone outline. The spline function requires less intermediate points for straight 
lines than for curves.

NOTE
To reject points, use the button Reject last point or use the Backspace key. Each click or keystroke 
rejects one point. Afterwards, continue drawing the outline.
In case you forget a part of the outline, return to the function femoral outline and add the missing 
lines in the same way as described above.

In order to draw the femoral outline:

1.	 Define the first point of the femoral outline.
2.	 Define the next point/s of the outline.
3.	 With a right click of the mouse, end the drawing of the outline.
4.	 Draw all other outlines the same way. End the drawing with a right click of the mouse.
5.	 With another right click of the mouse, exit the contour tool.

If a pelvis outline is required, perform the function Pelvis outline in the same way as described above .
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Requirements:
A scaled image.

Result:
An image area is drawn and marked with an outline (symbolically highlight-
ed in white color in the image on the right).

You are in the image tool, the function Cut and move image area is selected. 

Step 3 – Cut Femur

Step 4 – Define Preoperative Hip Joint Center (HJC)

In order to cut the femur:

1.	 Select the first and successively all other required points of the image area to be cut out. Alterna-
tively, draw the image area while holding down the mouse button. A preview of the image area is 
shown in inverted style.

2.	 A right click with the mouse cuts the image area and exits the function.

The femur image area is now cut, the image area is marked with an outline.

NOTE
When defining the image area, start with the resection line, or insert 
a stem first and define the image area afterwards by starting with 
the resection line.

Requirements:
A scaled image.

You have the following 2 options to define the HJC:

•	 Circle by 3 points
•	 Free

They are described below:
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Step 4a – Define HJC with Circle by 3 Points

Step 4b – Define HJC Freely

Result: 
Using this function, the HJC is defined freely.

After selecting point color/type and line width, define the HJC freely.

In order to define and draw the HJC freely:

1.	 Place the point on the determined position.
2.	 The hip joint center is drawn.

Step 5 – Correct Abduction/Adduction

Requirements: 
A scaled image with a cut femur image area or alternatively with a drawn femoral 
outline, drawn hip joint center.

Result: 
The position of the femoral axis of the pathological side is adjusted to match the 
non-pathological side.

You are in the copy/move tool.

In order to correct the abduction/adduction:

1.	 Select the cut femur image area and pick it up. Define the hip joint center as grab/rotation point, 
capture mode is set to Point.

2.	 Optionally, by using the ← → keys or according input in the copy/move tool, you can rotate the cut 
image area.

3.	 Place the femur image area on the desired position.
4.	 The abduction/adduction is corrected.

NOTE
In order to achieve an optimal joint geometry, it is recommended to correct the abduction/adduc-
tion of the femur at this point for a better assessment of the prosthesis choice 

Result: 
A circle by 3 points is drawn, the circle and the diameter in mm are shown 
for a quick moment, the hip joint center is drawn.

In order to define the HJC with a circle by 3 points:

1.	 Define the first point.
2.	 Define the second point.
3.	 A circle with diameter in mm is displayed. Define the third point.
4.	 The hip joint center is drawn.
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Step 6 – Define Biometric Points

Requirements:
1.	 Pelvis overview with iliac crest and sufficient femur shaft length.
2.	 CAUTION: Exact input of patient's height/weight (using Planning Information) is necessary 

before performing this function. Otherwise, definition of the biometric points is not possible.

Result:
The preoperative biometric values are calculated and displayed.

In order to define the biometric points:

1.	 Define the first point, the cranial body center (upper mid part of processus spinosus L5).
2.	 Define the second point, the caudal body center (lower mid symphysis).
3.	 Define the third point, hip joint center (HJC)/pre-operative rotation center.
4.	 Define the fourth point, approx. 2cm below and 2cm medial of the lesser trochanter. The point de-

fines the direction of pull of the M. rectus femoris from the lower pelvic edge towards the medial 
upper edge of the patella.

5.	 Define the fifth point, the greater trochanter. 
Click on the lateral, most proximal edge of the greater trochanter.

6.	 Define the sixth point, the caudal wing of ilium. 
Click on the most cranial edge of the sclerotic area.

7.	 Define the seventh point, the spina iliaca anterior inferior (see 
»Biometric Marker Points (Overview)«).

8.	 Define the eighth point, the lateral wing of ilium. 
Click on the most lateral point of the iliac wing.

9.	 Define the ninth point, the cranial wing of ilium. 
Click on the most cranial point of the iliac wing.

10.	 Define the tenth point, the medial wing of ilium. 
Click on the most medial point of the iliac wing.

11.	 The 10 biometrical points are defined, the biometric assessment 
is displayed in the biometry tool.

12.	 Optionally, you can pick up individual points with a click of the 
mouse and correct them by moving and repositioning. Moving 
any point results in a change of the biometric values, the new 
values are displayed in the biometry tool.

13.	 End the editing of the points with a right click of the mouse. The 
biometric values are now attached to the mouse cursor.

14.	 Place the values on any desired position of the planning.
15.	 All biometric points are now defined, the assessment is dis-

played. End this function with a right click of the mouse.
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Step 7 – Select and Insert Stem

Requirements:
Abduction/adduction is corrected. 10 biometric points are defined.

Result:
Using the function Insert Stem, you can select the manufacturer, type, 
size and other properties of a stem  At first, insert the stem in a way the 
inner corticalis overlaps with the edge of the stem and the resection line 
is at the desired position.

After selecting the function, you are in the Implant/template tool, the 
prosthesis used last is attached to the mouse cursor, freely moveable in 
the work area.

WARNING
All dimensions and measurements given by the IMPAX Orthopaedic Tools prosthesis database 
derived from original manufacturer data or templates. If you suspect that the data is not cor-
rect, please report it to Agfa‘s service representative or contact Agfa using the contact infor-
mation provided in the beginning of this manual.

After selecting the line color, line width as well as the body side, consecutively select the desired manufacturer, 
the prosthesis type, prosthesis size and all other properties. The prosthesis attached to the mouse cursor changes 
accordingly. Further info about inserting implants can be found at »Inserting Implants«.

In order to insert the stem:

1.	 The prosthesis appears on the mouse. By using the cursor keys ← and →, you can adjust the incli-
nation of the prosthesis. The angle in ° is displayed in the Angle field of the implant/template tool. 
In capture mode Free you can place the prosthesis anywhere in the image. If you approve of size/
position/angle, place the prosthesis.

2.	 As long as the prosthesis is not confirmed as final, you can always pick it up again and move or modi-
fy it. You can change the size by using the cursor keys ↓ and ↑ after selecting the respective column 
of the menu list or the respective fly out menu.

3.	 With a right click of the mouse, confirm the prosthesis as final.
4.	 The prosthesis is inserted.

NOTE
At this time, do not pay any attention to the rotation center or neck length of the stem. Both will be 
taken care of in the next steps.

Step 8 – Select Neck Length

Requirements:
The stem is placed correctly in the femur.

Result:
The neck length determines the post operative leg length and a lateral 
changed position of the femur.

You can also open this function at any time by using the Select 
Size (Shaft/Head/..) icon of the toolbar.
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WARNING
All dimensions and measurements given by the IMPAX Orthopaedic Tools prosthesis database 
derived from original manufacturer data or templates. If you suspect that the data is not cor-
rect, please report it to Agfa‘s service representative or contact Agfa using the contact infor-
mation provided in the beginning of this manual.

In order to select the neck length:

1.	 Select the required neck length with a click of the mouse. You can click on the displayed size as well 
as the lines to the rotation center or the rotation center itself.

2.	 You can change your choice at any time and as often as needed with another click of the mouse.
3.	 End selection with a right click of the mouse.
4.	 The neck length is selected, the stem updated.

Step 9a – Draw Resection Line (optional)

Requirements:
Femoral outline is drawn, prosthesis is placed correctly in the 
femur.

Result:
The inner and outer corticalis outlines are cut through. You 
can draw the resection line as a straight cut, or as a stepped 
cut. In both cases, you need a line with 3 points.

Step 9b – Draw Resection Line in Cut Image Area (optional)

NOTE
Omit this function if you have drawn a femur cut. That way, the resection line is already defined 
when defining the femur cut image area. Or you have already defined the image area together with 
the prosthesis.

In order to draw the resection line:

1.	 Select the first point, the medial starting point of the resection line.
2.	 Select the second point. For a straight cut, the second point is on the lateral corticalis. For a stepped 

cut, the point indicates the step (see picture above).
3.	 Select the third point. For a straight cut, it is placed outside the femur. For a stepped cut, it is placed 

on the lateral corticalis (see picture above). 
4.	 The resection line is drawn and the length of the cuts in mm are displayed.

Requirements:
A femur cut image area is defined, the prosthe-
sis is placed correctly in the femur.

Result:
The inner and outer corticalis outlines are cut 
through. You can draw the resection line as a 
straight cut, or as a stepped cut. In both cases, 
you need a line with 3 points.
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Step 10 – Define Postoperative Hip Joint Center (HJC) of Prosthesis

Requirements:
Inserted prosthesis, selected neck length.

Result:
An additional biometric point 11 is defined on the rotation center of the 
prrsthesis (head center) as the new rotation center of the overall joint 
geometry. At the same time, point 5 becomes point 12.

In order to determine the postoperative hip joint center:

1.	 Define the head center.
2.	 The head center is displayed and becomes point 11. Point 12 automatically obtains the position of 

point 5.
3.	 The hip joint center is determined.

Step 11 – Calculate Biometric Evaluation Circle

Requirements:
Biometric points 11 and 12 are defined.

Result:
A circle by 3 points is drawn above the area, in which the 
new joint geometry is supposed to be positioned. Within this 
circle, an area with colored markers appears, evaluating the 
postoperative biometric situation.

The different colors represent the following Hip score values:

10-12 points	 Light green represents ideal, good or very 
good hip joint biomechanics

9-7 points	 Dark green represents satistfactory hip joint 
biomechanics

6-4 points	 Light yellow represents moderate, unfavor-
able hip joint biomechanics

3-0 points	 Dark yellow and red represent poor or very 
poor hip joint biomechanics

In order to determine the possible rotation centers within a 
specified area, select an area by creating a circle by 3 points.

IMPAX Orthopaedic Tools evaluates the possible rotation 
centers inside the specified area.

In order to draw the resection line:

1.	 Select the first point, the medial starting point of the resection line.
2.	 Select the second point. For a straight cut, the second point is on the lateral corticalis. For a stepped 

cut, the point indicates the step (see picture above).
3.	 Select the third point. For a straight cut, it is placed outside the femur. For a stepped cut, it is placed 

on the lateral corticalis (see picture above). 
4.	 The resection line is drawn and the image is removed in the respective area.
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In order to define the biometric evaluation circle:

1.	 Define the first point of the evaluation circle.
2.	 Define the second point of the evaluation circle.
3.	 Pull open a circle and define the third point of the evaluation circle.
4.	 The evaluation circle is defined, the hip score displayed by colored markers.

No optimal rotation center found?

If IMPAX Orthopaedic Tools can't find any point with a hip score of 7-12, the following strategies will usually help 
you to obtain a better evaluation:

•	 Check the position of the biometric marker points. You can move and replace individual points.
•	 Insert another prosthesis type or adjust the neck length. In this case you have to reset the rotation 

center of the prosthesis (point 11).
•	 Following that, the optimal rotation centers have to be recalculated. Define the evaluation circle by 

selecting 3 points, possibly widen the analyzed area.

In some exceptional cases, it is of course possible that no satisfactory score can be achieved.

Step 12 – Delete Bad Values

Requirements:
An optimal or good biometric area is available (score 7-12).

Result:
In order to make the planning image clearer, you can delete all points with 
a low hip score.

In order to delete bad values:

1.	 Select the area which surrounds the best points with the best value, i.e. if the best available zone is 
light green, click on the dark green zone in order to delete all other points. If the best available zone 
is dark green, click on the light yellow zone.

2.	 The bad values are deleted, the optimal or good zone for placing the new rotation center is visual-
ized. End the function with a right click of the mouse.

Step 13 – Select and Insert Cup

Requirements:
Suitable points for cup placement are available.

Result:
Using the function Insert Cup, you can select the manufacturer, type, size 
and other properties of a cup and place the cup on the required position 
in the required inclination.

WARNING
All dimensions and measurements given by the IMPAX Orthopaedic Tools prosthesis database 
derived from original manufacturer data or templates. If you suspect that the data is not cor-
rect, please report it to Agfa‘s service representative or contact Agfa using the contact infor-
mation provided in the beginning of this manual.
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Requirements:
The cup is placed within the optimal zone.

Result:
When activating this function, all relevant elements to be moved (stem, 
femoral outline and biometric point 12) are automatically selected. The 
rotation center of the stem is brought to congruency with the rotation 
center of the cup.

Step 14 – Repositioning Stem

CAUTION
If necessary, an abduction/adduction can be corrected simultaneously by using the cursor keys, 
however, this will also alter the biometric values.

After selecting the function, you are in the Implant/template tool, the prosthesis used last is attached to the 
mouse cursor, freely moveable in the work area.

After selecting the line color, line width as well as the body side, consecutively select the desired manufacturer, 
the prosthesis type, prosthesis size and all other properties. The prosthesis attached to the mouse cursor changes 
accordingly. Further info about inserting implants can be found at »Inserting Implants«.

In order to insert the cup:

1.	 The prosthesis usually appears on the mouse under 45°. By using the cursor keys ← and →, you 
can adjust the inclination of the prosthesis. The angle in ° is displayed in the Angle field of the im-
plant/template tool. In capture mode Free you can place the prosthesis anywhere in the image. 
Using the key P, the capture mode for a Point is activated, e.g. the hip joint center. If you approve of 
size/position/angle, place the prosthesis.

2.	 As long as the prosthesis is not confirmed as final, you can always pick it up again and move or modi-
fy it. You can change the size by using the cursor keys ↓ and ↑ after selecting the respective column 
of the menu list or the respective fly out menu.

3.	 With a right click of the mouse, confirm the prosthesis as final.
4.	 The prosthesis is inserted.

You are in the copy/move tool.

To reposition the stem:

1.	 All elements to be moved are automatically selected and marked.
2.	 Select the rotation point of the prosthesis (head center) as a grab point.
3.	 The prosthesis is now attached to the mouse cursor. Use the cursor keys ← or → for rotation. This 

also changes the position of the biometric point 12, possibly altering the biometrical values as well. 
Place the stem on the rotation center of the cup, bringing the head center to congruency with the 
cup.

4.	 The repositioning is completed.
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Step 15 – Define Postoperative Biometric Values

Requirements:
The new hip joint geometry is placed at the desired postoperative position.

Result:
The postoperative values are attached to the mouse cursor and can be positioned next to the preoperative values 
for comparison purposes. The leg length difference is automatically determined. At the same time, all values are 
included into the Planning Information.

CAUTION
Only the final results are recorded and displayed in the Planning Information. This makes sure the 
planning always provides up to date information when transferred into the patient database.
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To measure the CCD angle using axes with 2 points:

1.	 Define the first point of the first axis (e.g. FSA – femoral shaft axis).
2.	 Define the second point of the first axis.
3.	 Define the first point of the second axis (e.g. FNA – femoral neck axis).
4.	 Define the second point of the second axis.
5.	 The CCD angle is drawn, the angle size in ° is displayed.

To measure the CCD angle using axes with 4 points:

1.	 Define the first point of the first axis.
2.	 Define the second point of the first axis, opposite (medial) of the first point.
3.	 Define the third point of the first axis.
4.	 Define the fourth point of the first axis, opposite (medial) of the third point.
5.	 Define the first point of the second axis.
6.	 Define the second point of the second axis, opposite (medial) of the first point.
7.	 Define the third point of the second axis.
8.	 Define the fourth point of the second axis, opposite (medial) of the third point.
9.	 The CCD angle is drawn, the angle size in ° is displayed.

Step 16 – Measure Distances and Angles

Step 17 – Measure CCD Angle

The measuring of distances and angles is described in chapter »Working with IMPAX Orthopaedic Tools«, sections 
»Measure Distance« and »Measure Angle«.

NOTE
To measure the leg length correction, set the first point on the outline, e.g. greater trochanter. Set 
the second point perpendicular to the first one. An inclinated line between the measurement points 
causes incorrect measurements.

Requirements:
A scaled image.

Result:
The CCD angle is drawn and measured.

You are in the CCD angle tool. You can choose from two drawing modes  
for each of the axes to be drawn (FSA/femoral shaft axis and FNA/femoral 
neck axis): 2 points or 4 points. The sequence in which you draw the two 
axes does not matter. The additional option FNA by M.E. Mueller is ex-
plained on the next page.
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Step 18 – Measure Leg Length Difference

The measuring of the leg length difference is described in chapter »Hip - Manual Planning«, »Step 15 – Measure 
Leg Length Difference«.

If a CCD angle is measured outside of the norm range of 
124°/136°, the comment (>N) or (<N) is added to the mea-
surement label. In case of a substantial deviation, the warning 
shown on the right is displayed.

Step 19 – Insert Osteosynthesis Components

The procedure to insert plates, nails and screws is the same as the procedure to insert implants.

Step 20 – Insert Planning Information

The procedure to insert the planning information is described in chapter »Hip - Manual Planning«, »Step 20 – 
Insert Planning Information«.

As long as you are in the function CCD angle, you can grab the drawn lines at their respective ending points or in 
the middle to e.g. move them parallel or to rotate. Once you have defined 2 or 4 points, the axis is shown. Once the 
second line is finished, the CCD angle appears automatically. Draw the axes on the left and on the right body side.

After drawing the femoral shaft axis, instead of drawing the fem-
oral neck axis by 2 or 4 points you can also use the function 
according to M.E. Mueller.

In order to draw the femoral neck axis by M.E. Mueller:

1.	 Select the first point on the edge of the femoral head.
2.	 Move the mouse in order to match the femoral head with the displayed aid circle. By clicking the 

mouse, define the second edge point of the femoral head.
3.	 Place point 3 on the lateral corticalis of the femoral neck (at the most narrow area).
4.	 Place point 4 on the medial corcitalis of the femoral neck. IMPAX Orthopaedic Tools assists with 

correct placing on the opposite side in relation to the femoral head center.
5.	 The CCD angle size ° is displayed. Exit the function with a right click of the mouse.

Step 17a – Femoral Neck Axis by M.E. Mueller
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Basics

The module Hip - Coxometry provides indicators for the determination of pathological and non-pathological hip 
joints.

It allows to assess hip joints on the basis of clinically relevant values. These values differ in hip joints of children and 
adults and are rated differently depending on the course of the medical condition, therefore, they can be looked 
at separately.

Some criteria are evaluated automatically by IMPAX Orthopaedic Tools using graduation tables, e.g. the acetabu-
lum femoral head index or the angle of acetabular inclination. A detailed description of the particular hip param-
eters as well as information on their evaluation is described on the next pages.

In order to obtain reliable angle values, please use x-rays taken according to the following criteria:

•	 Symmetrical positioning of the pelvis
•	 Hip joints in neutral position
•	 Longitudinal femur axis parallel to the image receptor plane

Hip Values

The hip values are described in alphabetical order below:

•	 ACE angle according to Wiberg or CE angle = anterior center-edge angle
•	 ACW Acetabular angle: AC-SZW: acetabular angle (angle of sclerotic area of the roof of the acetabu-

lum if the Y-cartilage is closed)
•	 AC-Hilg: acetabular angle according to Hilgenreiner (if the Y-cartilage is open)
•	 ACM angle according to Idelberger and Frank
•	 CCD angle
•	 HW = hip index according to Busse, Gasteiger and Tönnis
•	 HPKI = acetabulum-femoral head index according to Heymann and Herndorn
•	 MZ = decentralized distance line used to calculate the hip index
•	 PFNW = acetabular inclination angle according to Ullmann
•	 MI = migration index according to Reimers / Reimer’s index

IMPAX Orthopaedic Tools uses tables familiar from medical literature for evaluation.

ACE Angle according to Wiberg – CE Angle

Wiberg angle and CE angle are used synonymously. CE angle is an abbreviation for center-edge angle. The CE angle 
is a dimension used for precise assessment of the development of the roof of the acetabulum in patients with hip 
joint dislocation or hip dysplasia.

It is the angle formed by the following lines:

•	 Parallel line to the longitudinal axis of the body positioned through the center of the femoral head
•	 Straight line running through the lateral edge of the acetabulum and the center of the femoral head

NOTE
In order to determine the development of the acetabulum (e.g. AC-HILG, ACE), the pelvis must not 
be in a lordotic position (flexion of hip and knee joints) and the patellae must be in zero position. 
In order to determine the situation of the femoral head, femoral neck and femur (e.g. CCD Angle), 
the patient must be positioned in such a way that the longitudinal axis of the femur is parallel to the 
image receptor plane. The hip joints must be in a neutral position and the patellae in zero position.
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	 Age	 Normal value	 Grade 1	 Grade 2	 Grade 3	 Grade 4
		  Mean value	 normal	 slightly path.	 gravely path.	 extremely path.

	 0 to ≤ 8	 25	 ≥ 20	 ≥ 15 to < 20	 ≥ 0 to < 15	 0

	 ≥ 8 to ≤ 18	 32	  ≥ 25	 ≥ 20 to < 25	 ≥ 5 to  < 20	 < 5

	 > 18 to ∞ 	 35 	 ≥ 30 	 ≥ 20 to < 30	  ≥ 5 to < 20 	 < 5

E: acetabulum convexity
Z: center of the femoral head

Determining the center of the femoral head =Z by 3 points on the hip outline (in case of hip head deformities, the 
circle has to be above the acetabular outline of the head)

Further information can be found in Hellinger: Messmethoden in der Skelettradiologie (1995).

ACM Angle
according to Idelberger and Frank

The ACM angle according to Idelberger and Frank is an indicator for the development of the acetabulum.

B: most caudal point of acetabulum edge
C: intersection of acetabulum floor and the perpendicular to the line BE
E: acetabulum convexity
M: point halfway along the line EB
Z: center

ACE Angle

Reference line

E = acetabulum convexity

ACM Angle
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	 Age	 Normal value	 Grade 1	 Grade 2	 Grade 3	 Grade 4
		  Mean value	 normal	 slightly path.	 gravely path.	 extremely path.

	 < 4 m.	 25	 < 30	 ≥ 30 to < 35	 ≥ 35 to < 40	 ≥ 40
	 5 m. to 2 y.	 20	 < 25	 ≥ 25 to < 30	 ≥ 30 to< 35	 ≥ 35
	 2 to 3 y.	 18	 < 23	 ≥ 23 to < 28	 ≥ 28 to < 33	 ≥ 33
	 3 to 7 y.	 15	 < 20	 ≥ 20 to < 25	 ≥ 25 to < 30	 ≥ 30
	 7 to 14 y.	 10	 < 15	 ≥ 15 to < 20	 ≥ 20 to < 25	 ≥ 25

	 Age	 Normal value	 Grade 1	 Grade 2	 Grade 3	 Grade 4
		  Mean value	 normal	 slightly path.	 gravely path.	 extremely path.

	
	 ≥ 2	 45	 < 50	 ≥ 50 to < 55	 ≤ 55 to < 60	 ≥ 60

Further information can be found in Idelberger, K.: Lehrbuch der Orthopädie (1984).

Acetabular Angle – ACW-SZ / ACW-HL

The acetabular angle indicates the steepness of the acetabulum, as well as the degree of any existing dysplasia.

ACW-SZ

If the Y-cartilage is closed, the acetabular angle is measured between the line parallel to the reference line and the 
line running through the laterocranial acetabulum convexity and the edge of the sclerotic area.

E: laterocranial acetabulum convexity
H: line parallel to reference line/ischial bone tangent
S: edge of the sclerotic area

ACW-HL

If the Y-cartilage is still open, the acetabular angle according to Hilgenreiner is measured (AC-HL) = angle between 
the reference line and the line running through the laterocranial acetabulum convexity and the Y-cartilage.

E: laterocranial acetabulum convexity
T: reference line (line parallel to ischial bone tangent)
Y: Y-cartilage

ACW-SZ

ACW-HL
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Further information can be found in 
Tönnis D.: Roentgen studies and arthrography of the hip joint in infancy (1997) 9-58.
Neidel J., Tönnis D.: Percentile graphs in the documentation of acetabular angle in children with hip dysplasia. A 
tool in the diagnosis and quality control of its treatment (1994) 132 (6): 512-5.

CCD Angle

The CCD angle (Caput-Collum-Diaphysis Angle) is the angle between the femoral neck axis and the femoral shaft 
axis. It is used to exclude coxa vara / coxa valga from the diagnosis. (Coxa valga = steep CCD angle, Coxa vara = 
shallow CCD angle).

FSA: femoral shaft axis
SHA: femoral neck axis

Hip Index

The hip index according to Busse, Gasteiger and Tönnis is a measure of pathological deviations of ACE, ACM and 
MZ. The hip index can only be used for patients from 5 years of age for evaluation purposes. In younger patients, 
the developmental variations are too large, which renders reliable statistical evaluation impossible.

The hip index is calculated using the following values:

ACE angle
ACM angle
MZ = decentralized distance line

HIP INDEX (HW)  =  A+B+C+10

CCD
Angle
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	 Age	 Angle	 Mean value	 Mean variation

	 5 to 8 y.	 ACM	 45.8	 2.7
		  ACE	 24.7	 6.3
		  MZ	 3.2	 1.7

	 9 to 12 y.	 ACM	 45.0	 2.4
		  ACE	 31.1	 5.0
		  MZ	 3.2	 1.51

	 13 to 16 y.	 ACM	 45.6	 2.82

		  ACE	 34.3	 5.7
		  MZ	 3.1	 1.5

	 17 to 20 y.	 ACM	 44.6	 3.0
		  ACE	 35.1	 5.4
		  MZ	 3.6	 1.5

	 > 20 y.	 ACM	 44.9	 3.13

		  ACE	 35.8	 6.44

		  MZ	 3.8	 1.7

1	 Values based on Brustel, Hell, Tönnis
2	 Values taken from the orthopedic accident surgery archives 1972
3	 Further information can be found in: Busse J., Gasteiger W., Tönnis D.: Significance of the "sum-

marized hip factor" in the diagnosis and prognosis deformed hip joints (1972) 72 (3): 245-52
4	 Values taken from the orthopedic accident surgery archives 1972

HPKI – Acetabulum Femoral Head Index
according to Heymann and Herndorn

The acetabulum femoral head index according to Heymann and Herndorn is a measure of the diameter of the 
femoral head and the degree of development of the acetabulum. If the femoral head is covered sufficiently on all 
sides by the acetabulum, the hip joint can develop normally with the acetabulum and femoral head forming a unit.

a: space used by femoral head
b: width of femoral head
E: acetabulum convexity
T: reference line
K1/K2: tangents to the femoral head circle

Grading:
The HPKI should be within the range of 70-90. An HPKI of 90 is regarded as an acceptable normal value.
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	 Age	 Normal value	 Grade 1	 Grade 2	 Grade 3	 Grade 4
		  Mean value	 normal	 slightly path.	 gravely path.	 extremely path.

	 1 to 10 y.	 46	 ≤ 49	 50 to 52	 53 to 55	 ≥ 56

	 11 to 12 y.	 44	 ≤ 47	 48 to 51	 52 to 54	 ≥ 55

	 13 to 14 y.	 42	 ≤ 45	 46 to 49	 50 to 52	 ≥ 53

	 > 14 y.	 40	 ≤ 43	 44 to 46	 47 to 49	 ≥ 50

MZ – Decentralized Distance Line

The decentralized distance line MZ is the distance between the femoral head center (Z) and the halfway point on 
the line running from the acetabulum convexity to the most caudal point of the acetabulum floor (M). The decen-
tralized line is required in order to calculate the hip index according to Busse. In the hip joint of a healthy adult, 
M = Z.

E: acetabulum convexity
B: most caudal point of acetabulum edge
M: point halfway between E and B
Z: femoral head center

PNW – Acetabular Inclination Angle
according to Ullmann

The acetabular inclination angle according to Ullmann measures the degree to which the acetabulum opens up or 
is inclined with respect to reference line.

It is the angle between the reference line (T) and a line (P) running through the acetabulum convexity (E) and the 
lowest point of the tear drop (B).

E: acetabulum convexity
B: lowest point of the tear drop
P: line through E and B
T: reference line (parallel to ischial bone tangent)

Grading:

PNW
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In order to perform coxometric calculations:

1.	 Load/import image as described in »Importing Images«.
2.	 Scale image as described in »Scaling Images«.
3.	 In the module overview window, select the Hip - Coxometry module.

WARNING
Images can only be properly scaled, if a reference object (sphere or scale bar) with dimensions 
known to the user is placed in the image region, close to and at the level of the joint/bone 
area you are interested in, when recording the image. Please verify the entered scaling size tho-
roughly, wrong input can lead to serious miscalculation. The original IMPAX Orthopaedic Tools 
sphere has a 25 mm diameter with a +/- 0.1 mm tolerance. When using other reference objects, 
measure and tolerance of the respective manufacturer apply. Please pay extreme attention to 
the Image Requirements and Scaling Instructions at the end of this User Manual.

Workflow Step by Step

Step 1 – Insert & Scale Images

Step 2 – Define Hip Joint Center (HJC)

Requirements:
A scaled image.

You have the following 3 options to define the HJC: Circle by 3 points. CCD angle, Circles and center.

Step 2a – Define HJC with Circle by 3 Points

Result: 
A circle by 3 points is drawn, the circle and the diameter in mm are shown 
for a quick moment, the hip joint center is drawn.

After selecting the line color and line width, start drawing the circle.

The Reimer’s Index measures the depth placement of the femoral head. It is the quotient of the distance between 
the lateral rim of the femoral head to the Perkins Ombredanne line (line a) and the horizontal diameter of the 
femoral head (line b), multiplied by 100 for a percentual evaluation of the depth placement of the femoral head.
This way the percentage of the not covered part of the femoral head can be determined.

T: reference line
L: lateral rim of the head
M: medial rim of the head
O: Perkins Ombredanne line
a: not covered part of femoral head
b: femoral head diameter

Grading:

Normal:		  up to 4 years: 0%				   Subluxation:	 33-99%
		  4-16 years: < 10%				   Luxation:	 100%

MI – Migration Index according to Reimers / Reimer’s Index
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Step 2c – Define HJC with Circles and Center

Result: 
By drawing two or more concentric circles, the hip joint center in defined. 
This way, the hip joint center can be defined even in case of serious hip 
bone deformities.

In order to define the HJC with circles and center:

1.	 Define the first point, e.g. the medial acetabular edge.
2.	 Define two or more points on the acetabular edge and the edge of the femoral head.
3.	 Define any desired amount of points. Each point successively generates a circle. Multiple points on 

the acetabular edge and the edge of the femoral head generate an according amount of circles.
4.	 With a right click of the mouse, end the definition of points. There are as many circles attached to 

the mouse cursor, as points have been defined.
5.	 Place the circles in congruence in such a way, that 2 circles are formed. One covering the femoral 

head, one covering the acetabular edge.
6.	 Define the center when reaching the best level of congruency.
7.	 The hip joint center is defined, the concentric circles are hidden.

Step 3 – Draw Reference Line

Requirements:
A scaled image.

Result:
The reference line is drawn. It serves as a reference line for 
further calculations.

Step 2b – Define HJC Freely

Result: 
Using this function, the HJC is defined freely.

After selecting point color/type and line width, define the HJC freely.

In order to define the HJC with a circle by 3 points:

1.	 Define the first point.
2.	 Define the second point.
3.	 A circle with diameter in mm is displayed. Define the third point.
4.	 The hip joint center is drawn.
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In order to draw the reference line:

1.	 Define the starting point of the line (1).
2.	 Define the end point of the line (2).
3.	 The reference line is drawn.

Step 4 – Define CCD Angle

Requirements:
A scaled image.

Result:
The CCD angle is drawn and measured.

You are in the CCD angle tool. You can choose from two drawing modes  for each of the 
axes to be drawn (FSA/femoral shaft axis and FNA/femoral neck axis): 2 points or 4 points. 
The sequence in which you draw the two axes does not matter. The additional option FNA 
by M.E. Mueller is explained in chapter »Hip - Manual Planning«, »Step 14a – Femoral 
Neck Axis by M.E. Mueller«.

To measure the CCD angle using axes with 2 points:

1.	 Define the first point of the first axis (e.g. FSA – femoral shaft axis).
2.	 Define the second point of the first axis.
3.	 Define the first point of the second axis (e.g. FNA – femoral neck axis).
4.	 Define the second point of the second axis.
5.	 The CCD angle is drawn, the angle size in ° is displayed.

To measure the CCD angle using axes with 4 points:

1.	 Define the first point of the first axis.
2.	 Define the second point of the first axis, opposite (medial) of the first point.
3.	 Define the third point of the first axis.
4.	 Define the fourth point of the first axis, opposite (medial) of the third point.
5.	 Define the first point of the second axis.
6.	 Define the second point of the second axis, opposite (medial) of the first 

point.
7.	 Define the third point of the second axis.
8.	 Define the fourth point of the second axis, opposite (medial) of the third 

point.
9.	 The CCD angle is drawn, the angle size in ° is displayed.

As long as you are in the function CCD angle, you can grab the drawn lines at their respective ending points or in 
the middle to e.g. move them parallel or to rotate. Once you have defined 2 or 4 points, the axis is shown. Once the 
second line is finished, the CCD angle appears automatically. Draw the axes on the left and on the right body side.

If a CCD angle is measured outside of the norm range of 
124°/136°, the comment (>N) or (<N) is added to the mea-
surement label. In case of a substantial deviation, the warning 
shown on the right is displayed.
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In order to calculate the coxometric values:

1.	 Define the first point, the laterocranial acetabular edge.
2.	 Define the second point, the mediocaudal acetabular edge.
3.	 Define the third point, the caudal tear drop.
4.	 Define the fourth point, on the cranial sclerotic area. With the circle attached to the mouse cursor, 

try to cover the edge of the femoral head as accurately as possible.
5.	 Define the fifth point, the acetabular bottom.
6.	 Define the sixth point, the medial edge of the sclerotic area. You may skip this point if the Y-cartilage 

is still open by using the space key.
7.	 Define the seventh point, within the Y-cartilage. You may skip this point it the Y-cartilage is closed 

by using the space key.
8.	 The coxometric values and graduations are now calculated and displayed.

WARNING
Please check and verify all entries very carefully, wrong information can cause severe problems. 
THe following details always have to be filled in:
Physician's name – Patient's Name – Patient's date of birth – Recording date of the image

Step 6 – Calculate Radius Head Quotient/Mose Index

Requirements:
A scaled x-ray image.

Result:
The following values are calculated and displayed:

•	 Radius left body side in mm
•	 Radius right body side in mm
•	 Coxa magna ratio, which is the quotient of the left 

femoral head radius and the right femoral head radius
•	 Mose Index: the difference between the greater and 

the smaller radius divided by the greater radius

Step 5 – Calculate Coxometric Values

Requirements:
HJC and reference line are drawn, patient's date of birth as 
well as the image recording date are entered in the Planning 
Information.

Result:
After defining the required points, all values are calculated 
and subsequently shown in a chart.

Abbreviations:
ACE	 Angle according to Wiberg/CE angle
ACM	 Angle according to Idelberger & Frank
MZ	 Decentralized distance line used to calculate the 

hip index
HW	 Hip index according to Busse, Gasteiger and Tönnis
HPKI	 Acetabulum-femoral head index according to 

Heymann and Herndorn
PNW/US	 Acetabular inclination angle according to Ullmann
ACW-SZW	 Acetabular angle (angle of sclerotic area of the 

roof of the acetabulum if the Y-cartilage is closed)
ACW-HILG	 Acetabular angle according to Hilgenreiner (if the 

Y-cartilage is open)



127

IMPAX Orthopaedic Tools» Table of Contents «

» Table of Contents «

Hip - Coxometry

After selecting line color and line width, draw a circle above each of the femoral heads, covering the femoral head 
as accurately as possible.

In order to calculate the radius head quotient/mose index:

1.	 Define the first point of the circle on the right body side.
2.	 Define the second point and complete the circle on the right body side.
3.	 Define the first point of the circle on the left body side. The calculation is already being displayed 

and changes when moving the mouse (thus changing the circle size).
4.	 Define the second point and complete the circle on the left body side.
5.	 The circles above both femoral heads are drawn, the calculation result is now displayed.

Step 7 – Calculate Articulo Trochantric Distance (Leg Length Difference)

Requirements:
A scaled x-ray image and a drawn reference line.

Result:
The distances from greater trochanter (trochanter major) to acetabular edge on both body sides, the difference 
between those distances which indicates the leg length difference, as well as the quotient of both distances are 
calculated and displayed automatically.

In order to calculate the articulo trochantric distance:

1.	 Define the right trochanter major, laterocranial.
2.	 Define the right, cranial acetabular edge.
3.	 Define the left trochanter major, laterocranial. The calculation is already being displayed and chang-

es when moving the mouse.
4.	 Define the left, cranial acetabular edge.
5.	 The results are now displayed.

Step 8 – Calculate Reimer’s Index

Requirements:
A scaled x-ray image and a drawn reference line.

Result:
The Reimer’s Index is calculated and displayed in percent.

After selecting line color and line width, draw the femoral head (circle by 2 edge points).
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Step 9 – Insert Osteosynthesis Components

The procedure to insert plates, nails and screws is the same as the procedure to insert implants.

The procedure to insert the planning information is described in chapter »Hip - Manual Planning«, »Step 20 – 
Insert Planning Information«.

Step 10 – Insert Planning Information

In order to calculate the Reimer‘s Index:

1.	 Define the first edge point of the femoral head.
2.	 A circle preview is displayed. Define the second edge point of the femoral in such a way that the 

circle recreates the femoral head as exactly as possible..
3.	 A line preview is displayed (perpendicular to the reference line). Define the lateral acetabular edge.
4.	 The Perkins Ombredanne line is drawn. Define the side to be measured according to the body side 

that is being examined. Place a mouse click in the lateral area of the not covered part of the femoral 
head. The Reimer‘s Index is displayed as a preview.

5.	 The Reimer‘s Index value is attached to the mouse cursor. Place the value at the desired position of 
the planning.

6.	 The calculation is completed. The function ends automatically.
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Hip - Wear Measurement
(Not available in IOT 3.0!)
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Basics

The module Hip - Wear Measurement allows you to measure the wear of hip endoprostheses

The measurement can be performed using two or more images. The following instructions are assuming the use 
of two images.

Requirements

This method can only be used for acetabular cups with a spherical outer shape and consisting of the material com-
bination "polyethylene inlay - ceramic/metal head".

Cups with a macro surface structure are not suited for measurement.

Only almost identical images can be compared to each other: the position of the hip endoprosthesis should be 
similar, if possible. Views must be the same on both images (AP and AP, ML and ML, etc.).

The chronological distance between the images should be as much as possible (wear increases the more time has 
passed).

Workflow Step by Step

Step 1 – Insert & Scale Images

In order to perform a wear measurement:

1.	 Load/import image as described in »Importing Images«.
2.	 Scale image as described in »Scaling Images«.
3.	 In the module overview, select the Hip - Wear Measurement module.

WARNING
Images can only be properly scaled, if a reference object (sphere or scale bar) with dimensions 
known to the user is placed in the image region, close to and at the level of the joint/bone 
area you are interested in, when recording the image. Please verify the entered scaling size tho-
roughly, wrong input can lead to serious miscalculation. The original IMPAX Orthopaedic Tools 
sphere has a 25 mm diameter with a +/- 0.1 mm tolerance. When using other reference objects, 
measure and tolerance of the respective manufacturer apply. Please pay extreme attention to 
the Image Requirements and Scaling Instructions at the end of this User Manual.

Step 2 – Drawing Reference Lines

Requirements:
To scaled x-ray images, showing the hip implant.

Result:
Both reference lines are drawn. They serve as reference lines 
for the upcoming calculations.
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In order to draw the reference lines:

1.	 Define the starting point of the line.
2.	 Define the end point of the line.
3.	 The reference line is drawn.
4.	 Repeat the procedure for the second and all other images.

Step 3 – Defining Head Center by 3 Points

Requirements:
To scaled x-ray images, showing the hip implant.

Result:
The head centers are drawn.

In order to define the head centers:

1.	 Set the first point on the edge of the hip head.
2.	 Set the second point on the edge of the hip head.
3.	 An aid circle and its diameter in mm is displayed. Set the third point on the edge of the hip head.
4.	 The head center is drawn.
5.	 Repeat the procedure for the second and all other images.

Step 4 – Defining Cup Center by 3 Points

Requirements:
To scaled x-ray images, showing the hip implant.

Result:
The cup centers are drawn.

In order to define the cup centers:

1.	 Set the first point on the edge of the cup.
2.	 Set the second point on the edge of the cup.
3.	 An aid circle and its diameter in mm is displayed. Set the third point on the edge of the cup.
4.	 The cup center is drawn.
5.	 Repeat the procedure for the second and all other images.
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Step 5 – Calculation of Wear

Requirements:
Two scaled x-ray images showing the hip implant, as well as correctly defined reference lines, head centers and cup 
centers.

In order to perform the calculation of wear:

1.	 In the Wear Calculation Tool, enter the recording dates of 
the images (the corresponding image for the date you're 
entering is always shown in full screen). Check/correct any 
automatically filled-in dates.

2.	 Select the respective body side.
3.	 The calculations are automatically performed, the results 

are displayed.
4.	 A right mouse click opens a pop-up context menu, where 

you can either apply or reject the results.
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The "X" in the second image (B) marks the projected, original 
position of the head center.

The line between "X" and current head center shows the 
wear direction.

Step 6 – Measure Inclination/Anteversion

Requirements:
A scaled x-ray image with a correctly drawn reference line.

Result:
The edge of the cup is drawn. Inclination and anteversion of 
the cup are calculated and displayed.

In order to measure inclination/anteversion:

1.	 Set the first point on the lateral edge of the cup.
2.	 Set the second point on the medial edge of the cup. The inclination of the cup is already shown and 

changes when moving the mouse.
3.	 Move the mouse away from the drawn line, towards the edge of the cup. A preview of an ellipse is 

shown. Bring the edge of the ellipse and the edge of the cup to congruency, and set the third point.  
The anteversion of the cup is now shown as well and changes when moving the mouse.

4.	 Inclination and anteversion are calculated. The result in ° is attached to the mouse cursor.
5.	 Place the result to the desired position.
6.	 You can now measure the inclination/anteversion of another cup or end this function with a right 

click of the mouse.

ATTENTION
This measurement is only valid if pelvis is positioned perfectly perpendicular to and centered on 
the x-ray beam.

The procedure to insert the planning information is described in chapter »Hip - Manual Planning«, »Step 20 – 
Insert Planning Information«.

Step 7 – Insert Planning Information
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Basics

The new module Hip - FAI (femoral acetabular impingement) assists you with the professional measurement and 
evaluation of the hip joint morphology. This way you can document all necessary steps pre and post operatively 
for quality management purposes, as well as for visualization during surgery.

The femoral acetabular impingement is a pathological condition in which proximal femur rubs abnormally or 
doesn’t have full range of motion in the acetabular socket. At the present day, this is considered to be one of the 
main causes for the development of hip joint arthritis.

There is two different types of FAI: the Pincer deformity (characterized by excessively overreaching acetabular 
edges and/or retrotorsion of the acetabular socket) and the Cam deformity (protrusion/bumps at the femoral 
head/proximal femur junction as well as offset disorder and asphericity of the femoral head), often to be found in 
combination.

IMPAX Orthopaedic Tools assist you with precise measuring and assessment of all FAI types, using various forms 
of x-ray images. These include the following:

•	 pelvis overview (anterior-posterior – central beam on Os coccygis)
•	 Lauenstein image
•	 Rippstein image
•	 false profile (“faux profile“) image
•	 cross-table image

A faux profile x-ray is always recommended. In case of a suspected cross-over sign on the pelvis overview, you can 
assess the various types of the Pincer deformity by measuring the anterior CE angle and assessing the dorsal joint 
cavity widths (e.g. a posterior impingement due to a prominent posterior edge). A faux profile is also very helpful 
for the assessment of dysplasia cases.

With regard to the x-ray images, please also pay attention to chapter »Image Requirements & Scaling« at the end 
of this manual. 

You can draw and measure/evaluate the following values and angles:

•	 cross-over sign
•	 LCE angle (lateral center edge angle according to Wiberg – CE angle)
•	 ACE angle (anterior CE angle – VCA angle)
•	 Alpha angle according to Nötzli
•	 femoral head-neck offset

Workflow Step by Step

In order to perform FAI measurements:

1.	 Load/import image as described in »Importing Images«.
2.	 Scale image as described in »Scaling Images«.
3.	 In the module overview, select the Hip - FAI module.

WARNING
Images can only be properly scaled, if a reference object (sphere or scale bar) with dimensions 
known to the user is placed in the image region, close to and at the level of the joint/bone 
area you are interested in, when recording the image. Please verify the entered scaling size tho-
roughly, wrong input can lead to serious miscalculation. The original IMPAX Orthopaedic Tools 
sphere has a 25 mm diameter with a +/- 0.1 mm tolerance. When using other reference objects, 
measure and tolerance of the respective manufacturer apply. Please pay extreme attention to 
the Image Requirements and Scaling Instructions at the end of this User Manual.

Step 1 – Insert & Scale Images
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Step 2 – Define Hip Joint Center (HJC)

Requirements:
A scaled image.

Result: 
A circle by 3 points is drawn, the circle and the diameter in mm are shown 
for a quick moment, the hip joint center is drawn.

After selecting the line color and line width, start drawing the circle.

In order to define the HJC with a circle by 3 points:

1.	 Define the first point.
2.	 Define the second point.
3.	 A circle with diameter in mm is displayed. Define the third point.
4.	 The hip joint center is drawn.

Step 3 – Draw Reference Line

Requirements:
A scaled image.

Result:
The reference line is drawn.

In order to draw the reference line:

1.	 Define the starting point of the line (1).
2.	 Define the end point of the line (2).
3.	 The reference line is drawn.

After selecting the line color and line width, start by drawing the reference line (depending on the x-ray, the line 
can be chosen individually, e.g. acetabulum, ischium).

Step 4 – Draw Cross-Over Sign

Requirements:
A scaled image.

Result:
Anterior and posterior walls are drawn. A potential cross-over 
sign is visualized. This way you can determine and illustrate 
an acetabular retroversion or an overreaching acetabular 
edge (often anterolateral). This can indicate either dysplasia 
or a Pincer deformity.

After selecting the line color and line width, start by drawing the anterior wall.
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In order to draw the anterior wall:

1.	 Define the first point of the anterior wall.
2.	 Define the next and subsequently all other points of the anterior wall. This way you can trace/draw 

the outline of the anterior wall. By using the Delete button of the FAI tool, you can delete the last 
point/s.

3.	 Conclude drawing the anterior wall with a right click of the mouse. The anterior wall outline is la-
belled accordingly.

Use the same procedure for the posterior wall function.

Step 5 – Draw LCA Angle

Requirements:
A scaled image with drawn hip joint center and reference line.

Result:
The center edge angle according to Wiberg/LCE angle (= lat-
eral CE angle) is drawn and evaluated. This way you can also 
assess a Pincer deformity or measure dysplasia.

After selecting the line color and line width, start drawing the LCA angle.

In order to draw the LCA angle:

1.	 After selecting the function an angle previw is displayed with the hip joint center as apex as well as 
a green dashed line (normal area).

2.	 Select the lateral acetabular edge.
3.	 The LCE angle is drawn. The corresponding assessment is displayed.

Step 6 – Draw ACE Angle

Requirements:
A scaled image (faux profile) with drawn hip joint center.

Result:
The anterior center edge angle/ACE angle (VCA angle) is 
drawn and evaluated. This way you can assess and measure 
both a Pincer deformity, as well as the anterolateral roof (for 
the purpose of dysplasia diagnostics)

After selecting the line color and line width, start drawing the 
ACE angle.

In order to draw the ACE angle:

1.	 After selecting the function an angle preview is displayed with the hip joint center as apex as well as 
a green dashed line (normal area).

2.	 Select the lateral acetabular edge.
3.	 The ACE angle is drawn. The corresponding assessment is displayed.

As shown in the example, you can always draw multiple angles in order to evaluate different scenarios.
NOTE: The ACE/VCA angle is not clearly validated in scientific literature. The normal area referenced in this module 
is therefore only to be seen as an approximation based on expert knowledge.
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Step 7 – Draw Alpha Angle according to Nötzli

An axial recording is recommended to assess the asphericity of the femoral head (Cam deformity). For this purpo-
se, alpha angle and femoral head-neck offset are determined. In principle, you can conclusively measure this angle 
in all hip rotation positions. The standard planes are pelvis overview (pistolgrip deformity) as well as Lauenstein 
and Rippstein images.

Requirements:
A scaled image with drawn hip joint center.

Result:
The alpha angle is measured by only 3 clicks (between the fe-
moral neck axis as well as the line between the hip joint cen-
ter and the point of the head outline leaving the sphericity).
At the same time, the femoral head-neck offset is determined 
by means of two parallel lines between the latter point and 
the tangent of the anterior femoral head outline. A deviation 
from the normal values of both the alpha angle and/or the 
femoral head-neck offset indicate a Cam deformity.

After selecting the line color and line width, start drawing the 
Alpha angle.

In order to draw the Alpha angle:

1.	 After selecting the function, a circle preview is displayed using the hip joint center as center point. 
Adjust the circle in such a way that the edge of the femoral head is exactly traced. Confirm with a 
click of the mouse.

2.	 A line connected to the hip joint center is attached to the cursor of the mouse. Click on a point of 
the femoral neck axis. The femoral neck axis is drawn.

3.	 A preview of the Alpha angle with the corresponding measurement label as well as the tangent of 
the anterior femoral head outline are displayed. Click on the point where the femoral head outline 
is leaving the sphericity.

4.	 The Alpha angle as well as the femoral head-neck offset are drawn.

Step 8 – Perform Resection

If needed for your planning (e.g. in case of a Cam deformity), you can cut and move specific bone areas. You are in 
the image tool, the function Cut and move image area is selected.

In order to perform the resection:

1.	 Select the first and successively all other required points of the image area to be cut out. Alterna-
tively, draw the image area while holding down the mouse button. A preview of the image area is 
shown in inverted style.

2.	 A right click with the mouse cuts the image area.
3.	 Pick up the image area and move it to the desired position.
4.	 Exit the function with a right click of the mouse.

Step 9 – Insert Planning Information

The procedure to insert the planning information is described in chapter »Hip - Manual Planning«, »Step 20 – 
Insert Planning Information«.
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Basics

The new module Hip - Intertrochanteric Osteotomy offers a specifically designed workflow for the planning of os-
teotomies close to the hip joint with the purpose of anomaly correction of femoral torsion and socket anteversion.

With regard to the x-ray images, please also pay attention to chapter »Image Requirements & Scaling« at the end 
of this manual. 

Workflow Step by Step

In order to perform Intertrochanteric Osteotomies:

1.	 Load/import image as described in »Importing Images«.
2.	 Scale image as described in »Scaling Images«.
3.	 In the module overview, select the Hip - Intertrochanteric Osteotomy module.

WARNING
Images can only be properly scaled, if a reference object (sphere or scale bar) with dimensions 
known to the user is placed in the image region, close to and at the level of the joint/bone 
area you are interested in, when recording the image. Please verify the entered scaling size tho-
roughly, wrong input can lead to serious miscalculation. The original IMPAX Orthopaedic Tools 
sphere has a 25 mm diameter with a +/- 0.1 mm tolerance. When using other reference objects, 
measure and tolerance of the respective manufacturer apply. Please pay extreme attention to 
the Image Requirements and Scaling Instructions at the end of this User Manual.

Step 1 – Insert & Scale Images

Step 2 – Define Hip Joint Center (HJC)

Requirements:
A scaled image.

Result: 
A circle by 3 points is drawn, the circle and the diameter in mm are shown 
for a quick moment, the hip joint center is drawn.

After selecting the line color and line width, start drawing the circle.

In order to define the HJC with a circle by 3 points:

1.	 Define the first point.
2.	 Define the second point.
3.	 A circle with diameter in mm is displayed. Define the third point.
4.	 The hip joint center is drawn.
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Step 3 – Define Femur Shaft Axis

Requirements:
A scaled x-ray image.

Result: 
The femur shaft axis is drawn.

In order to draw the femur shaft axis:

1.	 Define the first point on the inner corticalis.
2.	 Define the second point on the inner corticalis (opposite of the first point).
3.	 Define the third point on the inner corticalis.
4.	 Define the fourth point on the inner corticalis (opposite of the third point).
5.	 The femur shaft axis is drawn.

Requirements:
A scaled x-ray image with drawn hip joint center and femur 
shaft axis.

Result: 
The intertrochanteric osteotomy is performed.

Once you select the function Intertrochanteric Osteotomy, an image area is drawn around the femoral head and 
the femur and highlighted in with a colored line.

After selecting line color and line width, start by drawing the osteotomy base line.

Step 4 – Perform Intertrochanteric Osteotomy
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In order to perform an intertrochanteric osteotomy:

1.	 Define the first point (1) of the base line.
2.	 Define the second point (2) of the base line.
3.	 An auxiliary line appears attached to the mouse cursor. Define the rotation center (3) of the resec-

tion angle. 
 
Depending on varus or valgus, the osteotomy is simulated via Open Wedge or Closed Wedge after 
defining the rotation center. 
 
In case of Closed Wedge: 
Point 3 above base line: 
The upper part of the image is overlapped. 
Point 3 below base line: 
The lower part of the image is overlapped. 

4.	 By placing another point (4), draw the resection angle and direction.
5.	 A preview sketch is displayed attached to the mouse cursor. Place the preview on a suitable posi-

tion, with a sufficient distance to the original.
6.	 The intertrochanteric osteotomy is performed, femoral head 

and femur are automatically aligned in the selected angle, 
the applied angles are displayed.

7.	 By using the options Rotate around femoral head and Rotate 
femur of the osteotomy tool, you can now manually adjust 
the resected image area.  
 
In order to do so, click anywhere inside or outside the image 
area. The image preview is temporarily hidden, the pre-
view sketch is displayed again and the selected element is 
attached to the mouse cursor. Rotate the element by the 
required angle and place the image area on its target position 
with another click of the mouse. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

8.	 Once the you have reached the required result, exit the function with a right click of the mouse.
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Step 5 – Insert Osteosynthesis Components

Requirements:
A scaled image.

Result:
You can select the manufacturer, type, size and other properties of the prostheses to be inserted.

WARNING
All dimensions and measurements given by the IMPAX Orthopaedic Tools prosthesis database 
derived from original manufacturer data or templates. If you suspect that the data is not cor-
rect, please report it to Agfa‘s service representative or contact Agfa using the contact infor-
mation provided in the beginning of this manual.

After selecting the function, you are in the Implant/template tool, the prosthesis used last is attached to the 
mouse cursor, freely moveable in the work area.

After selecting the line color, line width as well as the body side, consecutively select the desired manufacturer, 
the prosthesis type, prosthesis size and all other properties. The prosthesis attached to the mouse cursor changes 
accordingly. Further info about inserting implants can be found at »Inserting Implants«.

In order to insert prostheses:

1.	 The prosthesis appears on the mouse. By using the cursor keys ← and →, you can adjust the 
inclination of the prosthesis. The angle in ° is displayed in the Angle field of the implant/template 
tool. In capture mode Free you can place the prosthesis anywhere in the image. Using the key P, 
the capture mode for a Point is activated, e.g. the hip joint center. If you approve of size/position/
angle, place the prosthesis.

2.	 As long as the prosthesis is not confirmed as final, you can always pick it up again and move or modi-
fy it. You can change the size by using the cursor keys ↓ and ↑ after selecting the respective column 
of the menu list or the respective fly out menu.

3.	 With a right click of the mouse, confirm the prosthesis as final.
4.	 The prosthesis is inserted.

Step 5 – Draw Reference Line

Requirements:
A scaled image.

Result:
The reference line is drawn.

In order to draw the reference line:

1.	 Define the starting point of the line (1).
2.	 Define the end point of the line (2).
3.	 The reference line is drawn.

After selecting the line color and line width, start by drawing the reference line (depending on the x-ray, the line 
can be chosen individually, e.g. acetabulum, ischium).
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Step 6 – Measure Distances and Angles

The measuring of distances and angles is described in chapter »Working with IMPAX Orthopaedic Tools«, sections 
»Measure Distance« and »Measure Angle«.

The procedure to insert the planning information is described in chapter »Hip - Manual Planning«, »Step 20 – 
Insert Planning Information«.

Step 7 – Insert Planning Information
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Basics

The Knee module is used for the planning of knee prostheses on both legs, as well as for x-rays containing both 
legs.

During the planning process, you can determine and correct any axial deformities or malalignments. This way, you 
can assess the correction of power transmission for the whole leg preoperatively and postoperatively. The result is 
an improved durability of the knee prosthesis. If using partial images only showing the knee, you can insert pros-
theses in order to determine the correct prosthesis size.

For determination of axes and angles as well as correction of any deformities, IMPAX Orthopaedic Tools offers an 
automatic correction method. It requires a long leg image in standing position. After determining joint centers, 
knee base lines and anatomical axes, IMPAX Orthopaedic Tools automatically displays the mechanical axes, the 
centerline and all relevant angles.

Automatic correction method:
By drawing 2 knee base lines, the malalignment (offset of the knee joint centers) can be determined and corrected. 
IMPAX Orthopaedic Tools automatically corrects the malalignment and calculates the mechanical axes and angles 
and to be expected postoperatively.

Manual correction:
By manually determining the correction, the deformities of axes, center line and angles are corrected by rotating 
the femur or tibia. During the simulation, the physician can permanently check and adjust all displayed values 
according to his preferences.

CAUTION
You can calculate axial malalignment correctly only if the images used for planning fulfill the follow-
ing requirements:

•	 AP image showing one or both legs, taken in standing position with equal weight dis-
tribution on both legs

•	 Hip and ankle joints must be fully visible
•	 Reference object placed on longitudinal femur axis level

Due to missing hip and ankle joint centers, partial knee images should be only used as an exception.

Further Information

If an existing planning is already loaded when 
opening this module containing elements pre-
viously drawn in other modules, you will be 
prompted to assign those elements to a spe-
cific body side. Please check the information 
carefully and confirm the respective body side.

This information is required so that IMPAX Or-
thopaedic Tools can perform a proper assign-
ment and use the existing elements for the 
further planning on both sides.

Afterwards, you can begin with/continue 
drawing elements.

Assign Existing Elements to Body Side
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Workflow Step by Step

Step 1 – Insert & Scale Images

In order to perform a knee planning:

1.	 Load/import image as described in »Importing Images«.
2.	 Scale image as described in »Scaling Images«.
3.	 In the module overview, select the Knee module.

WARNING
Images can only be properly scaled, if a reference object (sphere or scale bar) with dimensions 
known to the user is placed in the image region, close to and at the level of the joint/bone 
area you are interested in, when recording the image. Please verify the entered scaling size tho-
roughly, wrong input can lead to serious miscalculation. The original IMPAX Orthopaedic Tools 
sphere has a 25 mm diameter with a +/- 0.1 mm tolerance. When using other reference objects, 
measure and tolerance of the respective manufacturer apply. Please pay extreme attention to 
the Image Requirements and Scaling Instructions at the end of this User Manual.

Select Body Side

When drawing additional/missing elements and throughout the whole plan-
ning you can always switch between both body sides. Please use the respec-
tive buttons of the Knee Tool.

Step 2 – Draw Outlines (optional)

If needed for your planning (e.g. for better highlighting), you can draw both femoral 
and tibial outlines. Outlines are not required for all further steps, the outline functions 
are hidden in the standard setting on setup. You can activate the outline functions by 
selecting menu item File > Settings > General, they will be available after restarting the 
program.

Requirements:
A scaled image.

Result:
The femoral outline or the tibial outline is drawn by clicking on intermediate points on 
the bone outline.

NOTE
To reject points, use the button Reject last point or use the Backspace key. Each click or keystroke 
rejects one point. Afterwards, continue drawing the outline.
In case you forget a part of the outline, return to the function femoral outline and add the missing 
lines in the same way as described above. Plase make sure that the option Group by → Femoral 
outline AP is activated.

You are in the outline tool. After selecting contour type as well as the line color and line 
width, successively click on one point after another along the bone outline. The spline 
function requires less intermediate points for straight lines than for curves.

In order to draw the femoral outline:

1.	 Define the first point of the femoral outline.
2.	 Define the next point/s of the outline.
3.	 With a right click of the mouse, end the drawing of the outline.
4.	 With another right click of the mouse, exit the contour tool.
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CAUTION
The tibial outline is drawn in the same way, but using the function Tibial outline instead.

By activating the respective function, a distinguishment between femoral and tibial outlines can 
be made. In case both outlines are drawn using the same function, the femur can not be rotated 
against the tibia.

The complete planning can also be performed without using outlines. After defining all joint centers as well as the 
anatomical and mechanical axes, the correction is automatically displayed on a corrected x-ray image. The postop-
erative situation of the axes and the respective resection lines are visible. 

In order to define the HJC with a circle by 3 points:

1.	 Define the first point.
2.	 Define the second point.
3.	 A circle with diameter in mm is displayed. Define the third point.
4.	 The hip joint center is drawn.

Step 3 – Define Hip Joint Center (HJC)

Step 3a – Define HJC with Circle by 3 Points

Step 3b – Define HJC with CCD Angle

Requirements:
A scaled image.

You have the following 3 options to define the HJC: Circle by 3 points, CCD angle, Free. They are described below:

Result: 
A circle by 3 points is drawn, the circle and the diameter in mm are shown 
for a quick moment, the hip joint center is drawn.

After selecting the line color and line width, start drawing the circle.

Result:
Using the function FSA (femoral shaft axis) by 4 points, the CCD angle and 
the hip joint center are drawn.

After selecting the line color and line width, start drawing the anatomical 
FSA (femoral shaft axis).

Optionally, you can use the function tool to define/select the required angle size: Default (130°/84°), Child 
(140°/90°), Adult (128°/90°), Senior (115°/90°) oder Custom.

NOTE:
Please use this option only in cases where the femoral head 
is not or not clearly visible.
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In order to define the HJC by drawing the CCD angle:

1.	 Define the first point.
2.	 Define the second point, which has to be opposite of the first point.
3.	 Define the third point.
4.	 Define the fourth point, which has to be opposite of the third point.
5.	 Place the angle in a way that the upper leg of the displayed angle touches the tip of the greater 

trochanter and the other leg of the angle runs through the center of the femoral neck. The mouse 
cursor defines the hip joint center.

6.	 The hip joint center is drawn. Also, femoral shaft axis and femoral neck axis as well as the trochanter 
line are drawn.

Step 3c – Define HJC Freely

Step 4 – Define Greater Trochanter

Requirements:
HJC is drawn.

Result:
A connecting line between hip joint center and the most cranial point of 
the greater trochanter is drawn. The direction of this line defines the body 
side for the program.

In order to define and draw the greater trochanter:

1.	 Define the most cranial point of the greater trochanter (trochanter major).
2.	 The connecting line is drawn, the body side is defined.

You are in the function Greater Trochanter. After selecting the line color and line width, draw the connecting line. 
The starting point of the line is automatically the hip joint center.

Step 5 – Define Femoral Knee Base

Requirements:
A scaled image.

Result:
A base line tangential to the distal femur condyles is drawn. By placing 2 
automatic perpendicular lines at the lateral and medial condyles, the fem-
oral knee base center is determined.

You are in the function Knee Base Femur. After selecting the line color and line width, start drawing the tangential 
line at the distal femur condyles (points 1 and 2).

Result: 
Using this function, the HJC is defined freely.

After selecting point color/type and line width, define the HJC freely.

In order to define and draw the HJC freely:

1.	 Place the point on the determined position.
2.	 The hip joint center is drawn.
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In order to define the femoral knee base:

1.	 Define the first of two base points, the lateral or medial femur condyle.
2.	 Define the second of two base points, the opposite femur condyle.
3.	 The femoral base line is drawn, a perpendicular line appears automatically. Move the mouse up-

wards and place the first of two tangents at the lateral or medial condyle.
4.	 Place the second of two tangents at the opposite condyle. The femoral knee base center is already 

displayed and changes when moving the mouse.
5.	 The femoral knee base line and knee base center are drawn.

Step 6 – Define Tibial Knee Base

Requirements:
A scaled image.

Result:
A base line tangential to the tibia condyles is drawn. By placing 2 automat-
ic perpendicular lines at the lateral and medial condyles, the tibial knee 
base center is determined (alternatively, you can use the eminentia).

You are in the function Knee Base Tibia. After selecting the line color and line width, start drawing the tangential 
line at the proximal tibia condyles (points 1 and 2).

Step 7 – Define Ankle Joint Base

Requirements:
Hip joint center (HJC) as well as 
femoral and tibial knee base center 
are defined.

Result:
The ankle joint base line and center 
are drawn and displayed.

In order to define the tibial knee base:

1.	 Define the first of two base points, the lateral or medial tibia condyle.
2.	 Define the second of two base points, the opposite tibia condyle.
3.	 The femoral base line is drawn, a perpendicular line appears automatically. Move the mouse down-

wards and place the first of two tangents at the lateral or medial condyle.
4.	 Place the second of two tangents at the opposite condyle. The tibial knee base center is already 

displayed and changes when moving the mouse.
5.	 The tibial knee base line and knee base center are drawn.

You are in the function Ankle Joint Base. After selecting the line color and line width, start drawing the tangential 
line (points 1 and 2).

In order to define the ankle joint base:

1.	 Define the first of two base points, the lateral or medial talus.
2.	 Define the second of two base points, the opposite lateral/medial talus.
3.	 The ankle joint base line is drawn, a perpendicular line appears automatically. Move the mouse 

downwards and place the first of two tangents at the medial or lateral talus.
4.	 Place the second of two tangents at the opposite talus. The ankle joint base center is already dis-

played and changes when moving the mouse.
5.	 The ankle joint base line and center are drawn.
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Step 8 – Define Femoral Shaft Axis / Tibia Shaft Axis

Requirements:
Hip, knee and ankle joint centers are drawn.

Result:
Both anatomical axes are displayed in a preview graphic. They form the basis of the 
preoperative situation of all axes.

Auxiliary lines provide support for drawing the anatomical axes. Then divide the dis-
tance from hip joint center (HJC) to femoral knee base into 3 equal sections. The 
same goes for the distance from the tibial knee base to the ankle joint base. 

They can be selected in pairs on the femur or tibia. The anatomical axes are formed 
by the centerline of the points 1-2 and 3-4 on the outer corticalis.

FSA TSA

The procedure is the same for both axes. Select one of the two functions and draw the selected axis. Subsequent-
ly, draw the second axis. You are in the function Femoral Shaft Axis. Select the line color and line width before 
drawing the axis.

In order to define and draw the femoral shaft axis:

1.	 Select point 1.
2.	 Select point 2.
3.	 Select point 3.
4.	 Select point 4.
5.	 The femoral shaft axis is automatically drawn.

Now, repeat the procedure on the tibia using the function Tibia Shaft Axis.

Step 9 – Preoperative Dimensions / Display Preoperative Axis Situation

Requirements:
All joint centers must be drawn, optionally both anatomical axes.

Result:
All preoperative mechanical axes, the centerline as well as all angles and lengths are automatically displayed in a 
preview.
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Scheme and abbreviations:

m	 mechanical
a	 anatomical
L	 lateral
M	 medial
D	 distal
P	 proximal
F	 femur
T	 tibia
A	 angle

NSA	 Neck Shaft Angle (CCD Angle) 
KJL-F	 Knee Joint Line – Femur
	 (proximal knee base)
KJL-T	 Knee Joint Line – Tibia
	 (distal knee base)
JLCA	 Joint Line Conversion Angle
	 (Angle between KJL-F and KJL-T)
AMA	 Anatomical Mechanical Angle 

(Angle between anatomical and 
mechanical axis)

MAD	 Mechanical Axis Deviation

The nomenclature of all values by "Dror Paley Standard Measurements"
"Glossary and Deformity Correction Principles". Gaslini 29:1 (1997) 5-9

Normal values overview
(For a description of the normal values, see Paley, Dror: Principles of Deformity Correction 2002)

Current preoperative measurements

no (N)   = normal value
(> N)      = above normal
(< N)      = below normal
Mikulicz = centerline
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Activate the function Preoperative Knee Dimen-
sions. By default, the preoperative graphic with 
all relevant measurements and dimensions is 
placed over the original image. However, you can 
select the option Move Dimensions in the knee 
tool. By doing so, the preoperative graphic is au-
tomatically attached to the mouse cursor, you can 
place it at the desired position. 

The preoperative dimensions are applied simulta-
neously for both sides. Values in the normal area 
are shown in green color, values outside the nor-
mal area in red color. All other elements/texts are 
displayed in the color selected in the knee tool. 
Additionally, you can find a comparison/assess-
ment of both sides below the preoperative di-
mensions (e.g. leg length difference, heel height 
difference, height of the hip joint center).

NOTE
The preoperative dimensions are a part of your planning, they are required for further assessment, 
surgical decisions and documentation purposes.
Place the preoperative graphic at a position that won't interfere with the upcoming plannings, ide-
ally at the left of the x-ray image so that there is enough room at the right for the preview graphics.
The previews can be either displayed or left out.

Step 10 – Knee Adjustment

Requirements:
Drawn joint centers.

Result:
The axis corrections are either done automatically by 
the program, or can be performed manually by several 
options. The result is displayed and can be placed on 
the desired position.

The knee joint centers are on the centerline. The cen-
terline is identical to the mechanical axes. The overall 
length of the centerline (Mikulicz) is determined and 
displayed automatically. All relevant values are dis-
played.

CAUTION
Always draw resection lines and per-
form measurements on the original, 
never on a preview.



159

IMPAX Orthopaedic Tools» Table of Contents «

» Table of Contents «

Knee

You can now perform the knee adjustment on one or both sides. The body side selected in the knee tool is visual-
ized by a dashed marking line. This way you always know in which part of the image you have to perform the next 
step. You can switch between sides as needed.

In order to perform the knee adjustment:

1.	 Activate the function Knee Adjustment. The corrected, finished preview is automatically attached 
to the mouse cursor.

2.	 Place the preview graphic on a suitable position, in a sufficient distance to the original.
3.	 Confirm the correction as final by using the Enter key. 

An alternative right click of the mouse opens a pop-up context menu: 
Apply: Applies the correction without changes. 
Reject: Cancels the function without showing the preview. 
Move preview: Moves/repositions the preview. 
Back: Allows selecting/changing of the correction method.

4.	 The adjustment is completed and displayed.

NOTE
If you want to work on a planning created with a previous version of IMPAX Orthopaedic Tools and 
containing a drawn ligament, you can also perform a knee adjustment with ligament correction. This 
procedure  however isn't described herein and is available for reasons of compatibility only.

You are in the Knee Adjustment Tool. The following options are available:

The displayed preview is automatically aligned on the screen in order for 
the centerline to be perpendicular to the knee base line.

The Hip Alignment is performed automatically with regard to the select-
ed option (Horizontal, Manual, Original or Reference Line, if previously 
drawn).

In order to manually change the preview, use the selection list and choose 
the function you want to use for manual correction. The various options 
are described below.

The distance of the resection line for the distal femur and the proximal 
tibia can be adjusted manually.

You can define, if the resection is to be performed on the centerline, the 
MTA or the MFA (in a predefined angle of 90°+a)

WARNING
For each changed resection line and each new preview, 
a new pair of resection lines is created on the original 
once you click the Apply button. In order to avoid any 
mix-ups, we recommend deleting all lines on the orig-
inal that are no longer necessary. The preoperative 
tibial and femoral base lines must however remain, as 
they are necessary for the calculations.

Rotate femur
Activate this function, click with the mouse cursor at any position within or outside of the femoral outline. Rotate 
the femur by moving the mouse. The tibial outline remains at the same position. The femoral outline moves and 
the displayed values are changing at the same time. A click of the mouse defines and confirms the new position. 
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Confirm as final using the Enter key or use the pop-up context menu with a right click of the mouse to Apply or 
return to the Knee Tool or Reject the preview and return to the Knee Adjustment function.

Rotate tibia
Activate this function, click with the mouse cursor at any position within or outside of the tibial outline. Rotate 
the tibia by moving the mouse. The femoral outline remains at the same position. The tibial outline moves and 
the displayed values are changing at the same time. A click of the mouse defines and confirms the new position. 
Confirm as final using the Enter key or use the pop-up context menu with a right click of the mouse to Apply or 
return to the Knee Tool or Reject the preview and return to the Knee Adjustment function.

Change malalignment
Activate this function, click with the mouse cursor at any position within or outside of the outline and move the 
mouse. Femur and tibia do not rotate. The malalignment changes, both knee base centers are moved against each 
other. The position of the centerline remains the same. A click of the mouse defines and confirms the new positi-
on. Confirm as final using the Enter key or use the pop-up context menu with a right click of the mouse to Apply 
or return to the Knee Tool or Reject the preview and return to the Knee Adjustment function.

Move centerline (default)
Activate this function, click with the mouse cursor at any position within or outside of the outline and move the 
mouse. Femur and tibia are rotated against each other. The centerline is moved accordingly. Both knee base 
centers change the relative position against each other. At the same time, all displayed values reflect the changes 
made when moving the mouse. A click of the mouse defines and confirms the new position. Confirm as final using 
the Enter key or use the pop-up context menu with a right click of the mouse to Apply or return to the Knee Tool 
or Reject the preview and return to the Knee Adjustment function.

Move preview (same as the general copy/move function)
Activate this function, click with the mouse cursor at any position within or outside of the outline. With a right click 
of the mouse, end selection. With a left click of the mouse, pick up the preview and move it to the desired position. 
A click of the mouse defines and confirms the new position. Confirm as final using the Enter key or use the pop-up 
context menu with a right click of the mouse to Apply or return to the Knee Tool or Reject the preview and return 
to the Knee Adjustment function. 

Rotate hip (only for dualside plannings)
Activate this function, click with the mouse cursor at any position within or outside of the outline and move the 
mouse. By moving the mouse, the position of the pelvis changes, as well as the position of the leg opposite of the 
leg where the knee adjustment was performed. No values are changed. A click of the mouse defines and confirms 
the new position. Confirm as final using the Enter key or use the pop-up context menu with a right click of the 
mouse to Apply or return to the Knee Tool or Reject the preview and return to the Knee Adjustment function.

Step 11 – Insert Prostheses

Requirements:
A completed knee adjustment.

Result:
Using the function Insert Prostheses, you can select the man-
ufacturer, type, size and other properties of femur and tibia 
components and place the cup on the required position in 
the required inclination.

WARNING
All dimensions and measurements given by the IMPAX Orthopaedic Tools prosthesis database 
derived from original manufacturer data or templates. If you suspect that the data is not cor-
rect, please report it to Agfa‘s service representative or contact Agfa using the contact infor-
mation provided in the beginning of this manual.
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You can also open this function at any time by using the Select Size (Shaft/Head/..) icon of the toolbar.

After selecting the function, you are in the Implant/template tool, the prosthesis used last is attached to the 
mouse cursor, freely moveable in the work area.

After selecting the line color, line width as well as the body side, consecutively select the desired manufacturer, 
the prosthesis type, prosthesis size and all other properties. The prosthesis attached to the mouse cursor changes 
accordingly. Further info about inserting implants can be found at »Inserting Implants«.

In order to insert a femur or tibia component:

1.	 The prosthesis appears on the mouse. By using the cursor keys ← and →, you can adjust the 
inclination of the prosthesis. The angle in ° is displayed in the Angle field of the implant/template 
tool. In capture mode Free you can place the prosthesis anywhere in the image. Using the key P, 
the capture mode for a Point is activated, e.g. the hip joint center. If you approve of size/position/
angle, place the prosthesis.

2.	 As long as the prosthesis is not confirmed as final, you can always pick it up again and move or modi-
fy it. You can change the size by using the cursor keys ↓ and ↑ after selecting the respective column 
of the menu list or the respective fly out menu.

3.	 With a right click of the mouse, confirm the prosthesis as final.
4.	 The prosthesis is inserted.

Requirements:
Correctly inserted femur and/or tibia component.

Result:
Select the appropriate inlay from the complete range of inlays.

Step 12 – Select Inlay

WARNING
All dimensions and measurements given by the IMPAX Orthopaedic Tools prosthesis database 
derived from original manufacturer data or templates. If you suspect that the data is not cor-
rect, please report it to Agfa‘s service representative or contact Agfa using the contact infor-
mation provided in the beginning of this manual.

In order to select an inlay:

1.	 Select the desired inlay with a click of the mouse. You can click on the displayed inlay sizes as well as 
the lines towards the inlay or the inlay itself.

2.	 The selection can be changed/modified by another click of the mouse at any time.
3.	 A right click of the mouse ends the inlay selection.
4.	 The inlay is selected, the tibia/femur component updated.
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Step 13 – Measure Distances and Angles

The measuring of distances and angles is described in chapter »Working with IMPAX Orthopaedic Tools«, sections 
»Measure Distance« and »Measure Angle«.

Step 14 – Insert Osteosynthesis Components

The procedure to insert plates, nails and screws is the same as the procedure to insert implants.

The procedure to insert the planning information is described in chapter »Hip - Manual Planning«, »Step 20 – 
Insert Planning Information«.

Step 15 – Insert Planning Information
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Basics

Further Information

The module Osteotomy allows you to plan femoral or tibial corrections of deformities / corrective osteotomies.
Axial malalignment can be determined and corrected during the planning process. Osteotomies can be performed 
simultaneously on both legs or on x-rays containing both legs, as well as on one side only or on images containing 
only one leg.

If the physician decides to perform a corrective osteotomy instead of using an endoprosthesis, this module pro-
vides the tools to perform an osteotomy on the proximal tibia or distal femur or an intertrochanteric osteotomy. 
Osteotomies with multiple cuts of the femur or tibia can be performed as well.

The size of the correction angle is either determined automatically by IMPAX Orthopaedic Tools in regards to the 
optimal position of the axes, or manually by the physician by defining all angles and results using manual planning 
functions. A wide range of osteosynthesis components, e.g. nails, plates, screws, etc., can be selected from the 
database.

NOTE
As the centerline and the mechanical axes cannot be determined properly, partial images are not 
suitable for conducting a proper Osteotomy

If an existing planning is already loaded when 
opening this module containing elements pre-
viously drawn in other modules, you will be 
prompted to assign those elements to a spe-
cific body side. Please check the information 
carefully and confirm the respective body side.

This information is required so that IMPAX Or-
thopaedic Tools can perform a proper assign-
ment and use the existing elements for the 
further planning on both sides.

Afterwards, you can begin with/continue 
drawing elements.

Assign Existing Elements to Body Side

Select Body Side

When drawing additional/missing elements and throughout the whole plan-
ning you can always switch between both body sides. Please use the respec-
tive buttons of the Osteotomy Tool.
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Workflow Step by Step

Step 1 – Insert & Scale Images

In order to perform an osteotomy:

1.	 Load/import image as described in »Importing Images«.
2.	 Scale image as described in »Scaling Images«.
3.	 In the module overview window, select the Osteotomy module.

WARNING
Images can only be properly scaled, if a reference object (sphere or scale bar) with dimensions 
known to the user is placed in the image region, close to and at the level of the joint/bone 
area you are interested in, when recording the image. Please verify the entered scaling size tho-
roughly, wrong input can lead to serious miscalculation. The original IMPAX Orthopaedic Tools 
sphere has a 25 mm diameter with a +/- 0.1 mm tolerance. When using other reference objects, 
measure and tolerance of the respective manufacturer apply. Please pay extreme attention to 
the Image Requirements and Scaling Instructions at the end of this User Manual.

Step 2 – Draw Outlines (optional)

If needed for your planning (e.g. for better highlighting), you can draw both femoral 
and tibial outlines. Outlines are not required for all further steps, the outline functions 
are hidden in the standard setting on setup. You can activate the outline functions by 
selecting menu item File > Settings > General, they will be available after restarting the 
program.

Requirements:
A scaled image.

Result:
The femoral outline or the tibial outline is drawn by clicking on intermediate points on 
the bone outline.

You are in the outline tool. After selecting contour type as well as the line color and line width, successively click on 
one point after another along the bone outline. The spline function requires less intermediate points for straight 
lines than for curves.

In order to draw the femoral outline:

1.	 Define the first point of the femoral outline.
2.	 Define the next point/s of the outline.
3.	 With a right click of the mouse, end the drawing of the outline.
4.	 With another right click of the mouse, exit the contour tool.

NOTE
To reject points, use the button Reject last point or use the Backspace key. Each click or keystroke 
rejects one point. Afterwards, continue drawing the outline.
In case you forget a part of the outline, return to the function femoral outline and add the missing 
lines in the same way as described above. Plase make sure that the option Group by → Femoral 
outline AP is activated.
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CAUTION
The tibial outline is drawn in the same way, but using the function Tibial outline instead.

By activating the respective function, a distinguishment between femoral and tibial outlines can 
be made. In case both outlines are drawn using the same function, the femur can not be rotated 
against the tibia.

The complete planning can also be performed without using outlines. After defining all joint centers as well as the 
anatomical and mechanical axes, the correction is automatically displayed on a corrected x-ray image. The postop-
erative situation of the axes and the respective resection lines are visible. 

Step 3 – Define Hip Joint Center (HJC)

Step 3a – Define HJC with Circle by 3 Points

Requirements:
A scaled image.

You have the following 3 options to define the HJC: Circle by 3 points, CCD angle, Free. They are described in detail 
below:

Result: 
A circle by 3 points is drawn, the circle and the diameter in mm are shown 
for a quick moment, the hip joint center is drawn.

After selecting the line color and line width, start drawing the circle.

In order to define the HJC with a circle by 3 points:

1.	 Define the first point.
2.	 Define the second point.
3.	 A circle with diameter in mm is displayed.
4.	 The hip joint center is drawn.

Step 3b – Define HJC with CCD Angle

Result:
Using the function FSA (femoral shaft axis) by 4 points, the CCD angle and 
the hip joint center are drawn.

After selecting the line color and line width, start drawing the anatomical 
FSA (femoral shaft axis).

Optionally, you can use the function tool to define/select the required angle size: Default (130°/84°), Child 
(140°/90°), Adult (128°/90°), Senior (115°/90°) oder Custom.

NOTE:
Please use this option only in cases where the femoral head 
is not or not clearly visible.
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In order to define the HJC by drawing the CCD angle:

1.	 Define the first point.
2.	 Define the second point, which has to be opposite of the first point.
3.	 Define the third point.
4.	 Define the fourth point, which has to be opposite of the third point.
5.	 Place the angle in a way, that the upper leg of the displayed angle touches the tip of the greater 

trochanter and the other leg of the angle runs through the center of the femoral neck. The mouse 
cursor defines the hip joint center.

6.	 The hip joint center is drawn. Also, femoral shaft axis and femoral neck axis as well as the trochanter 
line are drawn.

Step 3c – Define HJC Freely

Step 4 – Define Greater Trochanter

Requirements:
HJC is drawn.

Result:
A connecting line between hip joint center and the most cranial point of 
the greater trochanter is drawn. The direction of this line defines the body 
side for the program.

Result: 
Using this function, the HJC is defined freely.

After selecting point color/type and line width, define the HJC freely.

In order to define and draw the HJC freely:

1.	 Place the point on the determined position.
2.	 The hip joint center is drawn.

In order to define and draw the greater trochanter:

1.	 Define the most cranial point of the greater trochanter (trochanter major).
2.	 The connecting line is drawn, the body side is defined.

You are in the function Greater Trochanter. After selecting the line color and line width, draw the connecting line. 
The starting point of the line is automatically the hip joint center.

Step 5 – Define Femoral Knee Base

Requirements:
A scaled image.

Result:
A base line tangential to the distal femur condyles is drawn. By placing 2 
automatic perpendicular lines at the lateral and medial condyles, the fem-
oral knee base center is determined.

You are in the function Knee Base Femur. After selecting the line color and line width, start drawing the tangential 
line at the distal femur condyles (points 1 and 2).
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Step 6 – Define Tibial Knee Base

In order to define the femoral knee base:

1.	 Define the first of two base points, the lateral or medial femur condyle.
2.	 Define the second of two base points, the opposite femur condyle.
3.	 The femoral base line is drawn, a perpendicular line appears automatically. Move the mouse up-

wards and place the first of two tangents at the lateral or medial condyle.
4.	 Place the second of two tangents at the opposite condyle. The femoral knee base center is already 

displayed and changes when moving the mouse.
5.	 The femoral knee base line and knee base center are drawn.

Requirements:
A scaled image.

Result:
A base line tangential to the tibia condyles is drawn. By placing 2 automatic 
perpendicular lines at the lateral and medial condyles, the tibial knee base 
center is determined (alternatively, you can use the eminentia).

You are in the function Knee Base Tibia. After selecting the line color and line width, start drawing the tangential 
line at the proximal tibia condyles (points 1 and 2).

In order to define the tibial knee base:

1.	 Define the first of two base points, the lateral or medial tibia condyle.
2.	 Define the second of two base points, the opposite tibia condyle.
3.	 The femoral base line is drawn, a perpendicular line appears automatically. Move the mouse down-

wards and place the first of two tangents at the lateral or medial condyle.
4.	 Place the second of two tangents at the opposite condyle. The tibial knee base center is already 

displayed and changes when moving the mouse.
5.	 The tibial knee base line and knee base center are drawn.

Step 6a – Define Tibial Knee Base with Fujisawa Point

Requirements:
A scaled image.

Result:
A base line tangential to the tibia condyles is drawn. The Fujisawa Point 
(62% on the mediolateral tibial plateau) is drawn.

You are in the function Knee Base Tibia with Fujisawa Point. After select-
ing the line color and line width, start drawing the tangential line at the 
proximal tibia condyles (points 1 and 2).

In order to define the tibial knee base with Fujisawa Point:

1.	 Define the first of two base points, the lateral or medial tibia condyle.
2.	 Define the second of two base points, the opposite tibia condyle.
3.	 The femoral base line is drawn, a perpendicular line appears automatically. Move the mouse down-

wards and place the first of two tangents at the lateral or medial condyle.
4.	 Place the second of two tangents at the opposite condyle. The tibial knee base center as well as the 

Fujisawa Point are already being displayed and change when moving the mouse.
5.	 The tibial knee base line and knee base center as well as the Fujisawa Point are drawn.
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Step 7 – Define Ankle Joint Base

Requirements:
Hip joint center (HJC) as well as 
femoral and tibial knee base center 
are defined.

Result:
The ankle joint base line and center 
are drawn and displayed.

You are in the function Ankle Joint Base. After selecting the line color and line width, start drawing the tangential 
line (points 1 and 2).

In order to define the ankle joint base:

1.	 Define the first of two base points, the lateral or medial talus.
2.	 Define the second of two base points, the opposite lateral/medial talus.
3.	 The ankle joint base line is drawn, a perpendicular line appears automatically. Move the mouse-

downpwards and place the first of two tangents at the medial or lateral talus.
4.	 Place the second of two tangents at the opposite talus. The ankle joint base center is already dis-

played and changes when moving the mouse.
5.	 The ankle joint base line and center are drawn.

Requirements:
Hip, knee and ankle joint centers are drawn.

Result:
Both anatomical axes are displayed in a preview graphic. They form the basis of the 
preoperative situation of all axes.

Auxiliary lines provide support for drawing the anatomical axes. Then divide the dis-
tance from hip joint center (HJC) to femoral knee base into 3 equal sections. The same 
goes for the distance from the tibial knee base to the ankle joint base. 

They can be selected in pairs on the femur or tibia. The anatomical axes are formed by 
the centerline of the points 1-2 and 3-4 on the outer corticalis.

Step 8 – Define Femoral Shaft Axis / Tibia Shaft Axis

FSA TSA
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The procedure is the same for both axes. Select one of the two functions and draw the selected axis. Subsequently, 
draw the second axis. You are in the function Femur Shaft Axis. Select the line color and line width before drawing 
the axis.

In order to define and draw the femoral shaft axis:

1.	 Select point 1.
2.	 Select point 2.
3.	 Select point 3.
4.	 Select point 4.
5.	 The femoral shaft axis is automatically drawn.

Now, repeat the procedure on the tibia using the function Tibia Shaft Axis.

Step 9 – Preoperative Dimensions / Display Preoperative Axis Situation

Requirements:
All joint centers must be drawn, optionally both anatomical axes.

Result:
All preoperative mechanical axes, the centerline as well as all angles and lengths are automatically displayed in a 
preview.

Scheme and abbreviations:

m	 mechanical
a	 anatomical
L	 lateral
M	 medial
D	 distal
P	 proximal
F	 femur
T	 tibia
A	 angle

NSA	 Neck Shaft Angle (CCD Angle) 
KJL-F	 Knee Joint Line – Femur
	 (proximal knee base)
KJL-T	 Knee Joint Line – Tibia
	 (distal knee base)
JLCA	 Joint Line Conversion Angle
	 (Angle between KJL-F and KJL-T)
AMA	 Anatomical Mechanical Angle 

(Angle between anatomical and 
mechanical axis)

MAD	 Mechanical Axis Deviation

The nomenclature of all values by "Dror Paley Standard Measurements"
"Glossary and Deformity Correction Principles". Gaslini 29:1 (1997) 5-9

Normal values overview
(For a description of the normal values, see Paley, Dror: Principles of Deformity Correction 2002)
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Current preoperative measurements

no (N)   = normal value
(> N)      = above normal
(< N)      = below normal
Mikulicz = centerline

Activate the function Preoperative Dimensions. By default, the preoperative graphic with all relevant measure-
ments and dimensions is placed over the original image. However, you can select the option Move Dimensions in 
the osteotomy tool. By doing so, the preoperative graphic is automatically attached to the mouse cursor, you can 
place it at the desired position. 

The preoperative dimensions are applied simultaneously for both sides. Values in the normal area are shown in 
green color, values outside the normal area in red color. All other elements/texts are displayed in the color select-
ed in the osteotomy tool. Additionally, you can find a comparison/assessment of both sides below the preopera-
tive dimensions (e.g. leg length difference, heel height difference, height of the hip joint center).
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NOTE
The preoperative dimensions are a part of your planning, they are required for further assessment, 
surgical decisions and documentation purposes.
Place the preoperative graphic at a position that won't interfere with the upcoming plannings, ide-
ally at the left of the x-ray image so that there is enough room at the right for the preview graphics.
The previews can be either displayed or left out.

Step 10 – Osteotomy (Basics)

Requirements:
All joint centers as well as both anatomical axes must be defined.

Result:
A preview simulating the osteotomy is displayed. The mechanical and anatomical axes are automatically drawn.

IMPAX Orthopaedic Tools calculates the resection angle automatically if possible, otherwise, an angle of 0° is 
displayed
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Step 10a – Osteotomy (Single Resection)

At this time, start with the base line.

You can now perform the osteotomy on one or both sides. The body side selected in the osteotomy tool is visual-
ized by a dashed marking line. This way you always know in which part of the image you have to perform the next 
step. You can switch between sides as needed. 

First, draw the base line for the resection on the desired position. It is your decision where to place the base line. 
Afterwards, IMPAX Orthopaedic Tools calculates and displays a preview of the optimal osteotomy. You can either 
accept the result, or determine the position of the centerline manually in another preview.

In order to perform an osteotomy (single resection):

1.	 Define the first point (1) of the base line.
2.	 Define the second point (2) of the base line.
3.	 An auxiliary line appears attached to the mouse cursor. Define the rotation center (3) of the resec-

tion angle. 
 
Depending on varus or valgus, the osteotomy is 
simulated via Open Wedge or Closed Wedge after 
defining the rotation center. 
 
In case of Closed Wedge: 
Point 3 above base line: 
The upper part of the image is overlapped. 
Point 3 below base line: 
The lower part of the image is overlapped. 
 
NOTE: 
A warning is displayed for resection 
angles larger than 60°. 
 
The preview of the osteotomy result is displayed attached to the mouse cursor. Place the preview 
on a suitable position, with a sufficient distance to the original. For a clear view, placing the pre-
view to the right of the original is recommended.

4.	 The preview is preliminarily placed. You can now: 
a) move the centerline 
b) move the rotation center 
     (even beyond the bone edge) 
c) move a part 
d) rotate the preview 
e) rotate the hip 
f) automatically adjust the preview on the basis of certain criteria

5.	 Confirm the osteotomy as final by using the Enter key. 
An alternative right click of the mouse opens a pop-up context menu: 
Apply: Confirms and applies preview and osteotomy without changes. 
Apply without preview: Confirms/applies the cut without the preview. 
Reject: Cancels the function without drawing the preview. 
Move preview: moves/repositions the preview. 
Back: Allows an adjustment of the osteotomy settings.

6.	 The osteotomy is performed and displayed.

CAUTION
Always draw resection lines and perform 
measurements on the original, never on a 
preview.
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NOTE
In order to work up the best result for the patient, you can place any number of previews in your planning, using 
different procedures and showing different results.

But:
CAUTION

In order to perform another resection at the same position, the previous resection must be delet-
ed on the original. After that, proceed to Step 10 again You can repeat this procedure as often as 
necessary.

You can perform an osteotomy with or without outlines. Sometimes, it is preferable to simulate an osteotomy with 
outlines. If that's the case, only draw the outline on the part required for the resection.  The outlines will then be 
displayed together with the preview.

Step 10b – Osteotomy (Double Resection)

Requirements:
All joint centers as well as both anatomical axes must be defined.

Result:
A preview simulating the double osteotomy is displayed. The me-
chanical and anatomical axes are automatically drawn.

IMPAX Orthopaedic Tools calculates the resection angle auto-
matically if possible, otherwise, an angle of 0° displayed

first osteotomy

second osteotomy
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CAUTION
For a double osteotomy, start with the first resection at the proximal femur. For a double osteoto-
my of the tibia, start with the first resetion at the distal tibia.
The reason for this is the rotation center of the mechanical axes. The longer the distance between 
the knee base line and the resection line, the shorter the rest of the axis and the bigger the angle.
Ridiculous angle sizes, e.g. 85°, might come up.

NOTE
All resections are performed on the x-ray only. If you draw on a preview by accident, an obvious-
ly absurd result is shown in the preview. IMPAX Orthopaedic Tools calculates the resection angle 
automatically if possible. If the angle is 0°, move the center line to a position allowing for a useful 
angle size.

First, draw the base line for the resection on the desired position. It is your decision where to place the base line.  
Afterwards, IMPAX Orthopaedic Tools calculates and displays a preview showing a suggestion of the most favor-
able osteotomy. Since this isn't possible in this case, IMPAX Orthopaedic Tools will indicate an angle of 0°.

After that, manually adjust the automatic osteotomy angle to the desired size. Pick up the preview on any desired 
point above the preview graphic in order to rotate it. Confirm and apply the first resection via the context menu, 
ideally without the preview.

Now, perform the second resection. The procedure is similar to the first resection. Again, a preview is displayed, 
attached to the mouse cursor. Place the preview at a suitable position, with sufficient distance to the original. The 
automatically calculated angle is displayed. This angle is also calculated automatically, in regards to the optimal 
position of the centerline and mechanical axes

Once you have preliminary placed the preview, you can move the centerline or the rotation center, rotate or move 
the preview or automatically adjust the preview on the basis of certain criteria.

Confirm the osteotomy as final using the Enter key, or use the pop-up context menu appearing after a right click of 
the mouse in order to confirm/apply the osteotomy with or without the preview, move or adjust the osteotomy, 
or cancel the function without drawing the preview.

The double osteotomy is now completed and displayed.

CAUTION
In order to proceed with the second resection, return to the original x-ray and place the second 
resection base line on the required position , e.g. intertrochanteric. Perform the second resection in 
the same way as the first resection.

NOTE
IMPAX Orthopaedic Tools will always attempt to determine the optimal position of the base line 
automatically, depending on the preoperative situation and the first resection.
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Step 11 – Measure Distances and Angles

The measuring of distances and angles is described in chapter »Working with IMPAX Orthopaedic Tools«, sections 
»Measure Distance« and »Measure Angle«.

Step 12 – Insert Osteosynthesis Components

Requirements:
A scaled image.

Result:
You can select the manufacturer, type, size and other properties of the prostheses to be inserted.

WARNING
All dimensions and measurements given by the IMPAX Orthopaedic Tools prosthesis database 
derived from original manufacturer data or templates. If you suspect that the data is not cor-
rect, please report it to Agfa‘s service representative or contact Agfa using the contact infor-
mation provided in the beginning of this manual.

After selecting the function, you are in the Implant/template tool, the prosthesis used last is attached to the 
mouse cursor, freely moveable in the work area.

After selecting the line color, line width as well as the body side, consecutively select the desired manufacturer, 
the prosthesis type, prosthesis size and all other properties. The prosthesis attached to the mouse cursor changes 
accordingly. Further info about inserting implants can be found at »Inserting Implants«.

In order to insert prostheses:

1.	 The prosthesis appears on the mouse. By using the cursor keys ← and →, you can adjust the 
inclination of the prosthesis. The angle in ° is displayed in the Angle field of the implant/template 
tool. In capture mode Free you can place the prosthesis anywhere in the image. Using the key P, 
the capture mode for a Point is activated, e.g. the hip joint center. If you approve of size/position/
angle, place the prosthesis.

2.	 As long as the prosthesis is not confirmed as final, you can always pick it up again and move or modi-
fy it. You can change the size by using the cursor keys ↓ and ↑ after selecting the respective column 
of the menu list or the respective fly out menu.

3.	 With a right click of the mouse, confirm the prosthesis as final.
4.	 The prosthesis is inserted.

The procedure to insert the planning information is described in chapter »Hip - Manual Planning«, »Step 20 – 
Insert Planning Information«.

Step 13 – Insert Planning Information
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Basics

The module Osteotomy by Dror Paley allows you to determine and correct one or multiple femoral or tibial de-
formities and malalignments. Osteotomies can be performed simultaneously on both legs or on x-rays containing 
both legs, as well as on one side only or on images containing only one leg.

The size of the correction angle is either determined automatically by IMPAX Orthopaedic Tools in regards to the 
optimal position of the axes, or manually by the physician by defining all angles and results using manual planning 
functions.

By analyzing the relative malalignment positions in both the AP and the sagittal view, the APEX  of the sagittal 
plane as well as the actual deformity angle can be calculated.

A wide range of osteosynthesis components, e.g. nails, plates, screws, etc., can be selected from the database.

Advantages:

•	 The actual axis situation is calculated automatically
•	 Simulations under different conditions can be displayed in one single planning, in order to reach the most 

optimal result for the patient
•	 Low effort and easy handling
•	 Femoral and tibial outlines only have to be drawn once for each planning, if required

Further Information

If an existing planning is already loaded when 
opening this module containing elements pre-
viously drawn in other modules, you will be 
prompted to assign those elements to a spe-
cific body side. Please check the information 
carefully and confirm the respective body side.

This information is required so that IMPAX Or-
thopaedic Tools can perform a proper assign-
ment and use the existing elements for the 
further planning on both sides.

Afterwards, you can begin with/continue 
drawing elements.

Assign Existing Elements to Body Side

Select Body Side

When drawing additional/missing elements and throughout the whole plan-
ning you can always switch between both body sides. Please use the respec-
tive buttons of the Osteotomy Tool.
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Workflow Step by Step

Step 1 – Insert & Scale Images

In order to perform an osteotomy:

1.	 Load/import image as described in »Importing Images«.
2.	 Scale image as described in »Scaling Images«.
3.	 In the module overview, select the Osteotomy by Dror Paley module.

WARNING
Images can only be properly scaled, if a reference object (sphere or scale bar) with dimensions 
known to the user is placed in the image region, close to and at the level of the joint/bone 
area you are interested in, when recording the image. Please verify the entered scaling size tho-
roughly, wrong input can lead to serious miscalculation. The original IMPAX Orthopaedic Tools 
sphere has a 25 mm diameter with a +/- 0.1 mm tolerance. When using other reference objects, 
measure and tolerance of the respective manufacturer apply. Please pay extreme attention to 
the Image Requirements and Scaling Instructions at the end of this User Manual.

CAUTION
Pay close attention to use the Frontal (AP) functions when working on images in AP view, and the 
Sagittal (ML) functions when working on images in sagittal view.

In general, all functions can be performed using the following options:

1.	 Outlines are completely drawn and images are shown
2.	 Outlines are partially drawn and images are shown
3.	 Images are hidden but outlines are completely or partially drawn
4.	 Images only are shown

WORKING WITH OR WITHOUT OUTLINES

Step 2 – Draw Outlines (optional)

If needed for your planning (e.g. for better highlighting), you can draw both femoral and tibial outlines. Outlines 
are not required for all further steps, the outline functions are hidden in the standard setting on setup. You can 
activate the outline functions by selecting menu item File > Settings > General, they will be available after restart-
ing the program.

Img. 1 Img. 4Img. 3Img. 2
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Requirements:
A scaled image.

Result:
The femoral outline or the tibial outline is drawn by clicking on intermediate points on 
the bone outline.

You are in the outline tool. After selecting contour type as well as the line color and line 
width, successively click on one point after another along the bone outline. The spline 
function requires less intermediate points for straight lines than for curves.

In order to draw the femoral outline:

1.	 Define the first point of the femoral outline.
2.	 Define the next point/s of the outline.
3.	 With a right click of the mouse, end the drawing of the outline.
4.	 With another right click of the mouse, exit the contour tool.

NOTE
To reject points, use the button Reject last point or use the Backspace key. Each click or keystroke 
rejects one point. Afterwards, continue drawing the outline.
In case you forget a part of the outline, return to the function femoral outline and add the missing 
lines in the same way as described above. Plase make sure that the option Group by → Femoral 
outline AP is activated.

CAUTION
The tibial outline is drawn in the same way, but using the function Tibial outline instead.
By activating the respective function, a distinguishment between femoral and tibial outlines can 
be made. In case both outlines are drawn using the same function, the femur can not be rotated 
against the tibia.

Workflow Step by Step (AP View)

Step 3 – Define Hip Joint Center (HJC)

Step 3a – Define HJC with Circle by 3 Points

Requirements:
A scaled image.

You have the following 3 options to define the HJC: Circle by 3 points, CCD angle, Free. They are described in detail 
below:

Result: 
A circle by 3 points is drawn, the circle and the diameter in mm are shown 
for a quick moment, the hip joint center is drawn.

After selecting the line color and line width, start drawing the circle.

In order to define the HJC with a circle by 3 points:

1.	 Define the first point.
2.	 Define the second point.
3.	 A circle with diameter in mm is displayed. Define the third point.
4.	 The hip joint center is drawn.
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Step 3b – Define HJC with CCD Angle

Result:
Using the function FSA (femoral shaft axis) by 4 points, the CCD angle and 
the hip joint center are drawn.

After selecting the line color and line width, start drawing the anatomical 
FSA (femoral shaft axis).

Optionally, you can use the function tool to define/select the required 
angle size: Default (130°/84°), Child (140°/90°), Adult (128°/90°), Senior 
(115°/90°) oder Custom.

NOTE:
Please use this option only in cases where the femoral head 
is not or not clearly visible.

Step 3c – Define HJC Freely

Step 4 – Define Greater Trochanter

Result: 
Using this function, the HJC is defined freely.

After selecting point color/type and line width, define the HJC freely.

In order to define and draw the HJC freely:

1.	 Place the point on the determined position.
2.	 The hip joint center is drawn.

Requirements:
HJC is drawn.

Result:
A connecting line between hip joint center and the most cranial point of 
the greater trochanter is drawn. The direction of this line defines the body 
side for the program.

You are in the function Greater Trochanter. After selecting the line color and line width, draw the connecting line. 
The starting point of the line is automatically the hip joint center.

In order to define the HJC by drawing the CCD angle:

1.	 Define the first point.
2.	 Define the second point, which has to be opposite of the first point.
3.	 Define the third point.
4.	 Define the fourth point, which has to be opposite of the third point.
5.	 Place the angle in a way, that the upper leg of the displayed angle touches the tip of the greater 

trochanter and the other leg of the angle runs through the center of the femoral neck. The mouse 
cursor defines the hip joint center.

6.	 The hip joint center is drawn. Also, femoral shaft axis and femoral neck axis as well as the trochanter 
line are drawn.
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Step 5 – Define Fossa Piriformis for Anatomical Axes

Requirements:
HJC is drawn.

Result:
The Fossa Piriformis is defined by drawing a point.

In order to define and draw the greater trochanter:

1.	 Define the most cranial point of the greater trochanter (trochanter major).
2.	 The connecting line is drawn, the body side is defined.

In order to draw the Fossa Piriformis:

1.	 Define the Fossa Piriformis by drawing a point.
2.	 The Fossa Piriformis is defined.

You are in the function Fossa Piriformis (for aMPFA). After selecting the 
line color and line width, define the Fossa Piriformis.

When using the function Axes by Dror Paley, the axes aMPFA and aLDFA can now be automatically calculated and 
drawn.

Step 6 – Define Femoral Knee Base

Step 7 – Define Tibial Knee Base

Requirements:
A scaled image.

Result:
A base line tangential to the distal femur condyles is drawn. By placing 2 
automatic perpendicular lines at the lateral and medial condyles, the fem-
oral knee base center is determined.

You are in the function Knee Base Femur. After selecting the line color and line width, start drawing the tangential 
line at the distal femur condyles (points 1 and 2).

In order to define the femoral knee base:

1.	 Define the first of two base points, the lateral or medial femur condyle.
2.	 Define the second of two base points, the opposite femur condyle.
3.	 The femoral base line is drawn, a perpendicular line appears automatically. Move the mouse up-

wards and place the first of two tangents at the lateral or medial condyle.
4.	 Place the second of two tangents at the opposite condyle. The femoral knee base center is already 

displayed and changes when moving the mouse.
5.	 The femoral knee base line and knee base center are drawn.

Requirements:
A scaled image.

Result:
A base line tangential to the tibia condyles is drawn. By placing 2 automatic 
perpendicular lines at the lateral and medial condyles, the tibial knee base 
center is determined (alternatively, you can use the eminentia).
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You are in the function Knee Base Tibia. After selecting the line color and line width, start drawing the tangential 
line at the proximal tibia condyles (points 1 and 2).

In order to define the tibial knee base:

1.	 Define the first of two base points, the lateral or medial tibia condyle.
2.	 Define the second of two base points, the opposite tibia condyle.
3.	 The femoral base line is drawn, a perpendicular line appears automatically. Move the mouse down-

wards and place the first of two tangents at the lateral or medial condyle.
4.	 Place the second of two tangents at the opposite condyle. The tibial knee base center is already 

displayed and changes when moving the mouse.
5.	 The tibial knee base line and knee base center are drawn.

Step 8 – Define Ankle Joint Base

Requirements:
Hip joint center (HJC) as well as 
femoral and tibial knee base center 
are defined.

Result:
The ankle joint base line and center 
are drawn and displayed.

You are in the function Ankle Joint Base. After selecting the line color and line width, start drawing the tangential 
line (points 1 and 2).

In order to define the ankle joint base:

1.	 Define the first of two base points, the lateral or medial talus.
2.	 Define the second of two base points, the opposite lateral/medial talus.
3.	 The ankle joint base line is drawn, a perpendicular line appears automatically. Move the mouse 

downwards and place the first of two tangents at the medial or lateral talus.
4.	 Place the second of two tangents at the opposite talus. The ankle joint base center is already dis-

played and changes when moving the mouse.
5.	 The ankle joint base line and center are drawn.

Step 9 – Define Femoral Shaft Axis

Requirements:
Hip and knee joint centers are drawn.

Result:
The femur shaft axis is displayed in a preview graphic. It forms 
the basis of the preoperative situation of all axes.

Auxiliary lines provide support for drawing the anatomical 
axes. Then divide the distance from hip joint center (HJC) to 
femoral knee base into 3 equal sections. The same goes for 
the distance from the tibial knee base to the ankle joint base. 

They can be selected in pairs (e.g. like in the sequence 1-4 
shown above) on the femur or tibia. The anatomical axes are 
formed by the centerline of the points 1-2 and 3-4 on the 
outer corticalis.
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You are in the function FSA (for AMA). Select the line color and line width before drawing the axis. Points 1 thru 4  
are the intersection points of the auxiliary lines and the femoral edge or drawn femoral outline.

Step 10 – Preoperative Dimensions AP / Display Preoperative Axis SItuation

Scheme and abbreviations
m	 mechanical		  a	 anatomical		  L	 lateral		
M	 medial			   D	 distal			   P	 proximal
F	 femur			   T	 tibia			   A	 angle

ACA	 Angle of Correction of Angulation
aLDFA	 anatomical Lateral Distal Femoral Angle
AMA	 Anatomical Mechanical Angle (angle between anatomical and mechanical axis)
aMLFA	 anatomical Medial Lateral Femoral Angle
aMPFA	 anatomical Medial Proximal Femoral Angle
Center Line	 Mikulicz
CORA	 Center of Rotation of Angulation (Center of Deformity) is created by moving the NCORA
NCORA	 neutral CORA, is always the original center of deformity
FSA-mTA	 Femoral Shaft Axis (anatomical) – mechanical Tibia Axis
HJC	 Hip Joint Center
JLCA	 Joint Line Conversion Angle (angle between KJL-F and KJL-T)
KJL-F	 Knee Joint Line – Femur (proximal knee base)
KJL-T	 Knee Joint Line – Tibia (distal knee base)
lBL	 Longitudinal Bisector Line
MAD 	 Mechanical Axis Deviation
mFA-mTA	 mechanical Femur Axis – mechanical Tibia Axis
Mikulicz	 Center line (Mikulicz = german)
mLDFA	 mechanical Lateral Distal Femoral Angle
mLDTA	 mechanical Lateral Distal Tibial Angle
mLPFA	 mechanical Lateral Proximal Femoral Angle
mMPTA	 mechanical Medial Proximal Tibial Angle
NSA	 Neck Shaft Angle (= CCD angle)
RDA	 Real Deformity Angle (Real angle of the maldisposition)
TSA 	 Tibia Shaft Axis
tBL	 Transversal Bisector Line

NOTE
Moving the NCORA to another position fundamentally effects the result:

NCORA is moved on the tBL:
Results in a change of axis length at this position, without causing a translation.

NCORA is moved on the lBL:
Results in a translation, without a change of axis length at this position.

NCORA is moved neither on the tBL, nor on the lBL, but freely:
Results in a change of axis length as well as a translation at this position.

In order to define and draw the femoral shaft axis:

1.	 Select point 1.
2.	 Select point 2.
3.	 Select point 3.
4.	 Select point 4.
5.	 The femoral shaft axis is automatically drawn.

Requirements:
All joint centers must be drawn, optionally both anatomical axes.

Result:
All preoperative mechanical axes, the centerline as well as all angles and lengths are automatically displayed in a 
preview.
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The nomenclature of all values by "Dror Paley Standard Measurements"
"Glossary and Deformity Correction Principles". Gaslini 29:1 (1997) 5-9

Normal values overview
(For a description of the normal values, see Paley, Dror: Principles of Deformity Correction 2002)

Current preoperative measurements

no (N)   = normal value
(> N)      = above normal
(< N)      = below normal
Mikulicz = centerline
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Step 11 – Define Axes by Dror Paley

Requirements:
All joint centers must be defined.

Result:
The preoperative mechanical axes are displayed on the image, the nor-
mal angles in degrees are displayed in the Axes by Dror Paley tool. Us-
ing the input fields, you can adjust the values by using the keyboard, or 
when placing the mouse cursor over the respective input field by using 
the scroll wheel of te mouse. Also, you can show the min./normal/max. 
values  if required by placing the mouse over the respective field. By se-
lecting the respective value, you can restore the original situation at any 
time.

NOTE:
All axes can be shown or hidden as needed in order to arrange the plan-
ning in a clearer fashion. However, they will not be deleted.

Using Auxiliary axis – 2 Pnt, an auxiliary axis 
can be drawn with any desired starting and 
ending point.

Using Auxiliary axis – 4 Pnt, an auxiliary axis by 
4 points can by drawn.

The auxiliary axes allow you to define the centers of deformity at another position (e.g. 
if the CORA is outside of the bone area), preferably in an easy-healing bone section,  and 
to adjust the angle of correction accordingly. The axes and the auxiliary axes create a 
continuous connection between the joint centers.

Activate the function Preoperative Dimensions. By default, the preoperative graphic with all relevant measure-
ments and dimensions is placed over the original image. However, you can select the option Move Dimensions in 
the osteotomy tool. By doing so, the preoperative graphic is automatically attached to the mouse cursor, you can 
place it at the desired position. 

The preoperative dimensions are applied simultaneously for both sides. Values in the normal area are shown in 
green color, values outside the normal area in red color. All other elements/texts are displayed in the color select-
ed in the osteotomy tool. Additionally, you can find a comparison/assessment of both sides below the preopera-
tive dimensions (e.g. leg length difference, heel height difference, height of the hip joint center).

NOTE
The preoperative dimensions are a part of your planning, they are required for further assessment, 
surgical decisions and documentation purposes.
Place the preoperative graphic at a position that won't interfere with the upcoming plannings, ide-
ally at the left of the x-ray image so that there is enough room at the right for the preview graphics.
The previews can be either displayed or left out.
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Step 12 – Osteotomy (Basics)

You can now perform the osteotomy on one or both sides. The body side selected in the osteotomy tool is visual-
ized by a dashed marking line. This way you always know in which part of the image you have to perform the next 
step. You can switch between sides as needed. 

Requirements:
All joint centers and both mechanical axes must be drawn. One or multiple centers of deformity (CORA)  must be 
clearly defined.

Procedure:

1.	 Activate the function Osteotomy.
2.	 Crosshairs appear at the mouse cursor, capturing the intersection points of the axes (CORA) in 

proximity of the mouse.  
 
 
 
 

3.	 Confirm tBL and lBL.
4.	 A preview is created, showing the optimal angle of correction, automatically calculated by IMPAX 

Orthopaedic Tools.
5.	 Subsequently, you can apply manual adjustments using various options. The options can be selected 

in the Osteotomy Tool.
6.	 With a right click of the mouse, the pop-up context menu for Applying, Applying without preview, 

Rejecting, Moving preview and Back opens.

CAUTION
If more than one intersection point exists, pay attention to define the correct intersec-
tion point for the first osteotomy.

A value displayed in green color represents the normal value in degrees, 
i.e. the mean value between the min. and max. values. A value displayed 
in black color represents a value in degrees within the min. and max. val-
ues. A value displayed in red color represents a value in degrees outside 
of the min. and max. values.

Result:
In reference to the defined elements (see requirements) and the definition of tBL and lBL, the first simulated result 
is shown in a preview. The mechanical axes are automatically drawn. The angles and all other values are calculated 
automatically.
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WARNING
After confirming/applying a preview, the calculated angle of correction is also drawn and saved 
on the original image. When you continue, you can

1.	 keep this angle in order to include it in the following calculations (resections).
2.	 delete this angle, in order to make a new calculation while keeping the current calcula-

tion visible in your planning. In this case, the angle in the original image has to be delet-
ed completely. The preview of the previous calculation remains visible.

All options of the Osteotomy Tool can be applied individually or in com-
bination.

The displayed preview is automatically aligned on the screen in order for 
the centerline to be perpendicular to the base line.

The Hip Alignment is performed automatically with regard to the select-
ed option (Horizontal, Manual, Original or Reference Line, if previously 
drawn).

Automatic Osteotomy can be activated if you want to undo a manual 
change performed by one of the other options. The automatically calcu-
lated  osteotomy is restored.

Osteotomy by tBL can be activated if you want to undo  the function 
Osteotomy parallel to tbl. The calculation using the automatic tbl is re-
stored.

Use neutral CORA can be activated if you want to undo the function 
Move CORA. The calculation using the automatically calculated CORA is 
restored.

Step 12a – Osteotomy with Automatically Calculated Angle

Procedure:

1.	 Activate the function Osteotomy.
2.	 Select the required CORA and confirm tBL and lBL.
3.	 The angle of correction is shown; the preview and all relevant automatically calculated values are 

attached to the mouse cursor. The calculation is conducted in such a way to achieve angle values 
within the normal Dror Paley limits for all axes.

4.	 Place the preview on a suitable position with sufficient distance to the original. The result shows the 
angle of correction automatically suggested by IMPAX Orthopaedic Tools.

5.	 With a right click of the mouse, the pop-up context menu for Applying, Applying without preview, 
Rejecting, Moving preview and Back opens. Select Apply.

6.	 The automatic calculation is displayed, the preview can no longer be modified.

CAUTION
Always draw resection lines and perform measurements on the original, never on a preview.
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Procedure:

1.	 Activate the function Osteotomy.
2.	 Select the required CORA and confirm tBL and lBL.
3.	 The angle of correction is shown, the preview and all relevant, automatically calculated values are 

attached to the mouse cursor.
4.	 Place the preview on a suitable position with sufficient distance to the original. 
5.	 Select Move centerline in the osteotomy tool.
6.	 Click anywhere in the work area. The mouse cursor is automatically attached to the CORA. By mov-

ing the mouse, the position of the centerline as well as the proximal segment of the femur or femo-
ral outline change as well. Simultaneously, all relevant values of the preview are updated. The angle 
of correction is drawn onto the original image.

7.	 Confirm the result. You can repeat this function or switch to a different function of the osteotomy 
tool.

8.	 With a right click of the mouse, the pop-up context menu for Applying, Applying without preview, 
Rejecting, Moving preview and Back opens. Select Apply.

9.	 The automatic calculation is displayed, the preview can no longer be modified.

Step 12c – Osteotomy with Resection Parallel to tBL

Requirements:
A preview with automatically calculated an-
gle of correction is preliminarily placed.

Result:
Defines a parallel position of the tBL  with-
out changing the position of the CORA. The 
size of the angle of correction remains. All 
relevant values are automatically calculat-
ed and displayed according to the changes 
made.

Step 12b – Osteotomy with Manually Moved Center Line

Requirements:
A preview with automatically calculated angle of correction is 
preliminarily placed.

Result:
Defines size and type of the angle of correction without 
changing the CORA. All relevant values are automatically cal-
culated and displayed according to the changes made.
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Procedure:

1.	 Activate the function Osteotomy.
2.	 Select the required CORA and confirm tBL and lBL.
3.	 The angle of correction is shown, the preview and all relevant, automatically calculated values are 

attached to the mouse cursor.
4.	 Place the preview on a suitable position with sufficient distance to the original.
5.	 Select Osteotomy parallel to tBL in the osteotomy tool.
6.	 Click anywhere in the work area and confirm the parallel line of the tBL.
7.	 The parallel line is now attached to the mouse cursor. By moving the mouse, the angle of correction 

changes its position in the preview. Simultaneously, all relevant values of the preview are updated. 
The angle of correction is drawn onto the original image.

8.	 Confirm the result. You can repeat this function or switch to a different function of the osteotomy 
tool.

9.	 With a right click of the mouse, the pop-up context menu for Applying, Applying without preview, 
Rejecting, Moving preview and Back opens. Select Apply.

10.	 The automatic calculation is displayed, the preview can no longer be modified.

Step 12d – Custom Osteotomy

Requirements:
A preview with automatically calculated angle of 
correction is preliminarily placed.

Result:
Defines the position of the resection line with-
out changing the position of the CORA. The size 
of the angle of correction changes in relation to 
the inclination of the resection line. All relevant 
values are automatically calculated and dis-
played according to the changes made.

Procedure:

1.	 Activate the function Osteotomy.
2.	 Select the required CORA and confirm tBL and lBL.
3.	 The angle of correction is shown, the preview and all relevant, automatically calculated values are 

attached to the mouse cursor.
4.	 Place the preview on a suitable position with sufficient distance to the original.
5.	 Select Osteotomy custom in the osteotomy tool.
6.	 Define the starting point of the new resection line. 

CAUTION: Always draw on the original, not on the preview!
7.	 Define the end point of the new resection line.
8.	 By moving the mouse, the angle of correction changes its orientation and position, the resection 

size and type on the preview change as well. Simultaneously, all relevant values of the preview are 
updated. The angle of correction is drawn onto the original image.

9.	 Confirm the result. You can repeat this function or switch to a different function of the osteotomy 
tool.

10.	 With a right click of the mouse, the pop-up context menu for Applying, Applying without preview, 
Rejecting, Moving preview and Back opens. Select Apply.

11.	 The automatic calculation is displayed, the preview can no longer be modified.
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NOTE
Moving the CORA may cause one translation.
The size of the translation is calculated and displayed automatically.

Procedure:

1.	 Activate the function Osteotomy.
2.	 Select the required CORA and confirm tBL and lBL.
3.	 The angle of correction is shown, the preview and all relevant, automatically calculated values are 

attached to the mouse cursor.
4.	 Place the preview on a suitable position with sufficient distance to the original.
5.	 Select Move CORA in the osteotomy tool.
6.	 Optionally, you can select further options for the CORA in the osteotomy tool: 

 
 
 
 
 

7.	 Crosshairs appear attached to the mouse cursors, displaying the automatically calculated angle 
8.	 Pick up the CORA and place it to the required position. 

CAUTION: Always draw on the original, not on the preview!
9.	 You can repeat this function or switch to a different function of the osteotomy tool.
10.	 With a right click of the mouse, the pop-up context menu for Applying, Applying without preview, 

Rejecting, Moving preview and Back opens. Select Apply.
11.	 The automatic calculation is displayed, the preview can no longer be modified.

Step 12e – Osteotomy with Moved CORA

Requirements:
A preview with automatically calculated angle of cor-
rection is preliminarily placed.

Result:
The automatically calculated angle remains, the CORA 
is moved to a new position. The resection is on the 
tBL.
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Step 12g – Osteotomy with Combined Options

All steps described in steps 12a to 12f can be combined while in the activated Osteotomy function:

•	 Osteotomy with automatically calculated angle
•	 Osteotomy with manually moved centerline
•	 Osteotomy with resection parallel to tBL

Once you have finished your planning using one of the commands Apply, Apply without preview, Reject, select 
the function Osteotomy in the module tool again.

Step 12h – Move Preview

Requirements:
The preview is not yet confirmed as final.

Result:
The preview is moved to another position, without being rotated or changed otherwise.

Procedure:

1.	 Select Move preview in the osteotomy tool.
2.	 Pick up the preview at the femur or tibia.
3.	 Place the preview on the desired position.
4.	 You can repeat this function or switch to a different function of the osteotomy tool.
5.	 With a right click of the mouse, the pop-up context menu for Applying, Applying without preview, 

Rejecting, Moving preview and Back opens. Select Apply.
6.	 The preview is moved and can no longer be modified.

Step 12f – Osteotomy with Moved Part

Requirements:
A preview with automatically calculated angle of correction is 
preliminarily placed.

Result:
You can perform a leg length adjustment or simulate a trans-
lation/rotation simultaneously to the osteotomy.

Procedure:

1.	 Activate the function Osteotomy.
2.	 Select the required CORA and confirm tBL and lBL.
3.	 The angle of correction is shown, the preview and all relevant, automatically calculated values are 

attached to the mouse cursor.
4.	 Place the preview on a suitable position with sufficient distance to the original.
5.	 Select Move part in the osteotomy tool.
6.	 Click on the part to be moved in the preview. It is attached to the mouse cursor right away. By mov-

ing the mouse, the part's position changes. Simultaneously, all relevant values of the preview are 
updated. The angle of correction is drawn onto the original image.

7.	 Confirm the result. You can repeat this function or switch to a different function of the osteotomy 
tool.

8.	 With a right click of the mouse, the pop-up context menu for Applying, Applying without preview, 
Rejecting, Moving preview and Back opens. Select Apply.

9.	 The automatic calculation is displayed, the preview can no longer be modified.

•	 Custom osteotomy
•	 Osteotomy with moved CORA
•	 Osteotomy with moved part
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Workflow Step by Step (Sagittal View)

Step 13 – Define Proximal 2/3 Center of Femur

Requirements:
A scaled image.

Result:
The proximal 2/3 center of femur is defined and drawn.

In order to define the proximal 2/3 center of femur:

1.	 Set the point in the center of the most proximal part of the 
visible femur.

2.	 The proximal 2/3 center of femur is defined.

NOTE
The proximal 2/3 center of femur marks the anatomical axis of the visible part of the femur. The 
more is visible of the distal femur, the more exact IMPAX Orthopaedic Tools is able to calculate.

Step 14 – Define Femoral Knee Base Center ML

Requirements:
A scaled image.

Result:
A base line tangential to the prox-
imal femur condyles is drawn. By 
placing 2 automatic perpendicular 
lines at the anterior and posterior 
outer condyles, the femoral knee 
base center is determined. 

You are in the function KJ Femur ML. After selecting the line color and line width, start drawing the tangential line 
at the proximal femur condyles (points 1 and 2).

Requirements:
The preview is not yet confirmed as final.

Result:
The hip/pelvis is rotated in the preview.

Procedure:

1.	 Select Rotate hip in the osteotomy tool.
2.	 Click anywhere near the preview.
3.	 By moving the mouse, the position of the pelvis changes, as well as the position of the leg opposite 

of the leg where the knee adjustment was performed. No values are changed.
4.	 Confirm the result. You can repeat this function or switch to a different function of the osteotomy 

tool.
5.	 With a right click of the mouse, the pop-up context menu for Applying, Applying without preview, 

Rejecting, Moving preview and Back opens. Select Apply.
6.	 The preview is rotated and can no longer be modified.

Step 12i – Rotate Hip
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In order to define the femoral knee base center ML:

1.	 Define the first of two base points, the anterior or posterior proximal femur condyle.
2.	 Define the second of two base points, the opposite proximal femur condyle.
3.	 The femoral base line is drawn, a perpendicular line marked 

"anterior" appears automatically. Move the mouse downwards 
and place the first of two tangents at the anterior outer condyle. 
CAUTION: Always place the first line on the anterior bone edge.

4.	 Place the second of two tangents at the posterior outer con-
dyle. The femoral knee base center ML is already displayed and 
changes when moving the mouse.

5.	 The femoral knee base line and knee base center ML are drawn.

Step 15 – Define Tibial Knee Base Center ML

Requirements:
A scaled image.

Result:
A base line tangential to the proximal 
tibial condyles is drawn. By placing 2 
automatic perpendicular lines at the 
anterior and posterior outer condyles, 
the tibial knee base center is deter-
mined.

You are in the function KJ Tibia ML. After selecting the line color and line width, start drawing the tangential line 
at the proximal tibia condyles (points 1 and 2).

In order to define the tibial knee base center ML:

1.	 Define the first of two base points, the anterior or posterior proximal tibia condyle.
2.	 Define the second of two base points, the opposite proximal tibia condyle.
3.	 The tibial base line is drawn, a perpendicular line marked "anterior" appears automatically. Move 

the mouse downwards and place the first of two tangents at the anterior outer condyle. CAUTION: 
Always place the first line on the anterior bone edge.

4.	 Place the second of two tangents at the posterior outer condyle. The tibial knee base center ML is 
already displayed and changes when moving the mouse.

5.	 The tibial knee base line and knee base center ML are drawn.

Step 16 – Define Ankle Joint Center ML

Requirements:
A scaled image.

Result:
The ankle joint base and center are 
drawn.

You are in the function Ankle Joint ML. After selecting the line color and line width, start drawing the tangential 
line from point 1 to point 2.
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Step 17 – Preoperative Dimensions ML / Display Preoperative Axis Situation

Requirements:
Proximal 2/3 center of femur and all joint centers are defined.

Result:
All preoperative mechanical axes, the centerline as well as all angles and lengths are automatically displayed in a 
preview.

Abbreviations:

aPDFA	 anatomical Anterior Distal Femoral Angle
aPPTA	 anatomical Posterior Proximal Tibia Angle
aADTA	 anatomical Anterior Distal Tibia Angle

Activate the function Preop. Dimensions ML. The preoperative graphic with all relevant measurements and di-
mensions is automatically attached to the mouse cursor, you can place it at the desired position – with sufficient 
distance to the original.

NOTE
The preoperative dimensions are a part of your planning, they are required for further assessment, 
surgical decisions and documentation purposes.
Place the preoperative graphic at a position that won‘t interfere with the upcoming plannings, ide-
ally at the left of the x-ray image so that there is enough room at the right for the preview graphics.
The previews can be either displayed or left out.

The nomenclature of all values by "Dror Paley Standard Measurements"
"Glossary and Deformity Correction Principles". Gaslini 29:1 (1997) 5-9

Normal values overview
(For a description of the normal values, see Paley, Dror: Principles of Deformity Correction 2002)

In order to define the ankle joint center ML:

1.	 Define the first of two base points, the anterior or posterior talus.
2.	 Define the second of two base points, the opposite anterior or posterior talus.
3.	 The ankle joint base is drawn, a perpendicular line marked "anterior" appears automatically. Move 

the mouse upwards and place the first of two tangents at the anterior condyle. CAUTION: Always 
place the first line on the anterior bone edge.

4.	 Place the second of two tangents at the posterior condyle. The ankle joint center ML is already dis-
played and changes when moving the mouse.

5.	 The ankle joint base line and center ML are drawn.
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Step 18 – Define Axes by Dror Paley

The procedure to define the axes by Dror Paley is identical to the respective procedure in AP view. See »Step 11«.

Step 19 – Osteotomy

The osteotomy procedure is identical to the respective procedure in AP view. See »Step 12«.

Workflow Step by Step (AP and ML Views Combined)

WARNING
Images can only be properly scaled, if a reference object (sphere or scale bar) with dimensions 
known to the user is placed in the image region, close to and at the level of the joint/bone 
area you are interested in, when recording the image. Please verify the entered scaling size tho-
roughly, wrong input can lead to serious miscalculation. The original IMPAX Orthopaedic Tools 
sphere has a 25 mm diameter with a +/- 0.1 mm tolerance. When using other reference objects, 
measure and tolerance of the respective manufacturer apply. Please pay extreme attention to 
the Image Requirements and Scaling Instructions at the end of this User Manual.

Step 20 – Showing AP and ML Images in Combination

NOTE
For the AP view, IMPAX Orthopaedic Tools requires 
the femoral and tibial knee base and the ankle joint. 
For the sagittal view, IMPAX Orthopaedic Tools re-
quires the distal femur, the femoral and tibial knee 
base and the ankle joint.

NOTE
It is recommended to save this image as a IMPAX Orthopaedic Tools planning on your local hard 
drive before proceeding, to avoid unintentional loss or deletion

Requirements:
Two images of the tibia, one in frontal (AP) view, one in sagittal (ML) 
view. Both images have been recorded with a reference object.

Result:
Both images are scaled and show the part required for planning.

In order to display AP and ML images in comhination:

1.	 Load/import first image (AP view) as described in »Importing Images«.
2.	 Scale first image as described in »Scaling Images«.
3.	 Load/import second image (sagittal view).
4.	 Scale second image.
5.	 After inserting/scaling, the second image is selected and marked. Pick it up with another click of 

the mouse and place it on the desired position (ideally next to each other), which you require to 
continue with your planning.

6.	 Optionally, you can select the other image with two clicks of the mouse and pick it up, in order to 
move and place it on another position. You can repeat this procedure for both images as often as 
needed. For moving the images later on, use the Image Tool under menu item Image, and proceed 
accordingly.

7.	 Both images are displayed in combination.
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Step 21 – Measuring APEX/Deformity Angle

Requirements:
Scaled images in AP and MP view, displayed in combination.

Result: 
A schematic view of the APEX deformity and the APEX defor-
mity angle.

Preparative steps:

1.	 Define the hip joint center in the AP image as described in »Step 3«. 
NOTE: If the hip joint center is not visible on the selected image, define any visible position above 
the image using the Free mode.

2.	 Define the greater trochanter in the AP image as described in »Step 4«. 
NOTE: If the greater trochanter is not visible on the selected image, define any visible point next 
to the hip joint center. The position, i.e. the direction of the greater trochanter indicates the body 
side of the displayed femurs, IMPAX Orthopaedic Tools then automatically recognizes if it is the 
left or the right leg.

3.	 Define the femoral knee base in the AP image as described in »Step 6«.
4.	 Define the tibial knee base in the AP image as described in »Step 7«.
5.	 Define the ankle joint base in the AP image as described in »Step 8«.
6.	 Define (and adjust if necessary) the axes by Dror Paley in the AP image as described in »Step 11«.
7.	 Define the proximal 2/3 center of femur in the ML image as described in »Step 13«.
8.	 Define the femoral knee base center in the ML image as described in »Step 14«.
9.	 Define the tibial knee base center in the ML image as described in »Step 15«.
10.	 Define the ankle joint center in the ML image as described in »Step 16«.
11.	 Define (and adjust if necessary) the axes by Dror Paley in the ML image as described in »Step 11«.

In order to calculate the APEX deformity and the APEX deformity angle:

1.	 Confirm the center of deformity (CORA) in the AP view. Move the mouse cursor near the CORA, until 
tBL and lBL appear. NOTE: Make sure the mechanical axes intersect.

2.	 The deformity angle and its orientation is already shown in the information window. Confirm the 
center of deformity (CORA in the ML view. Move the mouse cursor near the CORA, until tBL and lBL 
appear. NOTE: Make sure the mechanical axes intersect.

3.	 The schematic image of the APEX deformity is attached to the mouse cursor. Place it at any desired 
position of the planning.

4.	 The APEX deformity and the APEX deformity angle is calculated and displayed.

IMPAX Orthopaedic Tools subsequently displays the deformity in the AP view in correlation with the deformity in 
the ML view.

CAUTION
A correct calculation can only be performed, if both centers of deformity (AP and ML) are approx-
imately on the same level (e.g. at the distal tibia or at the proximal tibia). Some deformities are 
visible in the AP or ML view only. The APEX deformity can not be determined in this case.
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Other Functions

Step 22 – Measure Distances and Angles

The measuring of distances and angles is described in chapter »Working with IMPAX Orthopaedic Tools«, sections 
»Measure Distance« and »Measure Angle«.

Step 23 – Insert Osteosynthesis Components

Requirements:
A scaled image.

Result:
You can select the manufacturer, type, size and other properties of the prostheses to be inserted.

WARNING
All dimensions and measurements given by the IMPAX Orthopaedic Tools prosthesis database 
derived from original manufacturer data or templates. If you suspect that the data is not cor-
rect, please report it to Agfa‘s service representative or contact Agfa using the contact infor-
mation provided in the beginning of this manual.

After selecting the function, you are in the Implant/template tool, the prosthesis used last is attached to the 
mouse cursor, freely moveable in the work area.

After selecting the line color, line width as well as the body side, consecutively select the desired manufacturer, 
the prosthesis type, prosthesis size and all other properties. The prosthesis attached to the mouse cursor changes 
accordingly. Further info about inserting implants can be found at »Inserting Implants«.

In order to insert prostheses:

1.	 The prosthesis appears on the mouse. By using the cursor keys ← and →, you can adjust the 
inclination of the prosthesis. The angle in ° is displayed in the Angle field of the implant/template 
tool. In capture mode Free you can place the prosthesis anywhere in the image. Using the key P, 
the capture mode for a Point is activated, e.g. the hip joint center. If you approve of size/position/
angle, place the prosthesis.

2.	 As long as the prosthesis is not confirmed as final, you can always pick it up again and move or modi-
fy it. You can change the size by using the cursor keys ↓ and ↑ after selecting the respective column 
of the menu list or the respective fly out menu.

3.	 With a right click of the mouse, confirm the prosthesis as final.
4.	 The prosthesis is inserted.

The procedure to insert the planning information is described in chapter »Hip - Manual Planning«, »Step 20 – 
Insert Planning Information«.

Step 24 – Insert Planning Information
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Basics

Using the Spine module, you can determine various measurement values on the vertebrae.

The Spine module provides an assessment of pathological and non-pathological conditions on the basis of mea-
sureable angles and distances. The values are different for children and adults.

Depending on the course of the medical condition, the values are evaluated differently and can be looked at sepa-
rately. Calculations can be performed in the AP (anterior-posterior) view and the ML (sagittal) view.

A wide range of components like nails, plates, screws and prostheses, can be selected from the database. 

Advantages:

•	 Simulations under different conditions can be displayed in one single planning, in order to reach the most 
optimal result for the patient

•	 Graduation tables used in common literature are automatically applied
•	 Measuring results are displayed graphically
•	 Low effort and easy handling

Workflow Step by Step – Spine in General

Step 1 – Insert & Scale Images

In order to perform a spine planning:

1.	 Load/import image as described in »Importing Images«.
2.	 Scale image as described in »Scaling Images«.
3.	 In the module overview, select the Spine module.

WARNING
Images can only be properly scaled, if a reference object (sphere or scale bar) with dimensions 
known to the user is placed in the image region, close to and at the level of the joint/bone 
area you are interested in, when recording the image. Please verify the entered scaling size tho-
roughly, wrong input can lead to serious miscalculation. The original IMPAX Orthopaedic Tools 
sphere has a 25 mm diameter with a +/- 0.1 mm tolerance. When using other reference objects, 
measure and tolerance of the respective manufacturer apply. Please pay extreme attention to 
the Image Requirements and Scaling Instructions at the end of this User Manual.

CAUTION
Pay close attention to use the Frontal (AP) functions when working on images in AP view, and the 
Sagittal (ML) functions when working on images in sagittal view.
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Step 2 – Draw Vertebra Endplates

In order to draw the vertebra endplates:

1.	 Define the starting point of the vertebra endplate.
2.	 Define the end point of the vertebra endplate.
3.	 The vertebra endplate. Repeat the function for the next plate/vertebra or exit the function with a 

right click of the mouse.

After selecting the line color and line width, draw the vertebra endplates.

Requirements:
A scaled x-ray image.

Result:
The vertebra endplates are drawn. The endplates can also be drawn later 
on in the other functions of this module.

Step 3 – Gravity Line of Vertebral Body

Requirements:
A scaled x-ray image with or without drawn vertebra endplates.

Result:
By connecting the endpoints of the vertebra, the gravity line is automatically drawn in the 
gravity center of the vertebral body.

After selecting the line color and line width, start selecting the endplates (click on 2 lines) or, if no endplates have 
been drawn so far, start by drawing the endplates (click on 4 endpoints).

In order to define the gravity line of the vertebral body (with previously drawn endplates):

1.	 Select the first endplate.
2.	 Select the second endplate.
3.	 Define the end point of the gravity line. A vertical or horizontal preview/aid line is automatically 

displayed.
4.	 The gravity line of the vertebral body is drawn. Repeat the function for the next vertebra or exit the 

function with a right click of the mouse.
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In order to define the gravity line of the vertebral body (without previously drawn endplates):

1.	 Define the starting point of the first vertebra endplate.
2.	 Define the end point of the first vertebra endplate.
3.	 Define the starting point of the second vertebra endplate.
4.	 Define the end point of the second vertebra endplate.
5.	 Define the end point of the gravity line. A vertical or horizontal preview/aid line is automatically 

displayed.
6.	 The gravity line of the vertebral body is drawn. Repeat the function for the next vertebra or exit the 

function with a right click of the mouse.

Step 4 – Risser Grade

Requirements:
A scaled image of the iliac crest.

Result:
By defining three points on the iliac crest, the iliac crest is divided into 
four equal-sized segments. With a fourth point, the Risser Grade can be 
determined.

After selecting the line color and line width, start by defining the three 
points on the iliac crest. The arc being created should coincide as much 
as possible with the iliac crest. The division into four segments is done 
automatically.

In order to determine the Risser Grade:

1.	 Define the point of the Spina iliaca anterior superior.
2.	 Define the point of the Spina iliaca posterior superior.
3.	 Define the edge of the iliac crest.
4.	 Define the end of the apophysis. For the definition of the Risser Grades 1 or 4, go beyond the edge 

of the first or the fourth segment.
5.	 The 4 segments and the Risser Grade are displayed.

Workflow Step by Step – Spine AP View

Step 5 – Scoliosis by Cobb

Requirements:
A scaled x-ray image.

Result:
The angle according to Cobb is calculated between individual 
entplates.
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The Apex vertebra and the other two verte-
brae can be specified in advance using the  
spine tool.

In order to determine the scoliosis angle according to Cobb (with previously drawn endplates):

1.	 Select the first endplate.
2.	 Select the second endplate.
3.	 Define the text position. Text and angle are already displayed and are attached to the mouse.
4.	 The scoliosis angle according to Cobb as well as any specified vertebrae are now displayed. Repeat 

the function for the next angle or exit the function with a right click of the mouse.

After selecting the line color and line width, start selecting the endplates (click on 2 lines) or, if no endplates have 
been drawn so far, start by drawing the endplates (click on 4 endpoints).

In order to determine the scliosis angle according to Cobb (without previously drawn endplates):

1.	 Define the starting point of the first vertebra endplate.
2.	 Define the end point of the first vertebra endplate.
3.	 Define the starting point of the second vertebra endplate.
4.	 Define the end point of the second vertebra endplate.
5.	 Define the text position. Text and angle are already displayed and are attached to the mouse.
6.	 The scoliosis angle according to Cobb as well as any specified vertebrae are now displayed. Repeat 

the function for the next angle or exit the function with a right click of the mouse.

Step 6 – Scoliosis by Ferguson

Requirements:
A scaled x-ray image.

Result:
The angle according to Ferguson is calculated between indi-
vidual endplates.

The Apex vertebra and the other two vertebrae can be speci-
fied in advance using the spine tool.
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After selecting the line color and line width, start selecting the endplates (click on 6 lines) or, if no endplates have 
been drawn so far, start by drawing the endplates (click on 12 endpoints).

In order to determine the scoliosis angle according to Ferguson (with previously drawn endplates):

1.	 Select the top endplate of the first vertebra.
2.	 Select the bottom endplate of the first vertebra.
3.	 Repeat steps 1 and 2 for the Apex vertebra and then the second vertebra.
4.	 Define the text position. Text and angle are already displayed and are attached to the mouse.
5.	 The scoliosis angle according to Ferguson as well as any specified vertebrae are now displayed. Re-

peat the function for the next angle or exit the function with a right click of the mouse.

In order to determine the scoliosis angle according to Ferguson (without previously drawn endplates):

1.	 Define the starting point of the top endplate of the first vertebra.
2.	 Define the end point of the top endplate of the first vertebra.
3.	 Define the starting point of the bottom endplate of the first vertebra.
4.	 Define the end point of the top endplate of the first vertebra.
5.	 Repeat steps 1 thru 4 for the Apex vertebra and then the second vertebra.
6.	 Define the text position. Text and angle are already displayed and are attached to the mouse.
7.	 The scoliosis angle according to Ferguson as well as any specified vertebrae are now displayed. Re-

peat the function for the next angle or exit the function with a right click of the mouse.

Step 7 – Nash-Moe Rotation

Requirements:
A scaled x-ray image.

Result:
The Nash-Moe index represents the rota-
tion of the vertebra as indicated by good or 
bad visibility of the pedicle.

After selecting the line color and line width, start selecting the endplates (click on 2 lines) or, if no endplates have 
been drawn so far, start by drawing the endplates (click on 4 endpoints). The definition is usually done on the apex 
vertebra, which you can specify and document in the spine tool.

In order to determine the Nash-Moe Index (with previously drawn endplates):

1.	 Select the first endplate.
2.	 Select the second endplate.
3.	 Define the pedicle center. By using the space key, you can select the display mode. "Good only" 

means both pedicles are visible. Click on the center of the pedicle with better visibility. "Bad only" 
means only one pedicle is visible and moved beyond the vertebra center. 

4.	 The Nash-Moe Index and the width in percent is displayed. Repeat the function for the next vertebra 
or exit the function with a right click of the mouse.
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In order to determine the Nash-Moe Index (without previously drawn endplates):

1.	 Define the starting point of the first vertebra endplate.
2.	 Define the end point of the first vertebra endplate.
3.	 Define the starting point of the second vertebra endplate.
4.	 Define the end point of the second vertebra endplate.
5.	 Define the pedicle center. By using the space key, you can select the display mode. "Good only" 

means both pedicles are visible. Click on the center of the pedicle with better visibility. "Bad only" 
means only one pedicle is visible and moved beyond the vertebra center. 

6.	 The Nash-Moe Index and the width in percent is displayed. Repeat the function for the next vertebra 
or exit the function with a right click of the mouse.

Definition/Grading of the Nash-Moe Index:

Grade 0	 No rotation, symmetric pedicles

Grade 1	 + Rotation, one pedicle is at the edge of the vertebra, the second moved slightly towards 
the vertebra center

Grade 2	 ++ one pedicle just disappears behind the vertebra edge, the second is moved 2/3 to-
wards the vertebra center

Grade 3	 +++ one pedicle has disappeared, the second is on the vertebra center

Grade 4	 ++++ one pedicle has disappeared, the second is beyond the vertebra center

(Hellinger Johannes, Messmethoden in der Skelettradiologie, Georg Thieme Verlag Stuttgart, 1995)

Step 8 – Interpedicular Distance

Requirements:
A scaled x-ray image.

Result:
The interpedicular distance in mm is displayed. The normal 
values from the following list (next page) are shown, in rela-
tion to the patient's age.

After selecting the line color and line width, start by defining the measuring points on the inner, convex cortical 
edge of the pedicle. The program always proceeds to the next vertebra after finishing the current one. You can also 
skip individual vertebrae.

In order to measure the interpedicular distance:

1.	 Define the first point on the inner, convex corticalis of the pedicle.
2.	 Define the second point on the inner, convex corticalis of the opposite pedicle.
3.	 The distance of the inner, convex cortical edge in mm as well as the grading from the list is displayed 

(normal range is marked by N, >N, and <N). Repeat the function for the next vertebra or exit the 
function with a right click of the mouse.

CAUTION
In order to obtain a correct grading/assessment, the patient's age has to be entered into the Plan-
ning Information and the vertebra in question has to be specified in the spine tool, before perform-
ing this function.
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Normal values:

Age:	 3-5	 6-8	 9-10	 11-12	 13-14	 15-16	 17-18	 19+

C3	 18-29	 22-30	 21-32	 20-32	 24-31	 23-31	 23-32	 25-31
C4	 19-30	 23-31	 21-32	 21-33	 25-32	 24-32	 24-33	 26-32
C5	 20-31	 23-31	 22-32	 21-33	 25-32	 25-32	 25-34	 26-33
C6	 20-31	 24-31	 22-32	 21-33	 25-32	 24-33	 25-34	 26-33
C7	 19-30	 23-31	 21-32	 20-32	 24-31	 21-32	 23-32	 24-32
				  
T1	 17-26	 19-26	 20-27	 20-27	 19-28	 18-29	 20-26	 20-28
T2	 14-22	 15-22	 17-24	 16-24	 16-24	 14-25	 17-23	 17-24
T3	 13-21	 14-21	 15-21	 14-22	 15-23	 15-22	 15-21	 16-22
T4	 12-20	 14-21	 15-21	 14-21	 14-22	 14-20	 15-21	 15-21
T5	 12-20	 13-20	 14-20	 13-21	 14-22	 14-21	 15-21	 14-21
T6	 12-20	 13-20	 14-20	 13-20	 14-22	 13-20	 14-20	 14-20
T7	 12-20	 13-21	 14-20	 13-20	 14-22	 13-21	 15-21	 14-20
T8	 12-21	 14-21	 14-20	 13-21	 14-23	 14-21	 15-21	 15-21
T9	 12-21	 14-21	 13-21	 14-21	 15-23	 14-22	 15-21	 15-21
T10	 12-21	 15-22	 13-21	 14-21	 15-23	 14-22	 16-22	 16-22
T11	 13-22	 16-23	 14-23	 15-22	 16-25	 16-23	 17-23	 17-24
T12	 16-24	 18-25	 17-25	 18-25	 19-27	 18-26	 20-26	 19-27

L1	 17-24	 17-27	 19-28	 19-27	 20-27	 20-28	 20-29	 21-29
L2	 17-24	 17-27	 19-28	 19-27	 20-27	 20-28	 20-29	 21-30
L3	 17-24	 17-27	 19-28	 20-27	 21-28	 21-29	 20-29	 21-31
L4	 18-25	 18-28	 20-29	 20-28	 19-33	 21-30	 19-33	 21-33
L5	 21-28	 22-32	 24-33	 24-34	 22-36	 23-35	 23-37	 23-37

(Hinck, V.C. and assoc..: Normal interpediculate distances in children and adults. Amer.J.Radiol. 96 (1966) 141)

Step 9 – Determine Spinal Canal Width Index

Requirements:
A scaled x-ray image.

Result:
The interpedicular distance is displayed, as well as the small-
est vertebral diameter. The index and its assessment are dis-
played as well. The formula is:

Index A = B/2. Assessment: A < B/2 means a narrowing of the 
diameter of the lumbar spinal canal is suspected.

You are in the function Spinal Canal Width Index. After selecting the line color and line width, start by drawing the 
interpedicular distance, and continue by drawing the smallest vertebral diameter.

In order to determine the spinal canal width index:

1.	 Define the first point on the inner, convex corticalis of the pedicle.
2.	 Define the second point on the inner, convex corticalis of the opposite pedicle.
3.	 Define the first point of the vertebra diameter at the point of the smallest diameter.
4.	 Define the second point of the vertebra diameter opposite of the first point.
5.	 The interpedicular distance, the vertebral diameter and the spinal canal width index are displayed. 

Repeat the function for the next vertebra or exit the function with a right click of the mouse.
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Workflow Step by Step – Spine Lateral View

Step 10 – Lordosis

Requirements:
A scaled lateral x-ray image.

Result:
The drawn endplates, the lordosis angle and (if 
specified) the Apex angle are displayed.

The Apex vertebra and the other two vertebrae 
can be specified in advance using the spine tool.

You are in the function Lordosis. After selecting the line color and line width, start selecting the endplates (click on 
2 lines) or, if no endplates have been drawn so far, start by drawing the endplates (click on 4 endpoints). If vertebra 
combination Atlas-C7 is specified in the spine tool, the normal range values (marked by N, >N, and <N) are shown 
in the information window.

In order to determine the lordosis angle (with previously drawn endplates):

1.	 Select the first endplate.
2.	 Select the second endplate.
3.	 Define the text position. Text and angle are already displayed and are attached to the mouse.
4.	 The lordosis angle, the endplates and the apex vertebra (if specified) are displayed. Repeat the func-

tion for the next angle or exit the function with a right click of the mouse.

Step 11 – Kyphosis

Requirements:
A scaled lateral x-ray image.

Result:
The drawn endplates, the kyphosis angle and (if specified) the Apex an-
gle are displayed.

The Apex vertebra and the other two vertebrae can be specified in ad-
vance using the spine tool.

In order to determine the lordosis angle (without previously drawn endplates):

1.	 Define the starting point of the first vertebra endplate.
2.	 Define the end point of the first vertebra endplate.
3.	 Define the starting point of the second vertebra endplate.
4.	 Define the end point of the second vertebra endplate.
5.	 Define the text position. Text and angle are already displayed and are attached to the mouse.
6.	 The lordosis angle, the endplates and the apex vertebra (if specified) are displayed. Repeat the func-

tion for the next angle or exit the function with a right click of the mouse.
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CAUTION
In order to obtain the correct grading/assessment on the basis of the following table, the 
patient‘s age and gender has to be entered into the Planning Information and the vertebra 
in question has to be specified in the spine tool, before performing this function.

	 Age	 female	 male
	 2-10	 8-36	 5-40
	 10-20	 11-41	 8-39
	 20-30	 7-40	 13-48
	 30-40	 10-42	 13-49
	 40-50	 21-50	 17-44
	 50-60	 22-53	 25-45
	 60-70	 34-54	 25-62
	 70-80	 30-56	 32-66

(Essentials of Skeletal Radiology, Williams & Willkins, 1996)

You are in the function Kyphosis. After selecting the line color and line width, start selecting the endplates (click on 
2 lines) or, if no endplates have been drawn so far, start by drawing the endplates (click on 4 endpoints).

If vertebra combination T1–T12 is specified in the spine tool, the relation to the normal values(marked by N, >N, 
and <N) is also displayed.

In order to determine the kyphosis angle (with previously drawn endplates):

1.	 Select the first endplate.
2.	 Select the second endplate.
3.	 Define the text position. Text and angle are already displayed and are attached to the mouse.
4.	 The kyphosis angle, the endplates and the Apex vertebra (if specified) are displayed. Repeat the 

function for the next angle or exit the function with a right click of the mouse.

In order to determine the kyphosis angle (without previously drawn endplates):

1.	 Define the starting point of the first vertebra endplate.
2.	 Define the end point of the first vertebra endplate.
3.	 Define the starting point of the second vertebra endplate.
4.	 Define the end point of the second vertebra endplate.
5.	 Define the text position. Text and angle are already displayed and are attached to the mouse.
6.	 The kyphosis angle, the endplates and the Apex vertebra (if specified) are displayed. Repeat the 

function for the next angle or exit the function with a right click of the mouse.

Step 12 – Cloning by Reference Lines

Requirements:
Two scaled x-ray images, one in flexion and one in extension.

Result:
On one of the two images, the endplates are compared. Mea-
surements of distances and angles can be performed manu-
ally afterwards.

Source Target
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Step 1:	 Draw all elements that you want to compare on both, the source and the target images. Use the Ver-
tebra Endplates.for endplates, the Outlines function for vertebral outlines.

Step 2:	 Proceed to the function Clone by Reference Lines. Select the line color and line width.

NOTE
Now, select 2 reference lines, as described below. Start with the reference line on the target image, 
then mark the corresponding line on the source image.

In order to clone/compare by using reference lines:

1.	 Select the first reference line (endplate) on the target image on its posterior end.
2.	 Select the first reference line (endplate) on the source image on its posterior end.
3.	 Select the next element to be compared on the source image.
4.	 Select all further elements to be compared on the source image.
5.	 Use the space key to switch source and target lines.
6.	 With a right click of the mouse, open the pop-up context menu to apply/reject/cancel.

Workflow Step by Step – Cervical Spine Lateral View

Step 13 – Atlantodental Interspace

Requirements:
Lateral x-ray image with visible Tuberculum and Axis.

Result:
The atlantodental interspace is measured by clicking on two specific points.

In order to measure the atlantodental interspace:

1.	 Define the first point, the posterior edge of the tuberculum.
2.	 Define the second point, the anterior surface of the Axis.
3.	 The atlantodental interspace and its grading are displayed. Values within the normal range are 

marked "N", values outside the normal range are marked "<N" and ">N".

After selecting the line color and line width, draw the atlantodental interspace.
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Step 14 – Gravity Line From Dens

Requirements:
A scaled x-ray image.

Result:
The position of the Dens Apex is defined and the gravity line is drawn 
starting at that particular point.

After selecting the line color and line width, draw the cervical gravity line.

In order to draw the cervical gravity line:

1.	 Define the Dens Apex.
2.	 Define the end point of the gravity line. A vertical or horizontal preview/aid line is automatically 

displayed and should pass through C7.
3.	 The cervical gravity line is drawn, exit the function with a right click of the mouse.

Step 15 – Diameter of the Spinal Canal

Requirements:
Scaled lateral x-ray image of the cervical spine.

Result:
By clicking on two points, the diameter of the spi-
nal canal is measured and assessed.

After selecting the line color and line width, start by specifying the vertebra to be measured in the spine tool. The 
program always proceeds to the next vertebra after finishing the current one. You can also skip individual verte-
brae.

In order to determine and measure the spinal canal diameter:

1.	 Define a point on the posterior edge of the midvertebral body.
2.	 Define a point on the nearest point of the segmental spinolaminar junction line.
3.	 The diameter of the spinal canal in mm is now displayed. Repeat the function for the next vertebra 

or exit the function with a right click of the mouse.
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Step 16 – Draw Vertebra Lines

Requirements:
Lateral x-ray image.

Result:
By drawing meaningful lines, kink formations or steps can be identified.

You are in the function Vertebra Lines. After selecting the line color and 
line width, start by defining starting points and end points of the vertebral 
segment lines..

By using the fly-out menu of the spine tool, you 
can select the different lines individually. Subse-
quently, the different lines are shown in differ-
ent colors.

In order to draw vertebra lines:

1.	 Define the starting point of the particular line.
2.	 Define the end point of the particular line.
3.	 The vertebra line is displayed. Repeat the function for the next segment or exit the function with a 

right click of the mouse.

Step 17 – McGregor's Line

Requirements:
Lateral x-ray image with Palatum Durum

Result:
Abnormal positioning between Palatum Durum and the Occipital Bone is 
visualized.
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You are in the function McGregor's Line. After selecting the line color and line width, define the starting point and 
the end point of the line.

In order to draw the McGregor's Line:

1.	 Define the starting point of the line, the posterior edge of the Palatum Durum.
2.	 Define the end point of the line, the inferior edge of the occipital bone.
3.	 The McGregor's line is displayed.

Workflow Step by Step – Lumbar Spine Lateral View

Step 18 – Spondylolisthesis

Requirements:
Scaled lateral x-ray image of the lumbar spine, sacrum is visible.

Result:
The length of the sacral base line is correlated to the distance between 
the posteriosuperior edge of the sacrum and the perpendicular line be-
tween the posterioinferior edge of the L5 and the sacral base line The 
result is the Meyerding Grade (1-5) and the Olisthesis by Taillard (%).

You are in the function Spondylolisthesis. After selecting the line color and line width, start by defining the re-
quired points as described below.

In order to determine the Spondylolisthesis values:

1.	 Define the posteriosuperior edge of the sacrum.
2.	 Define the anteriosuperior edge of the sacrum. A line preview is already displayed and attached to 

the mouse cursor.
3.	 Define the posterioinferior edge of L5. A preview of the measurement is already displayed and 

changes when moving the mouse.
4.	 All values for the measurements according to Meyerding and Taillard are calculated and displayed. 

Exit the function with a right click of the mouse.

Step 19 – Intervertebral Disc Height

Requirements:
Lateral x-ray image of the lumbar spine.

Result:
The intervertebral disc height is measured between 2 verte-
brae positioned opposite each other.

You are in the function Intervertebral Disc Height. After se-
lecting the line color and line width, start by defining points 
between two vertebrae as described below.

In order to measure the intervertebral disc height:

1.	 Define the center point on the edge of the first selected vertebra.
2.	 Define the center point on the edge of the first selected vertebra.
3.	 The intervertebral disc height in mm is displayed. Repeat the function for the next disc or exit the 

function with a right click of the mouse.
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Step 20 – Intervertebral Disc Angle

Requirements:
Lateral x-ray image of the lumbar spine.

Result:
By selecting the endplates above and below 
the intervertebral disc, the angle between both 
endplates is measured.

You are in the function Intervertebral Disc Angle. After selecting the line color and line width, define the endplates 
of the required vertebrae. The vertebra cranial to the intervertebral disc can be specified in the spine tool. The 
caudal vertebra is automatically added.

In order to measure the intervertebral disc angle (with previously drawn endplates):

1.	 Select the first endplate.
2.	 Select the second endplate.
3.	 Place the measurement label on the desired position.
4.	 The intervertebral disc angle and its measurement are displayed. Repeat the function for the next 

disc or exit the function with a right click of the mouse.

In order to measure the intervertebral disc angle (without previously drawn endplates):

1.	 Define the starting point of the first vertebra endplate.
2.	 Define the end point of the first vertebra endplate.
3.	 Define the starting point of the second vertebra endplate.
4.	 Define the end point of the second vertebra endplate.
5.	 Place the measurement label on the desired position.
6.	 The intervertebral disc angle and its measurement are displayed.  Repeat the function for the next 

disc or exit the function with a right click of the mouse.

Step 21 – Instability by Van Akkerveeken

Requirements:
Lateral x-ray image of the lumbar spine.

Result:
By selecting the endplates above and below the in-
tervertebral disc, the instability by Van Akkerveek-
en is measured.

You are in the function Instability by Van Akkerveeken. After selecting the line color and line width, define the 
endplates of the required vertebrae.

In order to determine the Instability by Van Akkerveeken (with previously drawn endplates):

1.	 Select the first endplate.
2.	 Select the second endplate.
3.	 The Instability ba Van Akkerveeken is displayed. Repeat the function for the next disc or exit the 

function with a right click of the mouse.

In order to determine the Instability by Van Akkerveeken (without previously drawn endplates):

1.	 Define the starting point of the first vertebra endplate.
2.	 Define the end point of the first vertebra endplate.
3.	 Define the starting point of the second vertebra endplate.
4.	 Define the end point of the second vertebra endplate.
5.	 The Instability by Van Akkerveeken is displayed. Repeat the function for the next disc or exit the 

function with a right click of the mouse.
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Step 22 – Sacral Angles

Requirements:
Lateral x-ray of the lumbar spine.

Result:
By defining 3 specific points on the sacral base, the sacral base 
angle and the sacral inclination are calculated and displayed.

You are in the function Sacral Angles. After selecting the line color and line width, start defining the points of the 
sacral base as described below.

In order to determine the sacral angles:

1.	 Define the ventral end point of the sacral base.
2.	 Define the caudal end point of the dorsal sacral base.
3.	 Define the ventral cranial end point of the sacral base. A preview of the values is already displayed.
4.	 The sacral angles are measured and displayed, the angle measurements are displayed. Exit the func-

tion with a right click of the mouse.

Step 23 – Functional Analysis

Requirements:
Two scaled x-ray images, one in flexion and one in extension.

Result:
The comparison of endplates in relation to a reference plate is measured and displayed. The result can be either 
displayed on both images or on either one of the images.

Image 1
Step 1:	 Draw reference plate B
Step 2: 	 Draw endplate Q

Image 2 (comparison image)
Step 3: 	 Draw reference plate B
Step 4: 	 Draw endplate  Q

Image 1
Step 1: 	 Select reference plate B
	 at the posterior end point
Step 2: 	 Select endplate Q

Image 2 (comparison image)
Step 3: 	 Select reference plate B
	 at the posterior end point
Step 4: 	 Select endplate Q



220

IMPAX Orthopaedic Tools » Table of Contents «

» Table of Contents «

Spine

Image 1 Image 2 (comparison image)

Image 1 Image 2 (comparison image)

Explanation:

The measurement is performed with the same endplate, once in flexion and once in extension.  The basis of the 
measurement is the reference plate on both sides (B), brought to congruency.

B	 Reference plate, brought to congruency with the corresponding reference plate of the other 
image. B1 is the posterior end point of the reference plate

P	 Endplate (Image 1). P1 is the posterior end point and P2 is the anterior end point of the plate.

Q	 Corresponding endplate (Image 2). Q1 is the posterior end point and Q2 is the anterior end point 
of the plate.

B°90  	Reference plate (B), rotated by 90° at the posterior end point.

a	 Distance between P1 and B°90

b	 Distance between Q1 and B°90

d1	 Distance between P1 and Q1

d2	 Distance between P2 and Q2

You are in the function Functional Analysis. After selecting the line color and line width, start by selecting the 
reference and endplates in both images.



221

IMPAX Orthopaedic Tools» Table of Contents «

» Table of Contents «

Spine

In order to perform the functional analysis (with previously defined endplates):

1.	 Select the reference plate of the first image at its posterior end.
2.	 Select the endplate of the first image at its posterior end.
3.	 Select the reference plate of the second image at its posterior end.
4.	 Select the endplate of the second image at its posterior end.
5.	 The measurement result appears and is attached to the mouse cursor. By using the space key, you 

can switch between displaying the measurement results on both images or either one of the imag-
es. Place the result of the measurement on the desired position.

6.	 The functional analysis is completed, the correlating endplates and their respective measurement 
results are displayed. Repeat the function for the next pair of vertebrae pair or exit the function with 
a right click of the mouse.

In order to perform the functional analysis (without previously defined endplates):

1.	 Define the posterior starting point of the reference plate in the first image.
2.	 Define the end point of the reference plate in the first image.
3.	 Define the posterior starting point of the endplate in the first image.
4.	 Define the end point of the endplate in the first image.
5.	 Define the posterior starting point of the reference plate in the second image.
6.	 Define the end point of the reference plate in the second image.
7.	 Define the posterior starting point of the endplate in the second image.
8.	 Define the end point of the endplate in the second image.
9.	 The measurement result appears and is attached to the mouse cursor. By using the space key, you 

can switch between displaying the measurement results on both images or either one of the imag-
es. Place the result of the measurement on the desired position.

10.	 The functional analysis is completed, the correlating endplates and their respective measurement 
results are displayed. Repeat the function for the next pair of vertebrae pair or exit the function with 
a right click of the mouse.

Step 24 – Stability Criteria of Spondyloretrolisthesis

Requirements:
Lateral x-ray image.

Result:
The angle between two corresponding endplates in relation to a reference plate is measured. On the centers of 
both endplates, a perpendicular line is drawn. The distance between the intersection point of both perpendicular 
lines to the respective endplate centers is measured. The result can be either displayed on both images or on 
either one of the images.

Image 1 Image 2 (comparison image)
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You are in the function Stability Criteria of Spondyloretrolisthesis. After selecting the line color and line width,  
start by selecting the reference and endplates in both images. The procedure is similar to the procedure of the 
functional analysis.

In order to measure the stability criteria of spondyloretrolisthesis (with previously defined endplates):

1.	 Select the reference plate of the first image at its posterior end.
2.	 Select the endplate of the first image at its posterior end.
3.	 Select the reference plate of the second image at its posterior end.
4.	 Select the endplate of the second image at its posterior end.
5.	 The perpendicular lines are drawn, measurement result appears and is attached to the mouse cur-

sor. By using the space key, you can switch between displaying the measurement results on both 
images or either single one of the images. Place the result of the measurement on the desired 
position.

6.	 The stability criteria are measured, the correlating endplates and perpendicular lines with the cor-
responding measurement values are displayed. Repeat the function for the next pair of vertebrae or 
exit the function with a right click of the mouse.

In order to measure the stability criteria of spondyloretrolisthesis (without previously defined endplates):

1.	 Define the posterior starting point of the reference plate in the first image.
2.	 Define the end point of the reference plate in the first image.
3.	 Define the posterior starting point of the endplate in the first image.
4.	 Define the end point of the endplate in the first image.
5.	 Define the posterior starting point of the reference plate in the second image.
6.	 Define the end point of the reference plate in the second image.
7.	 Define the posterior starting point of the endplate in the second image.
8.	 Define the end point of the endplate in the second image.
9.	 The perpendicular lines are drawn, measurement result appears and is attached to the mouse cur-

sor. By using the space key, you can switch between displaying the measurement results on both 
images or either single one of the images. Place the result of the measurement on the desired 
position.

10.	 The stability criteria are measured, the correlating endplates and perpendicular lines with the cor-
responding measurement values are displayed. Repeat the function for the next pair of vertebrae or 
exit the function with a right click of the mouse.

Workflow Step by Step – Other Functions

Step 25 – Insert Prostheses and Osteosynthesis Components

Requirements:
A scaled image.

Result:
You can select the manufacturer, type, size and other properties of the prostheses to be inserted.

WARNING
All dimensions and measurements given by the IMPAX Orthopaedic Tools prosthesis database 
derived from original manufacturer data or templates. If you suspect that the data is not cor-
rect, please report it to Agfa‘s service representative or contact Agfa using the contact infor-
mation provided in the beginning of this manual.

After selecting the function, you are in the Implant/template tool, the prosthesis used last is attached to the 
mouse cursor, freely moveable in the work area.

After selecting the line color, line width as well as the body side, consecutively select the desired manufacturer, 
the prosthesis type, prosthesis size and all other properties. The prosthesis attached to the mouse cursor changes 
accordingly. Further info about inserting implants can be found at »Inserting Implants«.
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The following procedure applies to pedicle screws:

After inserting at least 2 pedicle screws at the de-
sired position:

1.	 Start the function 
Outlines

2.	 Change the capture mode to End 
point with the E key.

3.	 Draw 2 outlines. For the first out-
line, connect points 1 thru 4 (or 
more in case of more than 2 inserted 
screws). For the second outline, pro-
ceed in the same manner.

The measuring of distances and angles is described in chapter »Working with IMPAX Orthopaedic Tools«, sections 
»Measure Distance« and »Measure Angle«.

Step 26 – Measure Distances and Angles

In order to insert prostheses:

1.	 The prosthesis appears on the mouse. By using the cursor keys ← and →, you can adjust the 
inclination of the prosthesis. The angle in ° is displayed in the Angle field of the implant/template 
tool. In capture mode Free you can place the prosthesis anywhere in the image. Using the key P, 
the capture mode for a Point is activated, e.g. the hip joint center. If you approve of size/position/
angle, place the prosthesis.

2.	 As long as the prosthesis is not confirmed as final, you can always pick it up again and move or modi-
fy it. You can change the size by using the cursor keys ↓ and ↑ after selecting the respective column 
of the menu list or the respective fly out menu.

3.	 With a right click of the mouse, confirm the prosthesis as final.
4.	 The prosthesis is inserted.

The procedure to insert the planning information is described in chapter »Hip - Manual Planning«, »Step 20 – 
Insert Planning Information«.

Step 27 – Insert Planning Information
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Basics

The Foot module is used to plan foot prostheses. By inserting the prosthesis templates into the images, you can 
determine the size of the required prosthesis.

Also, you can assess and correct a Hallux Valgus deformity.

Workflow Step by Step

Step 1 – Insert & Scale Images

In order to perform a planning of the foot:

1.	 Load/import image as described in »Importing Images«.
2.	 Scale image as described in »Scaling Images«.
3.	 In the module overview, select the Foot module.

WARNING
Images can only be properly scaled, if a reference object (sphere or scale bar) with dimensions 
known to the user is placed in the image region, close to and at the level of the joint/bone 
area you are interested in, when recording the image. Please verify the entered scaling size tho-
roughly, wrong input can lead to serious miscalculation. The original IMPAX Orthopaedic Tools 
sphere has a 25 mm diameter with a +/- 0.1 mm tolerance. When using other reference objects, 
measure and tolerance of the respective manufacturer apply. Please pay extreme attention to 
the Image Requirements and Scaling Instructions at the end of this User Manual.

Step 2 – Cut and Move Image Area (optional)

Requirements:
A scaled image.

Result:
An image area is drawn and marked with an outline.

If needed for your planning, you can cut and move image areas to a separate position. You are in the image tool, 
the function Cut and move image area is selected.
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In order to cut the image area:

1.	 Select the first and successively all other required points of the image area to be cut out. Alterna-
tively, draw the image area while holding down the mouse button. A preview of the image area is 
shown in inverted style.

2.	 A right click with the mouse cuts the image area.
3.	 Pick up the image area and move it to the desired position.
4.	 Exit the function with a right click of the mouse.

Step 3 – Hallux Valgus

Requirements:
A scaled x-ray image of the foot (standing).

Result:
Hallux Valgus Angle (HVA) and First Intermetatarsal Angle (FIA) are determined and measured.

You are in the function Hallux Valgus. After selecting line color and line width, start by drawing the centerline of 
the Proximal Phalanx I. You can choose from 2 different methods: 2 Points and 4 Points.
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In order to draw the centerline of the Proximal Phalanx I by 2 points:

1.	 Define the first point of the centerline.
2.	 Define the second point of the centerline.
3.	 The center line is drawn.

In order to draw the centerline of the Proximal Phalanx I by 4 points:

1.	 Define the first intersection point.
2.	 Define the second intersection point.
3.	 Define the third intersection point.
4.	 Define the fourth intersection point.
5.	 The center line is drawn.

After drawing the centerline of the Proximal Phalanx I, you are automatically prompted to draw the centerline of 
the Metatarsal I next, followed by the centerline of the Metatarsal II. The procedure is identical to drawing the 
centerline of the Proximal Phalanx I. You can also choose between the two drawing methods, by 2 points and by 
4 points.

Once you have drawn all three centerlines, you can move the information label containing the measurement val-
ues to a suitable position. Alternatively, you can end the function with a right click of the mouse, and this way leave 
the information label on the suggested position.

In order to reposition the information label:

1.	 Pick up the information label.
2.	 Place the label on the desired position.
3.	 The label is repositioned, end the function with a right click of the mouse.

If needed, you can repeat the Hallux Valgus function for the other foot. In 
order to do so, use the button New HVA+FIA.

Step 4 – Insert Prostheses and Osteosynthesis Components

Requirements:
A scaled image.

Result:
You can select the manufacturer, type, size and other properties of the prostheses to be inserted.

WARNING
All dimensions and measurements given by the IMPAX Orthopaedic Tools prosthesis database 
derived from original manufacturer data or templates. If you suspect that the data is not cor-
rect, please report it to Agfa‘s service representative or contact Agfa using the contact infor-
mation provided in the beginning of this manual.

After selecting the function, you are in the Implant/template tool, the prosthesis used last is attached to the 
mouse cursor, freely moveable in the work area.

After selecting the line color, line width as well as the body side, consecutively select the desired manufacturer, 
the prosthesis type, prosthesis size and all other properties. The prosthesis attached to the mouse cursor changes 
accordingly. Further info about inserting implants can be found at »Inserting Implants«.
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Step 5 – Measure Distances and Angles

The measuring of distances and angles is described in chapter »Working with IMPAX Orthopaedic Tools«, sections 
»Measure Distance« and »Measure Angle«.

In order to insert prostheses:

1.	 The prosthesis appears on the mouse. By using the cursor keys ← and →, you can adjust the 
inclination of the prosthesis. The angle in ° is displayed in the Angle field of the implant/template 
tool. In capture mode Free you can place the prosthesis anywhere in the image. Using the key P, 
the capture mode for a Point is activated, e.g. the hip joint center. If you approve of size/position/
angle, place the prosthesis.

2.	 As long as the prosthesis is not confirmed as final, you can always pick it up again and move or modi-
fy it. You can change the size by using the cursor keys ↓ and ↑ after selecting the respective column 
of the menu list or the respective fly out menu.

3.	 With a right click of the mouse, confirm the prosthesis as final.
4.	 The prosthesis is inserted.

The procedure to insert the planning information is described in chapter »Hip - Manual Planning«, »Step 20 – 
Insert Planning Information«.

Step 6 – Insert Planning Information
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Basics

The module Upper Extremities can be used for prosthesis planning on shoulder, elbow and hand.

By inserting the prosthesis templates into the images, you can determine the size of the required prosthesis.

Workflow Step by Step

Step 1 – Insert & Scale Images

In order to perform a planning of the upper extremities:

1.	 Load/import image as described in »Importing Images«.
2.	 Scale image as described in »Scaling Images«.
3.	 In the module overview, select the Upper Extremities module.

WARNING
Images can only be properly scaled, if a reference object (sphere or scale bar) with dimensions 
known to the user is placed in the image region, close to and at the level of the joint/bone 
area you are interested in, when recording the image. Please verify the entered scaling size tho-
roughly, wrong input can lead to serious miscalculation. The original IMPAX Orthopaedic Tools 
sphere has a 25 mm diameter with a +/- 0.1 mm tolerance. When using other reference objects, 
measure and tolerance of the respective manufacturer apply. Please pay extreme attention to 
the Image Requirements and Scaling Instructions at the end of this User Manual.

Step 2 – Cut Bone (optional)

Requirements:
A scaled image.

Result:
An image area is drawn and marked with an outline.

If needed for your planning, you can cut and move image areas to a separate position. You are in the image tool, 
the function Cut and move image area is selected.
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Step 3 – Insert Prostheses and Osteosynthesis Components

Step 4 – Move Prosthesis With Bone

Requirements:
A scaled image with a cut image area and a prosthesis insert-
ed into that image area.

Result:
The prosthesis is moved together with the cut image area.

Requirements:
A scaled image.

Result:
You can select the manufacturer, type, size and other properties of the prostheses to be inserted.

WARNING
All dimensions and measurements given by the IMPAX Orthopaedic Tools prosthesis database 
derived from original manufacturer data or templates. If you suspect that the data is not cor-
rect, please report it to Agfa‘s service representative or contact Agfa using the contact infor-
mation provided in the beginning of this manual.

After selecting the function, you are in the Implant/template tool, the prosthesis used last is attached to the 
mouse cursor, freely moveable in the work area.

After selecting the line color, line width as well as the body side, consecutively select the desired manufacturer, 
the prosthesis type, prosthesis size and all other properties. The prosthesis attached to the mouse cursor changes 
accordingly. Further info about inserting implants can be found at »Inserting Implants«.

In order to insert prostheses:

1.	 The prosthesis appears on the mouse. By using the cursor keys ← and →, you can adjust the 
inclination of the prosthesis. The angle in ° is displayed in the Angle field of the implant/template 
tool. In capture mode Free you can place the prosthesis anywhere in the image. Using the key P, 
the capture mode for a Point is activated, e.g. the hip joint center. If you approve of size/position/
angle, place the prosthesis.

2.	 As long as the prosthesis is not confirmed as final, you can always pick it up again and move or modi-
fy it. You can change the size by using the cursor keys ↓ and ↑ after selecting the respective column 
of the menu list or the respective fly out menu.

3.	 With a right click of the mouse, confirm the prosthesis as final.
4.	 The prosthesis is inserted.

In order to cut the image area:

1.	 Select the first and successively all other required points of the image area to be cut out. Alterna-
tively, draw the image area while holding down the mouse button. A preview of the image area is 
shown in inverted style.

2.	 A right click with the mouse cuts the image area.
3.	 Pick up the image area and move it to the desired position.
4.	 Exit the function with a right click of the mouse.
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In order to move the prosthesis with the cut bone image area:

1.	 When selecting this function, the image area as well as the prosthesis are already selected. Pick 
them up with a click of the mouse.

2.	 Place the image area and prosthesis on the desired new position.
3.	 Prosthesis and image area are moved.

Please note, that this function always moves all existing image areas and all implants inserted herein together at 
the same time

Step 5 – Measure Distances and Angles

The measuring of distances and angles is described in chapter »Working with IMPAX Orthopaedic Tools«, sections 
»Measure Distance« and »Measure Angle«.

The procedure to insert the planning information is described in chapter »Hip - Manual Planning«, »Step 20 – 
Insert Planning Information«.

Step 6 – Insert Planning Information
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Image Requirements & Scaling

In order to obtain ideal results when planning prostheses and osteotomies, the following requirements have to 
be met:

•	 All images must be recorded in accordance with orthopaedic criteria. They are described in ref-
erence literature such as Bernau, Bohndorf: Röntgendiagnostik in Orthopädie und Traumatologie 
and partially used on the following pages..

•	 Images must be of high quality, the reference object (for scaling) as well as the area of interest 
must be clearly and fully visible.

•	 Place the reference object (e.g. sphere, scale bar) close to and at the level of the joint/bone area 
you are interested in to get results as accurate as possible.

The most accurate result is achieved if reference object is placed as shown below.

WARNING
Please pay attentions to these instructions at all times!

The used reference object has to be disinfected before and after 
usage with a disinfectant appropriate for stainless steel.

For hip planning, we recommend to place the sphere medial or lateral close to and at the level of 
the joint. For long leg planning (knee prostheses and corrective osteotomies), place the sphere 
medial or lateral at the level of the knee joint or the longitudinal femur axis.

In order to avoid errors that might occur during automatic scaling, we recommend not to use round 
x-ray markers.



242

IMPAX Orthopaedic Tools » Table of Contents «

» Table of Contents «

Image Requirements & Scaling

	 If you place the reference object upon the skin, as shown in the next image, the result must and 
will be inaccurate. About 5-10% or 1-3 sizes of the prosthesis are to be expected.

	 A cup size 58 mm was implanted, despite the expected cup size of 54 mm after scaling with a 24 
mm scaling sphere. The error was caused by positioning the scaling sphere above the femur bone 
level.

•	 The measures of the applied reference objects in mm must be known. Wrong input can lead to 
serious miscalculation. The original IMPAX Orthopaedic Tools sphere has a 25 mm diameter with 
a +/- 0,1 mm tolerance. When using other reference objects, measure and tolerance of the re-
spective manufacturer apply..

•	 Reference objects must not be too small. We recommend a sphere diameter of ≥ 20mm and scal-
ing bars of ≥ 50mm length.

•	 Scale bars or any angular/oblong reference objects must be placed parallel to the film to avoid 
projection errors. 

•	 Reference objects must have a clearly visible outline on the x-ray images. Avoid scatter.

•	 Enlarge the reference object on the screen before scaling.

User suggestions:

•	 Size and position of reference object should be documented.

•	 Film/focus distance, film/reference object distance and film/bone-of-interest dstance should be 
documented. Instead of the film, the desk can be used as the second level.

Sources of error:

•	 Reference object is too small. The smaller the reference object, the larger the measuring error.

•	 Rerference object is not placed parallel to film/table. The larger the angle, the larger the error.

•	 Reference object wasn't enlarged before scaling. The larger the number of x-ray pixels displayed 
on one screen pixel, the larger the error. Enlarging/zooming increases the visible screen pixels as 
well as the visibility of bone structures.

INCORRECT!
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Things to Know About the Scaling of X-Ray Images

The illustration shows an example of a frequently made x-ray of the hip/pelvis. The x-ray source is a point source and 
radiates in a spherical way, as shown in the illustration. The x-ray image however is recorded on a plane DR or CR 
detector plate. This causes an elliptic projection of the scaling sphere.

A precise dimension can therefore be only determined for the exact position of the scaling sphere. With increasing 
distance it becomes less accurate. Hence the sphere should always be placed as close as possible to the joint you 
want to work with and fixated exactly on the level of the joint. Our scaling tools (adhesive pads, scaling stand with 
flexible arm and integrated scaling sphere) are well suited for this task. 

In the depicted example, the relatively small distance to the actual hip joint only causes a minimal deviation of less 
than 0.5% – when used correctly, this allows for precise scaling.

x-ray focus

sphere on
hip level

x-ray film or
CR/DR panel

Compared to other scaling methods, IMPAX Orthopaedic Tools is well positioned: scaling methods, which for ex-
ample don’t determine the exact bone level but identify the distance between multiple scaling markers and then 
scale using statistical values (values which have been repeatedly adjusted over the last few years), are certainly 
not more or less precise.

The automatic scaling using a scaling sphere provides a highly convenient, simple, and uncomplicated handling 
and when used properly, a precise scaling as the basis of as exact a preoperative planning as possible.

When using a known magnification factor for scaling, it is required that the imaging system automatically saves a 
reference measurement (PixelSpacing). The level of the reference measurement (table/panel) may differ depend-
ing on the system used. When using a scaling bar with a known length, it is important to place the scaling bar 
parallel to the x-ray table, otherwise errors might occur due to distortion.

Magnification
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Additional Information for Each Module

Hip Modules

Place the reference object close to and at the level of the hip joint, near the palpable greater trochanter (Trochan-
ter Major) or at the level of the lesser trochanter (Trochanter Minor) or below at the level of the femur shaft. 

The basic requirements for planning a surgical procedure are x-rays taken according to the following criteria:

•	 Symmetrical positioning of the pelvis
•	 Hip joints in neutral position
•	 Longitudinal femur axis parallel to the image receptor plane
•	 Patella in zero position
•	 Central ray beam on femoral head center symphysis

CAUTION
When taking the x-ray, pay attention to avoid oblique positioning, abduction or external leg rota-
tion. Otherwise you won't be able to determine the optimal rotation center of the endoprothesis 
accurately.

The following information contains partial texts extracted and translated from Bernau, Bohndorf: Röntgendiag-
nostik in Orthopädie und Traumatologie drawings/outlines from/based on Wicke: Atlas of Radiologic Anatomy.

FURTHER INSTRUCTIONS

For the Hip - Biometry module, the iliac crest must be visible in order to exactly define the 10 bio-
metric points.

For the Hip - Wear Measurement module, only almost identical images can be compared to each 
other: the position of the hip endoprosthesis should be similar, if possible. Views must be the same 
on both images (AP and AP, ML and ML, etc.). The chronological distance between the images should 
be as much as possible (wear increases the more time has passed).

For the Hip - Coxometry module, in order to determine the development of the acetabulum (e.g. 
AC-HILG, ACE), the pelvis must not be in a lordotic position (flexion of hip and knee joints) and the 
patellaemust be in zero position. In order to determine the situation of the femur head, femoral 
neck and femur, (e.g. CCD angle), the patient must be positioned in such a way that the longitudinal 
axis of the femur is parallel to the image receptor plane. The hip joints must be in a neutral position 
and the patellae in zero position.

For the Hip - FAI module, you can use the following types of images: pelvis overview (anterior-pos-
terior), false profile (“faux” profile) image (axis between femoral head and scaling sphere must be 
parallel to the image receptor plane!), axial x-rays (e.g. cross-table or Rippstein), Lauenstein image.

Pelvis overview, standing:

The patient’s back is to the stand, knee joints stretched, kneecaps frontalized. As a rule, 
the feet are pronated in a way that the big toes are touching each other. A possible 
malposition of the hip joint shall not be necessarily avoided, instead keep it while re-
cording the x-ray in order to document the pathological clinical result radiologically. Use 
compression device for adipose patients.
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Hip anterior-posterior (standing or lying):

Standing in front of the bucky wall stand (patient stands with fron-
talized knee caps, which means having slightly pronated feet, in 
front of the bucky wall stand, while holding on to the stand with 
his hands)
			              or

lying on the bucky table (supine position), stretched legs, frontal-
ized knee caps, beam alignment on groin center.

Hip joint lateral according to Lauenstein:

Patient on the bucky table in supine position, rotated so far to the 
side, that hip joint to be recorded is centrally placed in 45° flexion 
and 45° abduction. If abduction is constrained by pain, elevate the 
opposite hip accordingly.

Upper leg with hip joint, anterior-posterior:

Supine position, stretched legs, frontalized knee caps, sandbag on 
lower leg, opposite leg slightly abducted.

Upper leg with hip joint, lateral:

Inclined position on the bucky table. The exterior side of the upper 
leg to be recorded lies lateral on the bucky table, with a 70° hip 
flexion and a 90° knee flexion. Sandbag on lower leg if necessary. 
The opposite leg is overstretched if possible and placed dorsally 
behind the leg to be recorded.

Pelvis overview, lying, hanging lower legs (Rippstein 1):

By placing the lower legs in vertical position, a defined rotation of the proximal femur edge is insured. This is par-
ticularly relevant in regard to repeated x-rays (e.g. pre and post operative). As the projected femoral neck angle 
is changing in correlation to the flexion of the hip, the flexion should be 0°, meaning, the hip joint shall be fully 
stretched.

Hip joint, antetorsion image (Rippstein 2)

This special orthopedic image is preferential in regard to the antetorsion angle in case of a child, but also of im-
portance for the objectivization of rotation errors after a femoral fractures. The projected antetorsion angle of the 
femoral neck is determined. Position on the leg holding device according to Rippstein, right-angled flexion of hip 
and knee joints, 20° abduction of both upper thighs. Usable images are only obtained by exactly abiding the angles 
mentioned above.

Hip joint, inclined – “faux profile” according to Lequesne

Patient is standing with the back diagonally to the bucky wall 
stand, in an angle of 65° between back and stand plane. The foot 
closer to the stand stays parallel to the image receptor plane (axis 
through metatarsal II) in order to achieve an actual lateral image.
In case of an excessive torsional malposition, where the foot is 
rotated outward by more than 15° while the patella is pointing 
forward, use the patella as the point of reference. The knee must 
be parallel, i.e. the patella perpendicular to the bucky wall stand.
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Knee & Osteotomy (Long Leg) Modules

When using the Knee & Osteotomy/Osteotomy by Dror Paley modules, you can use partial images as well as 
long leg images in a standing position and anterior-posterior view. You can compile a full long leg image out of the 
respective partial images.

CAUTION
You can calculate axial misalignment correctly only if the images used for planning fulfill the follow-
ing requirements:

•	 AP image showing one or both legs, taken in standing position with equal weight distribution 
on both legs

•	 Hip and ankle joints must be fully visible
•	 Reference object placed on longitudinal femur axis level

Due to missing hip and ankle joint centers, partial knee images should be only used as an exception. As the cen-
ter line and the mechanical axes cannot be determined properly, partial images are not suitable for conducting a 
proper Osteotomy.

Long leg anterior-posterior:

A stable, preferably variable stool construction, allowing safe entering/leaving, is a 
necessary requirement for all those x-ray systems, where space doesn't allow imag-
es with the x-ray tube on knee level with a 2 m FFA minimum to be taken.
Patient standing with the back to the stand, holding on to the stand with both hands 
behind his back. Knee cap parallel to the film, frontalized. If possible, take image 
standing on one leg only, whilst heel of the other leg is held against lower thigh 
of the standing leg and is shown on the image as well. If standing on one leg isn't 
possible, the skin of the inner ankles respectively knees should just about touch. 
The leg axes mustn't be affected by pressure from the other leg. When standing on 
both legs, both knees should be on the same level, a leg length difference is to be 
compensated with a pad/small board. The recording succeeds up until a body size of 
190 cm when using a 96 cm cartridge and proper adjustment of hip and ankle joints.

Knee joint anterior-posterior, lying:

Supine position, stretched legs, frontalized knee caps, sandbag on low-
er legs if necessary.

Upper leg with knee joint, lateral:

Lateral position on the bucky table. The exterior side of the upper leg to be recorded lies lateral on the bucky table, 
with hip and knee flexion, knee cap perpendicular to bottom layer, sandbag on lower leg if necessary. The opposite 
leg is placed heavily bent in front of the leg to be recorded.

Knee joint anterior-posterior, standing on one leg:

Patient standing with the back to the stand. If stand cannot be adjusted to knee level, patient stands on a safe 
footstool. Knee joint stretched, leg pronated so far, that knee cap is frontalized = parallel to the film.
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Knee joint lateral, lying:

Lateral position, exterior side of the knee joint lies proximal to the film, 
knee joint in 30° flexion. The flexion angle is significant for assessing 
the height position of the kneecap. The other leg is rested on foam 
support in front of the leg to be recorded. Knee cap perpendicular to 
bottom layer; easier to adjust: Lower leg parallel to bottom layer. Ele-
vated heel, rest on foam support.

Lower leg with ankle joint, anterior-posterior:

If possible: Recorded while standing. Patient standing in front of the bucky wall stand, recorded similar to knee 
joint anterior-posterior standing, however with a lower beam alignment according to the issue.

Lower leg with ankle joint, lateral:

Lateral position on the bucky table, knee joint in 30° flexion. Exterior side of the lower leg lies lateral on the car-
tridge, ankle joint in a right angle position. Exact lateral placement of knee and lower leg, elevate heel and rest on 
foam support. The opposite leg is placed to the front.

Spine Module

Cervical spine anterior-posterior, sitting:

Patient is seated in an upright position with the back to the stand. Head inclina-
tion guided by assistant in such a way, that the connecting line between lower 
edge occiput and upper jaw occlusal plane is perpendicular to the film plane. This 
adjustment is crucial for recording the 1. cervical vertebra without any overlays. 
The patient opens and closes the mouth on command of the assistant, “open 
– close, open – close …”, just by moving the lower jaw and keeping the head ab-
solutely still. In order to avoid the head moving to the back, a 15° foam support 
is pushed with the head to the stand. With an exposure time long enough (e.g. 
400 mAs), the lower jaw is blurred on the image and all cervical vertebrae are 
depictad suitable for further evaluation.

Cervical spine lateral, sitting:

Patient is seated in an upright position (“swan's neck”) with the right shoulder 
to the stand. Median plane (nose!) exactly parallel to the film. Head rest fixation 
if necessary. Patient is prompted to focus on a point at eye level (e.g. a postcard 
sticked to the wall in the required position). This assures a neutral, repeatable 
posture of the head. Sandbags in both hands in order to pull shoulders as far 
down as possible, achieving a free exposition of the cervical-thoracic junction.
Alternatively: if sitting is impossible, record in supine position, placement ac-
cording to skull lateral. Fixate small children, as described in position 1 and 3, 
with a lead blanket, keeping the arms free. Parents pull arms down while re-
cording.
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Foot Module

Thoracic spine anterior-posterior, standing:

Patient standing with the back to the stand, 
hanging arms, stretched legs, standard posi-
tion, especially during growth. Alternatively, 
recording in supine position (only with injured 
and patients unable to stand)

Thoracic spine lateral, standing:

Patient standing with the right shoulder to the stand. Shoulders shall be brought as much forward as possible, 
in order to reduce overlays of the upper spine by shoulder blades and tissue without causing an unnatural spine 
posture. It has proven the most, if the patient encompasses a coat hanger attached to the stand from below or 
rests the arms on the head rest holder.
Alternatively: for patients unable to stand, record in lying position.

Lumbar spine anterior-posterior, standing:

Patient standing with the back to the stand, arms hanging, legs stretched. If due to a 
heavy leg length difference the patient is unable to stretch both legs and put down both 
feet in a plantigrade position, compensate with pad/small board and expose info about 
the applied compensation onto the film. Use a compression device for adipose patients 
in order to avoid scattered x-rays.

Lumbar spine, lateral, standing:

Standing with the right shoulder to the stand, arms resting in front.
Alternatively, lying position for injured patients and patients unable to stand.

Ankle joint anterior-posterior, lying:

Supine position, legs stretched with frontalized knee cap and right an-
gle position of ankle joint. Foot is pronated approx. 15°.

Ankle joint lateral, lying:

Lateral position, right angle position of ankle joint, exterior ankle joint proximal to the cartridge. In order to achieve 
a clean lateral image, the malleoli must be exactly on top of each other and the  forefoot slightly elevated with 
foam support.

Foot full image dorso-plantar, standing:

Patient standing with one foot on the cartridge, which is placed on the ground. To avoid changing the foot posi-
tion, fixate foot on the cartridge using a patch. The other foot is stepping backward behind the one placed on the 
cartridge.
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Foot full image dorso-plantar, sitting:

Patient sitting on the x-ray table, hip and knee joints on the same side in flexion, 
standing on the cartridge with the sole of the foot.

Foot lateral, standing:

Patient standing on a safe footstool in front of the bucky wall stand. Place a small board under the foot, so the 
cartridge is standing lower, meaning on the footstool between foot and stand. This ensures a complete depiction 
of the foot and plantar tissue. Patient is holding on to the stand and lifts the healthy foot.

Foot dorso-plantar, inclined:

Patient sitting on the x-ray table, hip and ankle joints in flexion. Foot standing on the cartridge. Inner side of lower 
leg (tibial) is placed in a 45° angle against the x-ray table plate on foam support. This way, while holding the upper 
ankle joint in neutral position, the foot's exterior side is lifted in a 45° angle from the cartridge, with the big toe 
proximal to the film. In this image, midfoot bones and joint fissures of the toes are visible more clearly.

Big toe dorso-plantar, sitting:

Patient sitting on x-ray table, hip and knee joints on the same side in flexion, big toe flat on the cartridge.

Upper Extremities Module

Big toe lateral, lying:

Patient in lateral position in a way, that big toe is lying medial and strictly lateral on the cartridge. Toes 2 to 5 are 
held in dorsal direction by textile bands by either the patient, or (often easier) tucked between small bars.

Shoulder anterior-posterior:

For practical reasons, especially because of better repeatability, this recording 
is taken lying flat on the back. The arms are lying flat on the side of the body, 
with the palms to the upper leg, i.e. the thumbs are showing up. 

Shoulder joint anterior-posterior in 90° abduction and external rotation:

Patient standing at the stand, shoulder blade flat lying, upper arm elevated in a 90° angle with maximal external 
rotation and 90° flexion of the cubital joint. The position is easier to keep for the patient, if the hand can hold on 
to something, e.g. a drip stand.

Upper arm anterior-posterior:

Patient standing with the back to the stand, upper arm flat lying. In order to achieve the proper torsion of the 
upper arm, the elbow is slightly bent and the lateral axis of the cubital joint is set parallel to the film. The position 
with hanging arms is easier to hold especially for older patients, than the position with an abducted upper arm. 

Upper arm lateral:

Patient standing with the back to the stand, upper arm flat lying, upper arm abducted in a 90° angle and in exterior 
rotation, so when the elbow is bent, the lower arm is lying flat onto the stand. This position is easier to keep for 
the patient, if the hand can hold on to something (e.g. a drip stand).
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Cubital joint anterior-posterior:

Patient sitting sidewards at the bucky table. In order to place the arm parallel 
onto the cartridge, the arm may have to be placed higher or the patient seated 
lower. Shoulder and cubital joint as well as wrist have to be on the same level. 
The stretched cubital joint is dorsal on the cartridge, the hand is supined, i.e. 
palm shows up. Alternatively, if cubital joint can't be stretched (= bending con-
tracture), a separate image must be recorded with each the upper arm and the 
lower arm for a precise joint assessment.

Cubital joint lateral:

Patient sitting sidewards at the bucky table. Like for the anterior-posterior im-
age, shoulder and cubital joint as well as wrist are on the same level. The cubi-
tal joint is in a 90° flexion and lies medial on the cartridge center, wrist is held 
lateral, i.e. thumb shows up.

Lower arm anterior-posterior:

Patient sitting sideways at the bucky table, so that shoulder and cubital joint as well as wrist are on the same level. 
The lower arm lies flat dorsal on the cartridge. The position will be easier to keep for children, if the arm is fixated 
under a acrylic plate, weighed down on both ends.

Lower arm lateral:

Patient sitting sideways (radiation protection) at the bucky table in a way, so that shoulder and cubital joint as well 
as wrist are on the same level. The lower arm lies flat ulnar on the cartridge (thumb shows up), while the cubital 
joint is in 90° flexion.

Hand dorso-palmar:

Patient sitting sideways at the bucky table, lower arm lying on it. Hand is palmar flat 
on the cartridge, with slightly spread fingers in natural posture. The third finger is 
placed in extension of the longitudinal lower arm axis. Possible malalignments, e.g. 
an ulnar deviation of the fingers due to rheumatoid arthritis, shall not be corrected 
but also depicted radiologically.

Hand lateral (inclined):

Patient sitting sideways at the bucky table, lower arm lying on it. Hand is radial slight-
ly elevated (approx. 30°), thumb and index finger placed on foam support in a way, 
that fingers 2 to 5 including their metacarpal bones are shown inclined, but don't 
quite overlap („zither player position”).

Wrist dorso-palmar:

Patient sitting sideways at the bucky table. Hand is placed on cartridge and foam support in a way, that shoulder 
and cubital joint as well as wrist are on the same level. Wrist is in neutral position between pronation and supi-
nation. In the neutral position, the third metacarpal must be an exact extension of the radial axis and completely 
shown.
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Wrist lateral:

Patient sitting sideways at the bucky table, hand is placed strictly sidewards and fully 
stretched on the cartridge, in neutral position between pronation and supination, 
with the help of a dorsal placed small board/pad. When setting correctly, the balls of 
thumb and little finger are on the same level perpendicular to the film.

Thumb palmo-dorsal:

Patient sitting low at (e.g. on a footstool) or kneeling with the back to the bucky table. Arm held backwards on 
the bucky table, lower arm pronated, so that back of the thumb including the first metacarpal rest flat onto the 
cartridge center, sandbag over lower arm if necessary.

Thumb lateral:

Patient sitting low at the bucky table, e.g. on a footstool. Lower arm lying palmar on it. The exact lateral adjustment 
of the thumb succeeds easier if fingers are placed on a small foam support.

Fingers 2 to 5 dorso-palmar:

Patient sitting sideways at the bucky table, fingers individually, flat and stretched, palmar on cartridge center. The 
other fingers are abducted, sandbag over wrist if necessary. In case of bending contracture, fingers are placed with 
the dorsal side onto the cartridge, laying on middle phalanx if possible.

Fingers 2 to 5 lateral:

Patient sitting sideways at the bucky table, hand lays strictly lateral on the cartridge. To allow for a recording prox-
imal to the film, lay on the radial side of the hand for fingers 2 and 3, or the ulnar side of the hand for fingers 4 
and 5. The finger to be recorded is stretched, all other fingers are bend. As this position can't be held deliberately, 
especially for fingers 3 and 4, appropriate aids are necessary.

Further Reference

Please refer to the following manuals for further information:

T.E. Keats, C. Sistrom, Mosby
Atlas of Radiological Measurements
Elsevier 2001, ISBN 0-323-00161-0

A. Coussement, C. Fauré, N. Coussement-Beylard
Repères et mesures en imagerie Médicale
Expansion Scientifique Françcaise 1990, ISBN 2-7046-1315-X
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References for the Spine Module

Hellinger Johannes
Meßmethoden in der Skelettradiologie, Georg Thieme Verlag Stuttgart, 1995

Jochum, Terry R.; Rowe,  Lindsay J.
Essentials of skeletal radiology, William & Wilkins, 1996

References for the Hip - Coxometry Module

References for the Hip - Biometry Module

Babisch J., Blumentritt S.
Biomechanische Untersuchungen bei aseptisch gelockerten Hüfttotalendoprothesen und deren Konsequenzen für 
die präoperative Planung der Hüftalloarthroplastik. 
Orthop. Praxis 28(1992) 424-430

Tönnis D.
Die angeborene Hüftdysplasie und Hüftluxation im Kindes- und Erwachsenenalter
Springer Verlag, Berlin, Heidelberg NewYork 1984, Kapitel 9- Allgemeine Röntgendiagnostik des Hüftgelenkes, 
S.104-147 (Description, normal values, further bibliographic information)

Hellinger Johannes
Meßmethoden in der Skelettradiologie, Georg Thieme Verlag Stuttgart, 1995, ISBN 3131197013
(Most of the normal values used in IMPAX Orthopaedic Tools derive herefrom)

Hilgenreiner H. (1925)
Zur Frühdiagnose der angeborenen Hüftgelenksverrenkung. Med.Klin. 21: 1385-1388

Kleinberg S. und Liebermann H. (1936)
Acetabular index in infants in relation to congenital dislocation of the hip. Arch.Surg. 32: 1049-1054

Laurenson R. (1959)
The acetabular index. J Bone Jt Surg (Br) 41:702

Further normal values from:

Tönnis und Brunken 1968
Eine Abgrenzung normaler und pathologischer Hüftpfannendachwinkel zur Diagnose der Hüftdysplasie. Arch Or-
thop trauma Surg 64:197-228

Wilcinson J., Carter C. (1960)
Congenital dislocation of the hip. The results of conservative treatment. J Bone Jt Surg[Br] 42:669-688 

Zippel 1971
Normal development of the structural elements of the hip joint in adolescence
Beier. Orthop Traumatol 1971 May;18(5): p255-70

Current literature (example):

Gotoh E., Tsuji M., Matsuno T., Ando M.
Acetabular development after reduction in developmental dislocation of the hip. Clin Orthop  (United States), Sep 
2000, (378) p174-82
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Blumentritt S.
Biomechanische Bauprinzipien des menschlichen Hüftgelenkes in der Frontalebene. 
Gegenbaurs morphol. Jahrb. 134(1988) 221-240

Blumentritt S.
Die Beziehung zwischen dem Gang des Menschen und dem Hüftgelenkaufbau in der Frontalebene.
Gegenbaurs morphol. Jahrb. 136(1990) 677-693

Blumentritt S., Babisch J., Sedlatschek S., Langer G.
Zur Bedeutung der Implantationsgeometrie einer HTEP für das Operationsresultat.
Hermsdorfer Technische Mitteilungen 81

John F.J., Fisher P.E.
Radiographic determination of the anatomic hip joint center - A cadaver study. 
Acta Orthop. Scand 65 (5) (1994) 509-510

Pauwels F.: Atlas zur Biomechanik der gesunden und kranken Hüfte.
Springer-Verlag 1973

Ranawat C.S., Dorr L.D., Inglis A.E.
Total hip arthroplasty in protrusio acetabuli of rheumatoid arthritis.
J.Bone Jt. Surg. 62-A (1980) 1059-1065

Yoder S.A., Brand R.A., Pederson D.R., Gormann T.W.
Total hip acetabular component position affetcs component loosening rates. 
Clin. Orthop. 228 (1988) 79-87 

Aldinger G., Fischer A., Kurtz B.: Computer Assisted Manufacturing of individual Endo-prostheses (Preliminary 
Report). Arch. Orthop. Traumatol. Surg. 102 (1983) 31

Babisch J., Blumentritt S.: Biomechanische Untersuchungen bei aseptisch gelockerten Hüft-totalendoprothesen 
und deren Konsequenzen für die präoperative Planung der Hüftalloarthroplastik.  Orthop. Praxis 28 (1992) 424-430

John F.J., Fisher P.E.
Radiographic determination of the anatomic hip joint center – A cadaver study
Acta Orthop. Scand 65 (5) (1994): 509-510

Hughes L.O., Aronson J., Smith  H. S.
Normal radiographic values for cartilage thickness and physeal angle in the pediatric hip.
J Pediatr Orthop. 1999 Jul-Aug; 19(4): 443-8

Armstrong C.G. et al.
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The growth of the juvenile hip joint. A planimetric study of X-ray films
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Abbreviations

a	 anatomical 
ACA	 Angle of Correction of Angulation
ACE	 Angle according to Wiberg or CE Angle = Anterior Center Edge Angle
AC-Hilg	 Acetabular Angle according to Hilgenreiner (if the Y-cartilage is open)
ACM	 Angle according to Idelberger and Frank
MZ 	 decentralized distance line used to caculate the hip index
AC-SZW	 Acetabular Angle (angle of sclerotic area of the roof of the acetabulum if the Y-cartilage is closed)
ACW	 Acetabular Angle
ACW-HL	 Acetabular Angle according to Hilgenreiner if the Y-cartilage is open
ACW-SZ	 Acetabular Angle if the Y-cartilage is closed
aLDFA	 anatomical Lateral Distal Femoral Angle
AMA	 Anatomical Mechanical Angle
aMLFA	 anatomical Medial Lateral Femoral Angle
aMPFA	 anatomical Medial Proximal Femoral Angle
BETADIFF	 Deviation of calculated direction of pull of the abductor muscles from their ideal direction of action
CCD	 Centrum Collum Diaphysen Angle
CE-angle	 Centrum Edge Angle
Center Line	 Mikulicz
D	 distal
FNA	 Femoral Neck Axis

References for the Upper Extremities Module

Hellinger J.
Meßmethoden in der Skelettradiologie
Georg Thieme Verlag, Stuttgart, 1995

References for Image Requirements & Scaling

Bernau A., Bohndorf K.
Röntgendiagnostik in Orthopädie und Traumatologie
Urban & Fischer, München, 1982/2010

Wicke L.
Atlas of Radiologic Anatomy
Icon Learning Systems, Teterboro/NJ, 2004
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FSA	 Femur Shaft Axis
FSA-mTA	 Femur Shaft Axis (anantomical) – mechanical Tibia Axis
HJC	 Hip Joint Center
HL	 Reference Line (e.g. Ischial Bone Tangent)
HPKI	 Acetabulum Femoral Head Index according to Heymann and Herndorn
HW	 Hip index according to Busse, Gasteiger and Tönnis
JLCA	 Joint Line Conversion Angle (angle between KJL-F and KJL-T)
KJL-F	 Knee Joint Line – Femur (proximal knee base)
KJL-T	 Knee Joint Line – Tibia (distal knee base)
KLDELTAOPT	 Direction of pull of the rectus femoris muscle in relation to the horizontal in an ideal joint situation
L	 Large
l	 lateral
lBL	 Longitudinal Bisector Line
m	 mechanical
M	 Medial
MAD 	 Mechanical Axis Deviation
mFA-mTA	 mechanical Femur Axis – mechanical Tibia Axis
Mikulicz	 Center Line
mLDFA	 mechanical Lateral Distal Femoral Angle
mLDTA	 mechanical Lateral Distal Tibial Angle
mLPFA	 mechanical Lateral Proximal Femoral Angle
mMPTA	 mechanical Medial Proximal Tibial Angle
MZ	 decentralized distance line used to calculate the hip index
NSA	 Neck Shaft Angle / CCD Angle
PNW	 Acetabular Inclination Angle according to Ullmann
PFNW	 Acetabular Inclination Angle
PNW/US	 Acetabular Inclination Angle according to Ullmann
RDA	 Real Deformity Angle
RREL	 Resulting joint counterforce relative to body weight
S	 Small
SZWITH	 Theoretical direction of the resulting joint counterforce in relation to the horizontal (position of the 

sclerotic area)
tBL	 Transversal Bisector Line
TL	 Center line
TSA 	 Tibia Shaft Axis
US	 Ulmann Sharp
VD5ABD	 Ratio of lever lengths (vertical distance of directions of pull from the rotation center) of the center of gra-

vity of part of the body and the abductor muscles
VRECABD	 Ratio of lever lengths (vertical distance of directions of pull from the rotation center) of the rectus femoris 

and the abductor muscles
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